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Chapter 3
Case and Scenario File Management

In CANSARP, the term “file management” refers to the manipulation of cases and scenarios – 
creating new ones; opening and closing existing ones; saving, viewing, duplicating and deleting 
them, and many other operations.  While most of these actions are performed via the File Menu, 
others are accessed via the Scenario Manager and still others are only available outside 
CANSARP.

This chapter explains all the elements of the File Menu in detail, as well as the parts of the 
Scenario Manager that relate to file management.  It also introduces the Nautilus File Manager 
and explains how it is used to perform advanced file management outside of CANSARP.

In this chapter, you will learn:
• The difference between a case and scenario

• The rules for naming cases and scenarios

• How to tell which case and scenario are active

• What scenario components are and how they are saved

• How to create new scenarios and to load, save, duplicate and delete existing scenarios

• The difference between a hard save and an autosave

• How to use the Scenario Manager to duplicate scenarios or to switch between active 
scenarios in a case

• How to perform advanced file management in Nautilus File Manager, including 
renaming, deleting, archiving and locking cases and scenarios

3.1 Before you begin...

3.1.1 What Is a Scenario?  What Is a Case?
The basic CANSARP search plan is called a scenario; a collection of related scenarios is known 
as a case.  A scenario contains all the information related to a single search plan, such as search 
objects, SRUs, environmental data, etc.  You may wish to develop alternate plans for the same 
SAR incident – to document a change in logic that leads to a revised plan, to test a different 
arrangement of SRUs in the search area or a different combination of drift factors, to plan a 
second or third search, or for various other reasons.  All scenarios related to a single SAR 
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incident should be created as part of the same case.

The relationship between a case and scenario is akin to the relationship between a file folder and 
the documents contained within it.  In fact, this is how CANSARP organizes the save files for 
cases and scenarios.  

3.1.2 Case Numbers and Scenario Names
Each case has its own unique name that distinguishes it from all others.  In keeping with the SAR 
Master case management tool, this unique name is referred to as its case number even though in 
CANSARP it might not be numeric.  Each scenario has its own unique scenario name that 
distinguishes it from all other scenarios within the same case.  

Every scenario must be uniquely identified by its name and the number of the case it belongs to. 
For this reason, no two cases can have the same number, and no case may contain two scenarios 
with the same name.  It is possible for two different cases to contain scenarios with the same 
name because the scenarios' case numbers will differ.

Case numbers and scenario names are case sensitive and may contain letters, numbers and the 
dash and underscore characters.  Other characters, such as punctuation marks, are not allowed. 
Spaces are replaced automatically with the underscore character.  Case numbers typically begin 
with the current year in four digit format in an effort to match the naming conventions of the 
SAR Master case management tool but this isn't a strict requirement.  Most RCCs establish their 
own conventions for numbering cases and naming scenarios; it's a good idea to familiarize 
yourself with the conventions used at your location.

3.1.3 Active Case and Scenario
The scenario which is currently open is known as the active scenario and the case it belongs to is 
the active case.  The active case and scenario are always listed in the title bar at the very top of 
the CANSARP window.  When CANSARP first starts up, there is no active case or scenario; a 
scenario must be created or loaded into memory before you can perform scenario operations. 
Once a scenario is created or reopened by loading it, it becomes active and its name and its case 
number appear in the title bar: 

A single CANSARP session can have only one scenario open at a time.  If you wish to have more 
than one scenario open, you must start a new CANSARP session from the desktop for each 
scenario.  You may have as many CANSARP sessions open as you wish.

3.1.4 Scenario Components
Every scenario has a list of components that are saved in separate data files and can be saved, 
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loaded or discarded independently.  The list of scenario components may be found by opening 
any of the submenus in the File Menu: 

Not all scenarios contain all these components; components that a scenario does not contain may 
be greyed out in the menu in certain situations.  For instance, search objects have not yet been 
added to the scenario associated with the scenario shown in Figure 3.2, so this option is greyed 
out in the menu.

The methods for saving, reloading, recovering or discarding scenario components are covered in 
this chapter but the details of the components themselves are covered in later chapters.

3.1.4.1 Scenario Parameters  

Scenario parameters actually include three types of information required to reload the scenario in 
the same state it was in when last saved: the list of map options turned on at the time, the list of 
wind and current forces active, and scenario attributes set and modified via the Scenario 
Manager, such as CANSARP User, search number, and sea state.  These three things are covered 
in separate locations as indicated above.

3.2 File Management within CANSARP: The File Menu
Most case and scenario file management within CANSARP is performed via the File Menu:
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3.2.1 Creating a New Scenario In a New or Existing Case
The first step in starting a new search plan is to create a new scenario to contain it.  Because a 
scenario cannot exist outside of a case, you must either add the new scenario to an existing case 
or create a new case to add it to.  If you create a new case, it will contain only one scenario for 
the time being but you may add additional scenarios to it at a later time.

To create a new scenario, choose New Case/Scenario from the File Menu, click the New 
Case/Scenario button on the tool bar, or press F5.  A dialog box will appear and prompt you for a 
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case number and a scenario name:

If a case is already active, the Case Number field will contain the active case's number. 
Otherwise, this field contains the current year in four digit format followed by a dash and the 
cursor, as above.  In either event, the characters that appear in the field may be modified or 
deleted.

If you wish to create the scenario as part of an existing case, enter that case's number in the first 
field.  Otherwise, enter a new case number into the first field.

Caution: There is no way to tell whether the case number you enter is new or already 
exists.  To avoid using an existing name when your intention is to create a new case,  
check the menu of existing cases that comes up when you select Load Scenario from the 
File Menu before creating a new case.

Enter a name for your new scenario in the second field.  Once you've entered the case number 
and scenario name, click OK.

If you haven't duplicated the name and case number of an existing scenario, the new scenario is 
created and becomes active.  If you have duplicated the name and number of an existing scenario, 
you'll be asked if you want to load that scenario into memory.  If you click Yes, the existing 
scenario is loaded and becomes active.  If you click No, you must change the case number or 
scenario name or both before the new scenario can be created.  Once your new scenario is created 
(or existing scenario is loaded).  It becomes active and its case number and scenario name are 
displayed on the Title Bar at the top of the CANSARP window.

3.2.2 Loading an Existing Scenario (Load Scenario)
A scenario that was created and saved previously may be reloaded into memory and further 
modified.    To load an existing scenario, choose Load Scenario from the File Menu, click the 
Load Scenario button on the tool bar, or type F4.  The Load Scenario dialog box will appear:  
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The dialog box contains a list of case numbers in alpha-numeric order.  Each case number has a 
small triangle to its left; click on this triangle to expand the case into the list of scenarios it 
contains.  Several of the cases in the above diagram have been expanded in this fashion.  Select 
the scenario you wish to open and then click Load.  

This loads a scenario in its entirety, including all scenario components.  It is not possible to load a 
single scenario component independently of the others when no scenario is open but, once a 
scenario is active, you may reload one of its components or load one or more of another 
scenario's components into the active scenario.  See the sections on Reloading The Active 
Scenario and Reloading From Another Scenario Into The Active Scenario later in this chapter for 
more information.

3.2.3 Viewing a Scenario In View Mode (View Case)
Sometimes you may wish to look at a scenario without making any further changes to it.  This is 
particularly useful if a case has been completed and you want to review the search plan that was 
developed at the time without inadvertently modifying it, or if you want to open a plan someone 
else is working on without affecting the work in progress.  In these situations, you may view the 
scenario.  

When a scenario is opened in view mode, you may work with it as usual but none of your 
changes will be saved, nor will the scenario autosave.  In this way the original scenario is 
preserved unchanged.
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To open a scenario in view mode, choose View Case from the File Menu.  A dialog box just like 
the Load Scenario dialog box will appear, containing a list of case numbers in alpha-numeric 
order.  Each case number has a small triangle to its left; click on this triangle to expand the case 
into the list of scenarios it contains.  Select the scenario you wish to open and then click Load.

3.2.4 Printing the Active Scenario (Print Scenario)
To print a copy of the active scenario, select Print Scenario from the File Menu or type Ctrl-F12. 
The details of the Print Scenario window are covered in Chapter 14: Printing, Reports And The
Logging System.

3.2.5 Saving the Active Scenario (Save)
To save the active scenario, click the Save Scenario button on the toolbar or by clicking on Save 
in the File Menu and then selecting Scenario from the submenu that appears (similar to the 
submenu shown in Figure 3.2).  This is known as performing a hard save, as opposed to the 
autosaves that CANSARP performs intermittent in the background (see Section 3.2.7).
You may also save an individual scenario components by selecting the given component from the 
Save submenu.  
You will be prompted to save your work whenever you close or discard a scenario or when you 
quit CANSARP.  If you click 

Caution: There is no prompt to save your work when you create a new scenario or load a 
different scenario into memory.  Any changes made since the last autosave will be lost!

Whenever you make a hard save, the autosave files are also updated.  That is, the autosave files 
are never older than the most recent hard save.

3.2.6 The Autosave System (Autosave and Recover Autosave)
CANSARP periodically saves your work to an autosave file that is separate from the active 
scenario's hard save file.  This gives you the option to return to the last saved state (i.e. the last 
hard save) at any time via Reload as described in Section 3.2.7, or to return to the most recent 
autosave state.  This second option is useful when you wish to reverse some recent changes but 
don't want to discard all your changes since you last saved.

By default, CANSARP performs an autosave every two minutes.  See Section 3.2.6.3 for more 
information.

3.2.6.1 Recovering from the Autosave File  

To recover the state of the entire scenario or an individual scenario component from the autosave 
file, choose Recover Autosave from the File Menu and then Scenario or the scenario component 
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you wish to recover from the submenu that appears.  This discards any changes made to the 
scenario or the component in question since CANSARP last autosaved.  Only components that 
the active scenario contains are autosaved, so some of the options may be greyed out.

Hint: Although CANSARP has no undo function, Recover Autosave may be used like a 
limited undo.  If you apply a change and wish to undo it, recovering from  the autosave 
file will revert that change if it was changed more recently than the last autosave was 
performed.  You must consider, however, whether it will also undo other changes you 
wish to keep.

3.2.6.2 Recovering after a Crash or Forgetting to Save  

Whenever you load a previously saved scenario into memory, CANSARP checks to see if that 
scenario's autosave files are more recent than its hard save files.  If they are and there is a 
difference between the two, you are given the option to load the autosave data instead of the save 
data.

This protects you from losing more than a few minutes worth of work if you forget to save before 
opening a different scenario or in the event of a crash.  Any changes made since the last autosave 
will still be lost, but unless the Autosave Data Interval has been changed, this is limited to two 
minutes of work.

Whether you choose to load the hard save files or the autosave files, you may still make use of 
Reload and Recover Autosave to achieve a combination of the two.  That is, if you choose to load 
the hard save files, you can still use Recover Autosave as described in Section 3.2.6.1 to recover 
more recent versions of individual scenario components.  Alternately, if you choose to load the 
autosave files, you can still use Reload as described in Section 3.2.7 to set individual components 
back to their hard save state.  
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Hint: Unless you are certain that you don't want to keep the autosave data, it is safer to 
load it rather than the hard save data.  The autosave data may be overwritten very 
quickly (see Section 3.2.6.3) whereas the hard save data will never change until you 
perform a hard save.

3.2.6.3 Setting the Autosave Data Interval  

By default, CANSARP performs an autosave every two minutes but you may change the 
frequency of autosaves or turn them off entirely.  To do so, choose Autosave from the File Menu; 
this brings up the Autosave dialog box:

Use the up and down arrow keys or click on the up and down arrow buttons to the right of the 
Autosave Data Interval field to change the autosave data interval.  To turn off autosaving 
entirely, set the interval to 0.  To turn it on again, set the interval to something greater than 0. 
You may return to the default value of two minutes by clicking the Use Defaults button.

The moment at which autosaves are performed is established when you first start CANSARP, not 
when a scenario is opened, and it is not reset if you open a different scenario.  This means that the 
time between opening a scenario and the first autosave will be less than the autosave interval.  

For example, if you start CANSARP at 14:01:10, it will perform an autosave at 14:03:10, 
14:05:10, etc.  If you open a different scenario at 14:06:50, that scenario will still autosave at 
14:07:10, or 20 seconds later rather than the full two minutes.

3.2.7 Reloading the Active Scenario (Reload)
If, after making changes to a scenario, you wish to return to the scenario's previously saved state 
(i.e. the last hard save), you may reload the scenario from its save file.  To do so, choose Reload 
from the File Menu and then select Scenario from the submenu that appears.  

This discards all changes you have made to the scenario since the last time you made a hard save 
and reverts to the scenario's state at that time.  Reloading does not make use of the scenario's 
autosave file.

It is also possible to load individual scenario components independently.  To do so, choose 
Reload from the File Menu and then select the scenario component you wish to reload from the 

29

Figure 3.7: The Autosave 
dialog box in which the 
autosave interval is set



Chapter 3: Case and Scenario File Management

submenu that appears.  This will revert only that component to its last saved state, leaving all 
other scenario components in their current states.  Only components that the active scenario 
contains may be reloaded, so some of the options may be greyed out.

3.2.8 Reloading from Another Scenario into the Active Scenario (Reload From...)
You may replace individual scenario components in the active scenario with those from another 
scenario entirely.  This is useful if you wish to create an entirely new search plan that contains 
only some aspects of one previously created.

To do so, choose Reload From... from the File Menu and choose the component you wish to 
replace from the submenu that appears.  This brings up the Select Case dialog box which 
performs exactly like the Load Scenario dialog box described earlier.  Select the scenario from 
which you wish to load the component and click the Load button.  The current state of the 
scenario component you indicated will be discarded and replaced with the saved state of the 
alternate scenario you selected.

You may also replace the entire active scenario with another in memory, in effect creating a copy 
of the previously saved scenario.  To do this, choose Reload From... from the File Menu and 
choose Scenario from the submenu that appears, then select the scenario to load from the Select 
Case dialog box.  This differs from actually loading the scenario itself into memory in that the 
previously active scenario stays active and future saves will not affect the alternate scenario's 
save files.

3.2.9 Discarding the Active Scenario (Discard)
It is possible to discard an entire scenario or any of its individual scenario components. 
Discarding a scenario is equivalent to closing it as described below.  Discarding a single scenario 
component resets that component to its initial blank state.  Note that discarding the scenario or an 
component removes it without saving or modifying the active scenario's save files; to delete a 
scenario's save files entirely, you must use the Scenario Manager or the Nautilus File Manager as 
described later in this chapter.

To discard the scenario or one of its components, choose Discard from the File Menu and then 
select Scenario or one of the scenario components from the submenu that appears.  Only 
components that the active scenario contains may be discarded, so some of the options may be 
greyed out.

3.2.10 Closing the Active Scenario (Close Case)
Closing the active scenario returns CANSARP to the state in which it initially opens – that is, 
with no active case or scenario open.  Note that this does not save the scenario's current state, so 
you must save any changes you wish to keep before closing the scenario.  Once the scenario is 
closed, CANSARP continues to run and the active CANSARP User is unchanged, but no 
scenario operations are possible until a new scenario is loaded into memory.
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To close a case, select Close Case from the File Menu.  You will be asked to confirm that you 
wish to close the scenario before it is actually closed.

3.2.11 Backup Case

Note: Backup Case is not implemented in CANSARP version 4.9.5.28.  When 
implemented, it will create an archive of a case and its scenarios.  Archived cases and 
scenarios will not appear in the list of files available to the Load Scenario or Reload 
From... features but may be unarchived if required by using the Restore Case feature.

3.2.12 Restore Case

Note: Restore Case is not implemented in CANSARP version 4.9.5.28.  Once 
implemented, it will return a previously archived case to active duty so that its scenarios 
may be loaded into memory and components from those scenarios may be loaded into 
other scenarios.

3.2.13 Export Drifts
Export Drifts is a feature intended for research and validation rather than search planning.  It 
produces a raw data file in a binary format.

3.3 File Management within CANSARP: The Scenario Manager
While most file management within CANSARP is performed via the File Menu, some file 
management features are accessed via the Scenario Manager.  To open the Scenario Manager, 
choose Scenario Manager from the Managers Menu.  The top half of the manager window is 
related to file management:  

The top of the manager window contains the list of scenarios contained within the active case and 
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indicates which one of these scenarios is active.  The buttons below the list of scenarios are used 
for file management.  The bottom of the manager window, not shown here, is used to set scenario 
attributes as discussed in Chapter XX.XX.

3.3.1 Creating a New Scenario in a New or Existing Case (New Case/Scenario)
The New Case button in the Scenario Manager calls up the same dialog box as choosing New 
Case/Scenario from the File Menu and prompts you for a case number and a scenario name:

The active case's number appears in the Case Number field.  If you don't change the case 
number, the new scenario will belong to the active case; otherwise, a new case will be created for 
the new scenario.  Enter a name for your new scenario in the second field.  Once you've entered 
the case number and scenario name, click OK.  Regardless of whether the new scenario belongs 
to a new case or the previously active one, the Scenario Manager stays open and the new scenario 
becomes active.

3.3.2 Switching between Active Scenarios in a Case (Load)
The Scenario Manager allows you to easily switch between the scenarios contained within the 
active case.  Select the scenario you wish to make active by left clicking on its name, then click 
the Load button.  Note that this does not save the previously active case before switching to a 
new one, so you should save any changes you don't wish to lose before loading a new scenario.

3.3.3 Deleting a Scenario from the Active Case (Delete)
The Scenario Manager allows you to delete a scenario from the active case.  This completely 
removes all of the scenario's save files.  To delete a scenario, select it by left clicking on its name, 
then click the Delete button.

You cannot delete the active scenario; if the active scenario is the one you wish to delete, load 
another scenario to make it active and then delete the previously active scenario.  You cannot 
delete the last scenario in a case, delete scenarios from other cases, nor delete entire cases from 
within CANSARP.  See Section 3.4 later in this chapter to learn how to perform these actions.

32

Figure 3.9: The New Case 
dialog box with the active 
case number filled in



Chapter 3: Case and Scenario File Management

3.3.4 Duplicating a Scenario (Duplicate)
You may create an exact copy of an existing scenario via the Scenario Manager.  To do so, select 
the scenario you wish to copy by left clicking on its name, then click the Duplicate Scenario 
button.  This calls up the Duplicate Scenario dialog box:

Enter the name of the new scenario in the field provided (making sure to meet the naming 
requirements as described in the Before You Begin section of this chapter) and click OK.  This 
creates a duplicate of the last saved state of the selected scenario in the active case and makes the 
newly created scenario active.

Caution: If you are duplicating the active scenario, be aware that the duplicate is made 
of the scenario's last saved state, not its current state.  You must save the active scenario 
before duplicating it if you wish your changes to be part of the new copy.

3.4 File Management outside CANSARP: Nautilus File Manager
The CANSARP application runs within the Gnome Desktop environment in the Solaris 10 
operating system.  One component of the Gnome environment is the Nautilus File Manager, 
which allows users to manage files and directories.  Nautilus File Manager is similar to Windows 
Explorer in the Microsoft Windows operating system and functions in much the same way.

Nautilus may be used to perform several file management operations on CANSARP files outside 
of the CANSARP program itself.  Some of these operations are only available within the Nautilus 
File Manager, while others may be performed within CANSARP as well.  

You may perform these operations within Nautilus while CANSARP is running, though you 
should take care when manipulating any active cases or scenarios.  Some operations can 
introduce instability and may make CANSARP crash when performed on files currently in use; 
perform these operations on the active case or scenario at your own risk!

Caution: It is imperative that you follow the requirements for scenario names and case 
numbers when changing file names in the Nautilus File Manager.  Nautilus will allow 
you to add spaces and punctuation to file names that will prevent those cases and 
scenarios from behaving as expected within CANSARP.
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3.4.1 File Structure within Nautilus
As of CANSARP 5.0 version 4.9.5.28, all CANSARP case and scenario save files are located in 
the directory /export/home/cansarp/incidents/.  Each case is a directory located in that parent 
directory, and the scenarios it contains are themselves directories located in the case directory. 
For instance, for the scenario named 1 in the case 2006_0636 (see Figure 3.11)  the scenario 
directory is /export/home/cansarp/incidents/2006_0636/1/.  A scenario directory includes all the 
data files associated with each scenario component for the given scenario.  

Caution: While you can perform many useful operations within Nautilus at the case or 
scenario directory level, it is not advisable to manipulate individual data files within a 
scenario directory as this may corrupt the scenario and the case that contains it.

3.4.2 Opening the File Browser in Nautilus File Manager

To find case and scenario directories, open the File Browser by double clicking on the This 
Computer icon in the top left corner of the desktop.  Once the file browser is open to This 
Computer, you may either type /export/home/cansarp/incidents in the Location field (as shown in 
Figure 3.11) and hit the Enter key to move into the incidents directory, or double click first on the 
File System icon, then on the home directory icon, then the cansarp directory icon and finally the 
incidents directory icon to do the same.

In  Figure 3.11 there are 10 existing cases.  Double clicking on any case directory icon will open 
it and display the scenarios it contains.  Double clicking on a scenario directory will display the 
save files associated with that scenario.  To return to the case directory from a scenario directory 
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or to the incidents directory from a case directory, click the Up arrow icon above the Location 
field.

If a case or scenario directory or the incidents directory itself is open in the File Browser when a 
change is made within CANSARP that affects it (for instance, if a case or scenario is created, 
duplicated or deleted), these changes are not immediately visible within the File Browser 
window.  To update the list of files, choose Reload from the View Menu or type Ctrl-R to reload 
the window and see the effect of these changes.

Similarly, if the contents of a directory are changed outside of CANSARP, the changes will not 
be evident in any dialog boxes currently open within the program.  You will need to close and 
reopen any dialog boxes that display a list of cases or scenarios in order to see the revised list.

3.4.3 Deleting Scenarios and Cases
You may delete an existing case or a single scenario by selecting the case or scenario directory 
and hitting the Delete key or choosing Cut File from the Edit Menu in the File Browser window. 
This has the same effect as deleting a scenario from the Scenario Manager, but can be used to 
delete scenarios in any case or even entire cases.  There is no way to undo this operation, so take 
care when deleting files.

Do not delete the active case or scenario.  If this happens, the scenario will stay open in 
CANSARP but the directory containing its save files will no longer exist.  If this should happen 
inadvertently, saving the scenario should recreate the case and scenario directories as required for 
the active scenario but not other scenarios in the case.  Note that there is no guarantee this will 
work every time: sometimes too much instability is introduced, causing CANSARP to perform 
strangely or to crash.  

3.4.4 Duplicating Scenarios and Cases
While it is possible to duplicate a scenario within CANSARP, you cannot duplicate an entire 
case, nor can you duplicate more than one scenario at a time.  You can do both these things in 
Nautilus.

To copy an existing case or scenario, select the directory of the case or scenario you wish copy 
and choose Duplicate from the Edit Menu in the File Browser.  This creates a new copy of the 
directory and places it inside the same directory as the original.  The new copy will have the 
same name as the old one, with the characters “ (copy)” appended to the end.  Note that this 
introduces a space and parentheses into the file name, hence it is not a valid case number or 
scenario name for CANSARP and the name must be changed as described shortly.

You may select more than one directory at a time for copying.  Each directory will be copied as 
described above (and each new copy will need to be renamed).

3.4.5 Renaming Scenarios and Cases
CANSARP does not allow you to rename a scenario or case once it is created but you can do this 
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within Nautilus.  Be advised that Nautilus will allow you to give directories names that 
CANSARP cannot handle.  In fact, if you have duplicated a scenario or case within Nautilus, you 
must rename it as the new copy will contain spaces and punctuation that make the file unusable to 
CANSARP.

To change the name of a case or scenario, select the directory in question and choose Rename... 
from the Edit Menu or type F2.  This allows you to edit the directory's name as you would text in 
a word processor.  Make sure the new name follows the guidelines described in the Before You 
Begin section of this chapter.  In particular, be sure to remove any spaces and punctuation.

3.4.6 Moving or Copying Scenarios to Another (or a New) Case
CANSARP does not allow you to move a scenario to another case once it is created but you can 
do this within Nautilus.  To do so, first select the scenario directory and choose Cut File from the 
File Menu.  Next, use the Up arrow to move up to the incidents directory and then double click 
on the case directory where you want the scenario to be located to open it.  Once in the new 
case's directory, choose Paste File from the File Menu.  This removes the scenario from its 
original case and moves it to the new one.

To create a copy of the scenario in a new case but leave the original in its place, follow the above 
instructions but use Copy File instead of Cut File.

To move a scenario to a brand new case, you must first create a case directory for it.  In the 
incidents directory, choose Create Folder from the File Menu.  This will create a directory and 
give it the name “untitled folder”.  You must change this folder's name as described above, giving 
it an appropriate name for the new case.  Then follow the procedure for moving a scenario from 
one case to another to move it into the newly created case directory.

3.4.7 Archiving and Unarchiving a Case
This operation should only be performed by the CANSARP adminstrator.
Should you wish to preserve a case on the CANSARP workstation but prevent it from being 
opened within CANSARP (and so from appearing in the Load Scenario dialog box), you may 
archive it.  This operation will be added to future versions of CANSARP but in the meantime you 
may perform it manually from the Nautilus File Manager.

First you must create a directory in which to archive the case if one does not already exist.  To do 
so, move into /export/home/cansarp and choose Create Folder from the File Menu.  Be sure to 
select the newly created folder and change its name to something meaningful.  

To move the case to be archived into the new folder, first open the incidents directory where it is 
currently located.  Selecting the case directory, choose Cut File from the Edit Menu, move into 
the newly created archive directory and then chose Paste File from the Edit Menu.  
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Caution: Do not choose Create Archive... from the Edit Menu when archiving a case.  
This does something else entirely that is not compatible with CANSARP's file structure.

To unarchive a case, move it out of its archive directory and back into the incidents directory.

Scenarios may be archived in the same fashion, but it is advisable to archive entire cases rather 
than individual scenarios.  If you wish to prevent a scenario from being modified but leave the 
case it belongs to unarchived, lock the scenario rather than archiving it.

3.4.8 Locking a Scenario or a Case
This operation should only be performed by the CANSARP adminstrator.
Should you wish to prevent changes to a scenario or an entire case but still allow the scenario or 
scenarios within the case to be opened in CANSARP, you may lock the scenario or case directory 
by removing write access to it.  This operation will be added to future versions of CANSARP but 
in the meantime you may perform it manually from the Nautilus File Manager.

To do so, select the scenario or case directory in question and right click on it, then choose 
Properties from the menu that appears.  This calls up the file properities dialog box:  

Switch to the Permissions tab, then click on all three check boxes labeled Write to uncheck them 
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as shown above.

When write permissions are turned off in this way for a scenario, that scenario performs normally 
within CANSARP in all ways, except that neither hard saves nor autosaves are performed.  If a 
case is locked, this is true of all scenarios within that case.

Caution: There is no indication within CANSARP that saves are not being performed 
when a scenario or case is locked in Nautilus.  Saves will appear to work but no changes 
are actually written to the save files.  When this feature is implemented within CANSARP, 
it will be possible to tell when a scenario is locked.

To unlock a case or scenario, turn write permissions back on by opening the properties dialog box 
and clicking on all three check boxes labeled Write so that the check marks appear as they do for 
the read and execute permissions in Figure 3.12.
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Chapter 6
Search Objects and the Search Object Manager

One of CANSARP's primary functions is to calculate where objects in the water will drift given 
their type, the estimated incident position, and environmental conditions.  The first step in this 
process is adding the search objects themselves and configuring their parameters.  This chapter 
introduces the Search Object Manager and covers the methods used to add, modify and 
manipulate standard search objects.

In this chapter, you will learn:
• The difference between standard search objects and tracklines

• What search object parameters are

• How to use the Search Object Manager

• How to add standard search objects

• How to modify, duplicate and delete standard search objects

• How to deactivate and reactivate standard search objects

• How the canvas menu interacts with search objects

6.1 Before you begin...

6.1.1 Search Objects Vs. Tracklines
CANSARP uses two managers to handle search objects: the Search Object Manager and the 
Trackline Manager.  Standard search objects represent a single object in a single position and are 
used when the estimated incident position (EIP) is more or less clearly defined.  Tracklines are 
used when the course a vessel expected to follow is known but the point along that path at which 
the vessel went into distress is not.  In this case, a trackline is used to deploy several search 
objects at various points along the vessel's course, with drift starting times calculated to 
compensate for the time required to reach each deployment location.

Tracklines are covered in Chapter 7: Track Lines And The Trackline Manager but the information in 
this chapter applies to trackline search objects as well.  The Trackline Manager deploys its 
objects into the Search Object Manager, where they perform like standard search objects in 
almost all respects and may be modified like any other search object.
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6.1.2 Search Object Parameters
Regardless of how they are added, all search objects have four parameters that affect drift 
calculations: object type, drift starting point, initial position error and leeway divergence.  Each 
of these is introduced briefly below; instructions for setting them for a particular search object 
follow in the section titled Editing Search Objects later in this chapter.  

6.1.2.1 Search Object Type  

Every search object represents a particular type of object adrift in the water.   These may be 
persons in the water (PIWs), life rafts, sailboats or ships.  As well, each type may or may not 
have a drogue attached.  An object's type and the presence or lack of a drogue determine its 
default leeway parameters and the sweep width for SRUs allocated to search for that object.  

CANSARP provides a list of 26 types to choose from; these correspond directly to the search 
object types in the sweep width tables in Annex 7D of the National SAR Manual.  They also 
correspond to the leeway tables in Chapter 7 of the National SAR Manual, although the manual's 
categories are broader than CANSARP's in the case of leeway.

6.1.2.2 Drift Starting Point: LKP/EIP  

A search object's drift starting point includes both its drift starting time and its drift starting 
position, and indicates when and where the object began to drift.  For example, this might be the 
point at which a ship lost power, a person fell into the water, or life rafts were deployed.  This 
point is referred to by the National SAR Manual as last known position (LKP) however, because 
the object's last known position might not be near the best estimate of its position when it went 
into distress, IAMSAR Vol. 4 refers to this point as Estimated Incident Position (EIP). 
CANSARP and this manual use the terms LKP and EIP interchangeably.

6.1.2.3 Initial Position Error  

A search object's initial position error describes the margin of error in the estimate of its drift 
starting position owing to two factors: fix error and dead reckoning (DR) error.  Fix error is based 
on the navigation system of the reporting agency – whether the search object itself or a passing 
vessel or aircraft – or the type of electronic direction finding source used to fix the object's 
position.  If the search object's position has been calculated using dead reckoning procedures, the 
margin of error associated with that calculation must also be included.  A search object will 
always have fix error; if it also has DR error, these two values are added together to determine 
total initial position error.

6.1.2.4 Leeway Divergence  

Leeway is the movement of the search object through the water caused by the action of the wind 
on the exposed surfaces of the object.  There are four leeway parameters: coeffiecient, left and 
right angle of divergence, and correction.  Coefficient determines the magnitude of leeway's 
impact on the drift calculations: the higher the value, the greater the effect of leeway on drift. 
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Left and right divergence determine how far leeway pushes the object off the downwind path: the 
higher the value, the wider the spread of drift tracks.  Correction is a constant correcting factor 
applied based on experimental results.  It should not be applied when wind speed is less than 5 
knots.

When leeway divergence is turned on for a particular search object, these parameters are used in 
drift calculations for that object; when it is off, drift calculations do not include leeway. 
CANSARP turns leeway on automatically for those object types for which it is appropriate and 
assigns leeway parameter values according to the tables in the National SAR Manual.  You may 
override these default vaults for each object if desired.

6.2 The Search Object Manager
Most operations related to standard search objects are carried out via the Search Object Manager. 
To open the manager, choose Search Object Manager from the Managers menu, click on the 
Search Object Manager button on the managers tool bar, or type F11.

The list at the top of the manager window contains all search objects placed on the canvas.  This 
list displays each object's number, icon colour, drift starting point time and position, type, drogue 
status and activation status.  Immediately below the search object list are buttons that allow you 
to add new objects, duplicate or delete them, and activate or deactivate them.  The rest of the 
manager window comprises the Search Object Editor, which is used to edit a search object's 
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parameters.

When you open the Search Object Manager, the first search object in the list will be selected by 
default and the fields of the Search Object Editor will be filled with the values corresponding to 
that object.  If no search object has been added yet, the fields will be filled with the last settings 
used.  

To select a search object in the manager, click on it in the list; the selected object becomes 
highlighted (as is Object 2 in Figure 6.4) and a selection circle appears around its icon on the 
canvas.

6.2.1 Adding a New Search Object
To add a new search object, open the Search Object Manager and click on the New Search 
Object button.  The new search object will appear in the Search Object List.  New objects are 
added to the bottom of the list, so you may need to scroll down to see it.  The object is also 
assigned a unique colour and an search object icon this colour appears on the canvas at the 
object's drift starting position.

When added in this way, a new object's type and drift starting position are set to the values that 
appear in the corresponding fields of the Search Object Editor when it is created.  Its drift starting 
time is set to the time displayed on the scenario clock and its initial position error is set to 0. 
Leeway parameters are assigned automatically according to the object's type.

You may also add a new search object by right clicking on the canvas at the desired latitude and 
longitude.  This brings up the canvas menu; choose either Add Search Object (no Drogue) or 
Add Search Object (with Drogue) as appropriate and then select a type from the submenu that 
appears:
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This sets the object's type and its drift starting position; as with the first method, drift starting 
time is set by the scenario clock, initial position error is set to 0 and leeway parameters are set 
according to its type.

Finally, you may create a new search object by duplicating one that already exists.  This creates 
an exact copy of an existing object and assigns the new object its own colour.  See the section on 
duplicating search objects later in this chapter for more information.

6.2.2 Modifying Search Objects
Once a search object appears on the canvas, any of its parameters may be modified.  In fact, all 
search objects must be modified to some degree as initial position error must be set.  Search 
objects' parameters are modified in the Search Object Editor located in the bottom half of the 
Search Object Manager window.  See the Before You Begin... section at the beginning of this 
chapter for a brief introduction to the various search object parameters.

6.2.2.1 Selecting an Object to Edit  

If the Search Object Manager is already open, select the search object you wish to modify by left 
clicking on it in the Search Object List at the top of the manager window or by left clicking its 
icon on the canvas.  The line it occupies in the list becomes highlighted, a selection circle appears 
around its icon on the canvas and the fields of the Search Object Editor fill with the selected 
object's parameter values.
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If the Search Object Manager is not already open, you may left click on a search object's icon on 
the canvas to bring up the manager or right click on its icon and choose Edit Search Object from 
the canvas menu:

In either case, the manager opens with the selected automatically.

Caution: If objects are stacked on top of each other on the canvas, left or right clicking 
to bring up the manager will select the object in the stack that was created first – most  
likely the bottom object in the stack.  Make sure that the object you wish to modify is  
selected before you continue.

6.2.2.2 Applying changes  

Once the object is selected, you may modify its parameters by entering new values into any of 
the fields in the Search Object Editor and clicking the Apply button.  If you are making several 
changes, you may apply them individually, or make them all and then click Apply once they are 
all made.  The changes you make to an object will not appear in the Search Object List until they 
are applied.

None of your changes actually take affect until you apply them, so you may cancel your changes 
at any time by closing the manager without applying.  If you make changes to an object and then 
close the window or select (or create) another object without applying, you will be asked whether 
or not you want to apply before continuing.
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6.2.2.3 Search Object Type  

To change a search object's type, click on the small arrow to the right of the Search Object Type 
field and select the appropriate type from the drop down menu that appears:

When you set a search object's type, leeway divergence parameters for that type are automatically 
entered into the corresponding fields at the bottom of the Search Object Editor.

Note: CANSARP does not include a type for capsized or swamped rafts.  To simulate this 
type, select the appropriately sized raft and set the leeway divergence parameters to the 
following: coefficient 1.3%, 35º left and right angle of divergence, and correction -0.6.  
Drogue may be left on or off.
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Note: Search object type has no impact on drift calculations in CANSARP 5.0 apart from 
setting default leeway parameters.  Drift calculations are based entirely on leeway 
parameters, so if you add two objects of different types – a raft and a 300' ship, for 
instance – and then make their leeway parameters equal, the two objects' drift tracks will  
be identical.  Search object type does affect SRU sweep width calculations, however.

6.2.2.4 Drift Starting Point: LKP/EIP  

An object's drift starting point is comprised of two values: its drift starting position and its drift 
starting time.

To change an search object's drift starting position, type new values into the longitude and/or 
latitude fields or left click at the new position on the canvas to read new values into those fields 
automatically.  Once you apply this change, the new position is reflected in the Search Object 
List and the search object's icon moves to the new position on the canvas.

To change an object's drift starting time, type a new time into the Time field or advance or rewind 
the Time field just as you would the scenario clock.  As with the scenario clock, you may right 
click on the Time field to bring up the clock increment menu.

Caution: A search object's drift starting time is not the same as its drift track starting 
time.  For more information on drift track starting times, see Chapter 11: Drift And Search
Area Determination.

6.2.2.5 Initial Position Error: Fix Error  

All new search objects must be modified to account for their initial position error.  This value 
defaults to 0 but should be at least 0.25 NM – this is the margin of error for GPS, the most 
accurate position fixing method. 

If you know the degree of fix error, type it into the field to the right of the Fix... button. 
Otherwise, you may look up suggested values by clicking the Fix... button to call up the Fix Error 
dialog box:

48



Chapter 6: Search Objects and the Search Object Manager

Indicate whether the navigation is known or unknown by clicking on the arrow in the top right 
corner of the dialog box and choosing one or the other from the drop down menu that appears. 
Based on your choice, one of two tables will appear in bottom half of the window (NAV System 
Known appears in Figure 6.2).  If the navigation system is known, a list of navigation systems 
and electronic direction finding methods appears in the table; if the navigation system is not 
known, a list of vessels and aircraft types appears instead.  In either case, select the appropriate 
option and click OK; this automatically enters the suggested value into the fix error field in the 
Search Object Manager and closes the Fix Error dialog box.

6.2.2.6 Initial Position Error: DR Error  

If the drift starting position has been calculated using Dead Reckoning procedures, you must 
allow for a margin of error in that calculation as well.  If you know the degree of dead reckoning 
error, enter it into the field to the right of the DR... button.  Otherwise, you may look up the 
values outlined in the National SAR Manual based on calculated DR distance and vessel type.  

Hint: To calculate DR distance, use the linear range tool.  This tool is not available when 
the Dead Reckoning Error dialog box is open, so measure the distance before continuing 
to the next step.  If you have already opened the DR Error dialog box, close it to  
calculate DR distance, then reopen it.  The Search Object Manager may stay open during 
this process.
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To look up National SAR Manual values for DR Error, click on the DR... button to call up the 
Dead Reckoning Error dialog box:

Enter the DR distance into the field at the top of the dialog box, then select the appropriate type 
of vessel or aircraft in the table provided and click OK.  This will calculate the appropriate 
percentage of the distance traveled and enter it into the DR... field in the Search Object Manager. 
The Dead Reckoning Error dialog box closes automatically.

6.2.2.7 Leeway Parameters  

To turn leeway divergence on or off, click on the check box labeled Use Leeway Divergence.  If 
a check mark appears in the box, leeway is turned on for the selected search object and the 
parameter fields are editable.  If it is turned off, leeway is not included in drift calculations for the 
search object and the parameter fields are greyed out and cannot be edited.  

Hint: You can turn off the effects of leeway in drift calculations for ALL search objects on 
the wind drift forces sidebar or in the Wind Manager.  Doing so will override the 
individual search objects' settings but does not reset them; if you later turn leeway back 
on on the sidebar or in the Wind Manager, the individual objects' settings come into play 
once more.

When you set a search object's type, CANSARP automatically turns leeway divergence on or off 
as appropriate for that type and inserts the corresponding National SAR Manual leeway values 
into the leeway parameter fields at the bottom of the Search Object Editor.  To change any of the 
leeway parameter values, type new values into the fields next to the corresponding labels.
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Caution: The leeway values in the National SAR Manual were calculated using wind 
speeds measured at the 10 metre wave height (U10).  Be aware that winds measured at a 
higher wave height may be significantly greater than the U10 winds.  The values also 
assume a wind speed of 5 to 40 knots and should be used with caution for winds of more 
than 40 knots, as high waves may reduce the wind speed effect on the search object.  For 
wind speeds of less than 5 knots, do not apply the correction factor.

6.2.2.8 Drogue  

For many search object types, leeway values differ depending on whether or not a drogue is 
attached to the object.  For this reason, the drogue check box appears in the leeway parameters 
section of the manager window even though it is technically part of the search object type 
designation.

To indicate that the search object has a drogue attached, click the check box labeled With Drogue. 
You may remove the drogue by clicking the box a second time.  If a check mark appears in the 
box, drogue is turned on for the selected search object.  Turning drogue on or off resets the 
leeway parameters to the National SAR Manual values; if you have changed an object's leeway 
parameters and then change its drogue setting, you will have to re-enter the leeway parameters.

6.2.2.9 Colour  

You may change the colour assigned to a search object by selecting it and clicking on the Color 
button near the top of the Search Object Editor.  This brings up a small dialog box containing the 
list of available colours; drag the handle in the scroll bar on the right side of the box to see the 
entire list.  Click on the colour you wish to assign to the search object and then click OK.  This 
assigns the new colour and closes the dialog box.  The new colour appears in the Search Object 
List and the search object's icon on the canvas changes to match.

6.2.3 Duplicating Search Objects
Once a search object has been added, you may create an exact copy of it by selecting it and 
clicking the Duplicate Search Object button below the Search Object List.  A new search object 
is created, entered into the list and added to the canvas; it also becomes active so that it may be 
edited immediately.  

This is extremely useful in situations where multiple search objects have the same drift starting 
point or where one type of search object drifts from multiple points.  For example, suppose that a 
fishing vessel overturns and some of its crew deploy into rafts while others fall into the water.  In 
this case, you might create and configure a search object for the vessel itself, then duplicate it for 
the PIW and raft.  Since the duplicate objects would have the same drift starting point and initial 
position error as the fishing vessel, all you would need to change for each is its object type, as 
doing so automatically sets its leeway parameters to the appropriate values.  Alternately, if you 
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have a rough idea of the area in which a vessel has begun to sink, you might create and configure 
a search object for it at one end of the region, then duplicate it and move the copy's drift starting 
location to a point at the opposite end in order to bracket the possible area, leaving all other 
parameters the same.

6.2.4 Deleting a Search Object
To delete a search object, select it in the Search Object List and click the Delete button below the 
list.  Alternately, you may right click on its icon on the canvas and choose Delete Search Object 
from the canvas menu that appears.  If the search object was one of a stack of search objects, only 
the topmost object, the one visible on the canvas, will be deleted.

6.2.5 Deactivating and Reactivating Search Objects
During complex SAR operations with multiple search objects, the canvas can sometimes appear 
cluttered with too much information.  As well, CANSARP may take some time to calculate 
extended drifts, especially where multiple search objects are involved.  In these cases, it may be 
helpful to deactivate some search objects; deactivated objects still appear on the canvas, but their 
drift tracks are not calculated.

To deactivate a search object, select it in the Search Object List at the top of the Search Object 
Manager and then click the Deactivate button below the list.  Its activation status will change to 
“Inactive” in the Search Object List.  

To reactivate an inactive search object, select it in the Search Object List at the top of the Search 
Object Manager and then click the Activate button below the list.  Its activation status will 
change to “Active” in the Search Object List.  

6.2.6 Allocating SRUs
The Search Object Manager may be used to allocate a new SRU to the search.  To do this, select 
a search object and click the Allocate SRU button in the Search Object Editor.  This adds a new 
SRU to the SRU Manager and sets its search object type to the type of the search object you 
selected.

Caution: allocating an SRU in this way sets the SRU's search object type but does not  
link the SRU to the selected search object.  If you later change the search object's type,  
this change is not reflected in the SRU – you will also need to change the SRU's type in 
the SRU Manager.

SRUs and the SRU manager are discussed in detail in Chapter 12: Effort Allocation: SRUs And The
SRU Manager.
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6.2.7 Reverse Drift
To the right of the Time field in the Drift Starting Point section of the Search Object Manager 
window is a check box labeled Reverse Drift.  By turning on reverse drift, a search object may be 
set to drift backwards in time rather than forwards.

To toggle a search object between reverse and forward drift, click on the Reverse Drift check 
box.  If a check mark appears in the box, the object is set to drift backwards in time.  If it does 
not appear, the object will drift forward in time as usual.

Reverse drifts are covered in Chapter 11:Drift And Search Area Determination.

6.3 Search Objects and the Canvas Menu
You may perform several operations related to search objects from the canvas menu.  These 
include adding a new search object (with or without drogue), editing a search object, and deleting 
a search object.  To bring up the canvas menu, right click on the canvas.  You may add a search 
object at any location but in order to edit or delete a search object you must right click on the 
search object's icon.  The procedure for carrying out each of these actions is covered in the 
preceding sections of this chapter.

If search objects are stacked on top of each other on the canvas, as they will be if they share the 
same drift starting position, left or right clicking on the stack will affect the object at the top of 
the stack, i.e. the one that you can see on the canvas.  In the case of editing search objects, make 
sure that the object you intend to edit is the one selected once the Search Object Manager opens. 
To delete an object that's lower down in the stack, you must open the Search Object Manager and 
delete it from there.
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When the route a vessel expected to follow is known but the point along that path at which the 
incident occurred is not, a track line may used to model the vessel's speed and route.  The 
Trackline Manager is used to define such a track line, as well as to distribute search objects along 
the vessel's route in a manner that facilitates search planning in this situation.  This chapter 
introduces the Trackline Manager and covers the methods used to define and modify a track line, 
and to configure and deploy track line search objects.

In this chapter, you will learn:
• The purpose and composition of a track line

• The difference between track lines added by time and by speed

• How to use the Trackline Manager to add and manipulate track lines

• How to use the Trackline Manager to configure and deploy search objects

• How search objects deployed by the Trackline Manager are grouped together

• How track line search objects interact with the Search Object Manager

• How to modify individual track line search objects

• How to activate and deactivate track line search objects in deployment groups and 
individually

• How to clear and redeploy track line search objects

7.1 Before you begin...

7.1.1.1 The Purpose and Composition of a Track Line  

Track lines are used to model the route a vessel expected to travel and are comprised of way 
points and the track segments that join them.  The first and last waypoints are called end points; 
these represent the vessel's starting location (or its LKP) and its intended final destination. 
Interior waypoints are called turning points and represent intermediate destinations or points at 
which the vessel's course was expected to change.

For instance, if a fisherman left port with the intention of checking traps at three locations and 
then returning to port before dark, the end points of the track line would both be the port from 



Chapter 7: Track Lines and the Trackline Manager

which he left and planned to return, while the turning points of the track line would be the three 
locations where his traps were located.

The major benefit of using a track line is that CANSARP can automatically calculate the time at 
which the vessel was expected to reach any position along its course, not only the waypoints. 
This allows the Trackline Manager to deploy search objects with drift starting times that 
automatically compensate for the vessel's movement along its intended course.

Caution: One limitation of track lines as implemented in CANSARP 5.0 version 4.9.5.9 is  
that the vessel's speed is assumed to be constant along the entire length of the line.  This  
is expected to change in future versions of the program.

7.1.1.2 Behaviour of Search Objects Deployed by Track Lines  

Once deployed by the Trackline Manager, search objects appear in the Search Object Manager 
and behave like normal search objects except that they continue to be associated with the track 
line and may be manipulated to a limited extent via the Trackline Manager.  Furthermore, if the 
track line's search objects are cleared, they are removed from the Search Object Manager leaving 
those search objects not added by the Trackline Manager in place.  If the track line's search 
objects are redeployed, the existing track line search objects are removed from the Search Object 
Manager and new ones are added in their place.

Because the Trackline Manager deploys its objects into the Search Object Manager where they 
behave like standard search objects in all respects, you should review Chapter 6: Search Objects
And The Search Object Manager before reading this one.  In particular, you should be familiar 
with the four parameters that affect a search objects' drift calculation: object type, drift starting 
point, initial position error and leeway parameters.  This chapter will explain how to set these 
parameters for track line search objects but does not go into detail regarding their purpose or their 
effect on drift calculations.

7.2 The Trackline Manager
Most operations related to track lines are carried out via the Trackline Manager.  The manager 
has two primary functions: defining the track line itself – that is, the number, time and position of 
its points – and deploying and manipulating search objects distributed along the line's length.

To open the Trackline Manager, choose Trackline Manager from the Manager menu, or click on 
the Trackline Manager button on the manager tool bar.
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The table at the top of the manager window lists the way points that comprise the track line; if no 
points have been added, this table is empty.  The way point list displays each point's number, 
latitude, longitude, and time.  Points are numbered and listed in order according to their times, 
which represent the time at which the vessel was expected to reach each way point as it followed 
its intended course.  You must set the first node's time and, in some cases, the last node's; the 
times of all turning points are calculated automatically.  See the sections relating to adding a track 
line by speed or by time for further details on how time values are calculated.  

Immediately below the list of points are buttons that allow you to delete a single node or to clear 
the track line entirely.  Below these are radio buttons which determine the action performed when 
the track line is manipulated with the mouse.  See the sections on editing points and track lines 
for further information on both these subjects.  Below the radio buttons is a check box that 
indicates whether or not the waypoint labels appear on the canvas; clicking on this check box 
toggles the display on and off.

The bottom half of the Trackline Manager window contains three tabs: the Track line Details tab, 
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the Deploy Search Objects tab and the Search Object List tab.  The first of these is covered in the 
following sections on adding track lines and editing points.  The second is covered in the section 
on deploying track line search objects.  The third tab contains a list of search objects associated 
with the track line in the same format as the search object list in the Search Object Manager – see 
Chapter 6: Search Objects And The Search Object Manager for further information..

7.3 Adding a Track Line
Each scenario may have only one track line at a time.  If a scenario already as a track line, it must 
be cleared before another one may be added.  Although this does not automatically remove any 
search objects associated with the original track line, deploying search objects from a new line 
removes any search objects associated with the old one from the Search Object Manager.

7.3.1 How to Draw a Track Line
Track lines are drawn directly on the canvas by clicking with the mouse at the various way points 
that comprise the line.  To draw a track line, left click on the canvas at the position of the first end 
point, which will likely be the vessel's LKP or the port from which it left.  Then left click at each 
of the vessel's turning points in the order it expected to arrive at each.  Finally, right click at the 
vessel's expected destination or the last point on the line.  Right clicking finishes the draw 
routine; until you right click, anything you do with the mouse can be interpreted as adding new 
way points to the track line.  This process is illustrated in Figure 7.2:
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Don't be too concerned with adding the way points at exactly the right latitude and longitude as 
their positions can be changed easily later.  If you have added too many way points, the 
extraneous points can be deleted easily as well.  See the section on editing a track line for 
instructions on how to move or delete way points as well as other editing options.

7.3.2 By Speed Vs. By time
The first step in adding a track line is deciding whether to add it by speed or by time.  This 
selection is made before the track line is added and determines the way in which the times of all 
points after the first are calculated.  This choice cannot be changed after a track line is added; to 
change from one mode to the other, you must clear the track line completely and readd it using 
the other method.

When adding a track line by speed, you set the rate of travel and the time of the first node 
yourself; all later points' times are calculated according to how much time is required to travel the 
distance from one node to the next at the given speed.  When adding a track line by time, you 
must set the time of the first and last node yourself.  CANSARP calculates the speed required to 
travel the total distance of the line within that time period and assigns times to the turning points 
accordingly.

Note: Speed is assumed to be constant along the track line's entire length whether it is  
added by speed or by time.  It is not possible to change the rate of travel from one section 
of the track line to another.  
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If you know the vessel's intended rate of travel, add the track line by speed.  If you know the time 
at which the vessel left port (or the first location on the track line) and the time at which it 
expected to arrive at its final destination (or the last location on the track line), add the track line 
by time.

7.3.3 Adding a Track Line by Speed
A track line should be added by speed when you know the time at which the vessel left the first 
location on the line and the rate at which it was traveling.  In this case, you will set the time of 
the first end point and CANSARP will automatically calculate the times of all other way points.

To add a track line by speed, open the Trackline Manager and make sure that Track Line Details 
tab is displayed, as in Figure 7.1.  If a track line has already been added, you must clear it before 
adding a new one.  If no track line has been added, the Mode radio buttons labeled By Speed and 
By Time are enabled.  Note that a track line has already been added in Figure 7.1 so these radio 
buttons are disabled.

First, make sure the By Speed radio button is selected; to select it, click in the circle to the left of 
the button label.  Next, set the scenario clock to the time of the first way point.  Third, set the 
speed at which the vessel was expected to travel by entering the appropriate value into the 
Search Object Speed field or using the up and down arrows to the right of the field to modify the 
speed shown.  Finally, draw the trackline on the canvas as described above.  

As you draw the track line, the times of all way points after the first are automatically calculated 
based on their distance from the previous way point and the speed at which the vessel is 
traveling.  The total range of the track line is also calculated and represents the entire length of 
the track line as drawn (rather than straight from the first point to the last).

7.3.3.1 Modifying Way Points Added by Speed  

Once you right click to end the track line, you can select any way point in the way point list and 
then modify its latitude and/or longitude by changing the values in the Lat and Lon fields at the 
top of the Track Line Details tab.   You may also change the vessel's speed, which automatically 
recalculates the times of way points after the first.  You must click the Apply button after making 
either of these changes.

You may change the time of the first way point only.  If you do, all other way points' times are 
automatically adjusted.

7.3.4 Adding a Track Line by Time
A track line should be added by speed when you know the time at which the vessel left the first 
location on the line (often its LKP) and the time at which it expected to reach its final destination. 
In this case, you will set the time of the first and last end points and CANSARP will 
automatically calculate the speed required to travel from one to the other as well as the times of 
all turning points.
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To add a track line by time, open the Trackline Manager and make sure that Track Line Details 
tab is displayed, as in Figure 7.1.  If a track line has already been added, you must clear it before 
adding a new one.  If no track line has been added, the Mode radio buttons labeled By Speed and 
By Time are enabled.  Note that a track line has already been added in Figure 7.1 so these radio 
buttons are disabled.

First, make sure the By Time radio button is selected; to select it, click in the circle to the left of 
the button label.  Next, enter the time the vessel left the location of the first way point into the 
Start field.  Third, enter the time at which the vessel expected to arrive at the final way point into 
the End field. Finally, draw the trackline on the canvas as described above.

Caution: You must set the start and end time before you begin to draw the track line, and 
the end time must come after the start time chronologically.  If it is the same or earlier 
than the start time, CANSARP cannot calculate the times of the turning points accurately.

As you draw the track line, the total range of the track line is calculated.  The speed at which the 
vessel must have traveled to traverse the entire line between the given start and end times is also 
calculated and the times of all turning points are set accordingly.

7.3.4.1 Modifying Way Points Added by Time  

Once you right click to end the track line, you can select any way point in the way point list and 
then modify its latitude and/or longitude by changing the values in the Lat and Lon fields at the 
top of the Track Line Details tab.   You must click Apply before these changes are accepted.

You may not change the vessel's speed, as it is calculated automatically based on start and end 
times and the total range of the track line.

You may change the times of the first and last way points only, by changing the times displayed in 
the Start and End fields at the bottom of the Track Line Details tab.  If you do, all turning points' 
times are automatically recalculated.

Caution: Although it is possible to modify the time displayed in the Time field for the first  
way point in a track line added by time, doing so has no effect.  To change the start time 
of a track line added by time, modify the time displayed in the Start field at the bottom of  
the Track Line Details tab.

7.4 Editing a Track Line
Once a track line has been drawn on the canvas, it may be modified in a variety of ways.  
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7.4.1.1 Changing the Speed of a Track Line  

A track line's speed may only be modified if the track line was added by speed.  To do so, open 
the Track Line Details tab of the Trackline Manager and enter a new value into the Speed field or 
adjust the value displayed by clicking on the up and down arrows to the right of the field.  You 
must click the Apply button for this change to take effect.

7.4.1.2 Changing the Times of Way Points  

If the track line was added by speed, only the first end point's time may be set directly.  To do so, 
select the first way point in the way point list at the top of the Trackline Manager window and 
change the value displayed in the Time field near the top of the Track Line Details tab.  You must 
click the Apply button for this change to take effect.

If the track line was added by time, both end points' times may be set directly.  To do so, change 
the values displayed in the Start and End fields near the bottom of the Track Line Details tab. 
Although it is possible to select the first way point and change the value displayed in the Time 
field near the top of the tab, this does not actually affect the starting time of the track line.

The times of a track line's turning points can never be set directly by the user.  

7.4.1.3 Changing the Positions of Way Points  

To reposition a way point, select the way point in the list at the top of the Trackline Manager 
window and then change the values in the Lat and Lon fields at the top of the Track Line Details 
tab.  This method works best if the way point's position is known with a high degree of accuracy. 
You must click the Apply button for this change to take effect.

A second method of repositioning a way point that is less precise but often more convenient 
involves the mouse and is described later in this section.

7.4.1.4 Deleting Way Points  

To delete a way point, select that way point in the list at the top of the Trackline Manager window 
and then click the Delete button below the list.  A second method for deleting a way point 
involves the mouse and is described later in this section.

7.4.1.5 Clearing the Track Line  

To remove the track line completely, click the Clear Track Line button below the way point list in 
the Trackline Manager.  Note that this removes all the way points from the canvas but does not 
remove any search objects previously deployed via the Trackline Manager.  Such search objects 
will still appear on the Search Object List tab of the Trackline Manager and may be cleared there.

7.4.2 Manipulating a Track Line Via the Mouse
Once drawn, a track line may be manipulated in a number of ways by left clicking or dragging 
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the mouse on the canvas.  The behaviour of the mouse while the Trackline Manager is open is 
determined by which radio button is selected in the region labeled “Left Click Behaviour” in 
Figure 7.1.  To change the mouse's behaviour, click in the circle to the left of the label 
corresponding to the desired behaviour.  Note that these mouse behaviours apply regardless of 
which of the three tabs are displayed at the bottom of the manager window.

Before manipulating the track line or any of its way points, it may be helpful to turn on way point 
labels.  This causes numerical labels to appear on the canvas near each way point that correspond 
to the labels in the way point list, and makes it easier to tell which way point is being 
manipulated.  To toggle way point labels on or off, click on the check box labeled Show 
Waypoint Labels below the mouse behaviour buttons.

7.4.2.1 Moving Way Points (Move Node)  

If the Move Node mouse behaviour is selected, left clicking on the canvas near any way point 
will reposition that point to the spot at which you clicked.  The way point nearest to the new 
location will move.

If you left click on a way point and hold the button down while you drag the mouse, the way 
point will reposition to the location at which you release the mouse button.  This method works 
better than the first if you are trying to move one way point close to another, as you can be sure 
of which way point will move.

If you use this second method, the latitude and longitude of the mouse's position is displayed in 
the Lat and Lon fields of the Track Line Details tab as you drag the mouse so that you may place 
the point precisely.  However, if you wish to move a way point to an exact position, it is easier to 
simply modify the values of the Lat and Lon fields in the Track Line Details tab directly as 
described earlier.

7.4.2.2 Inserting a New Turning Point (Insert Node on Existing Segment)  

To add a new turning point to a track line, set the mouse behaviour to Insert Node On Existing 
Segment and then left click on the canvas at the location of the new point.  This inserts a new 
way point into the segment closest to the point at which you clicked, and calculates its time 
according to the method by which the track line was added.  Whichever method was used, the 
new point's time will fall between the times of the way points at the ends of the original segment.

The time of the new point is calculated automatically according to the method in which the track 
line was added.  If the track line was added by speed, the times of all later turning points are also 
adjusted.  If the track line was added by time, the times of all turning points are adjusted to 
account for the change in speed required to accommodate the new track line segments.
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Hint: If the new point's location is nearer to a track segment other than the one to which 
it should be added – that is, if it would be out of chronological order by adding it to the 
closest segment as may happen if the vessel's course changes direction dramatically at  
some point – add the new way point near the correct track segment chronologically 
speaking and then move it to the proper position.

7.4.2.3 Extending the Track Line (Add Waypoint)  

To add a new end point to a track line, select the Add Waypoint mouse behaviour and then left 
click on the canvas at the location of the new end point.  This connects the new point to the 
nearest original end point and turns the original end point into a turning point.  

If the new end point was added to the beginning of the track line, its time is set to the track line's 
beginning time.  If the track line was added by speed, all other points' times are recalculated to 
account for the time required for the vessel to traverse the new track segment.  If the track line 
was added by time, all the turning points' times are recalculated to account for the change in 
speed due to the increase in the track line's total range.

If the new end point was added to the end of the track line and the track line was added by speed, 
its time is calculated automatically and no other way points are affected.  If the track line was 
added by time, however, the times of all turning points' are recalculated to account for the change 
in speed due to the increase in the track line's total range.

Hint: If the new end point's location is nearer to the opposite end from the one to which it  
should be added – that is, if it would be out of order chronologically by adding it to the 
closest end, as may happen if the vessel is returning to port – add the new end point near 
the correct end chronologically speaking and then move it to the proper position.

7.4.2.4 Repositioning the Track Line (Drag Track Line)  

You may drag the entire track line to a new location without changing the angles between or the 
length of any track segments.  To do so, first select the Drag Track Line mouse behaviour and 
then left click on the canvas near the track line and hold down the mouse button as you drag. 
This changes the positions of every way point but has no effect on their times.

7.4.2.5 Deleting Way Points (Delete)  

You may delete a way point from a track line by clicking with the mouse on the canvas.  To do 
so, select the Delete mouse behaviour and then left click on or near the point you wish to delete. 
The point closest to the location at which you clicked will be deleted.  This works for both end 
points and turning points.
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7.4.2.6 Locking the Track Line (Lock Track Line)  

Once the track line is defined with all way points in their correct positions, it is a good idea to set 
the mouse behaviour to Lock Track Line.  This prevents any of the other possible mouse 
behaviours from acting upon the track line and eliminates the possibility of inadvertently moving 
or deleting any way points or otherwise manipulating the line with the mouse.  Note, however, 
that it does not prevent changes being made to the track line by changing the values in fields of 
the Trackline Manager window or using the Delete or Clear Track Line buttons.

7.5 Deploying Search Objects
After a track line is complete, search objects may be distributed along its length.  These search 
objects must be configured as they are when added via the Search Object Manager and, once 
deployed, may be further manipulated via both the Trackline Manager and the Search Object 
Manager.  These actions are performed via the second tab of the Trackline Manager, the Deploy 
Search Objects tab shown in Figure 7.3. 
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7.5.1 Distributing Search Objects Along a Track Line
You have two options when distributing search objects along a track line's length: you may 
deploy them at each way point or you may deploy them at a number of evenly spaced locations 
along the track line's length.

To deploy search objects at way points, including both end points and turning points, click the 
radio button labeled at waypoints to select it.  

To distribute search objects evenly along the track line's length, first click the radio button 
labeled equally spaced as shown in Figure 7.3.  Next, enter the number of locations at which to 
deploy search objects in the Num. Search Objects field or use the up and down arrows to adjust 
the value displayed.  Note that search objects are always deployed at the track line's end points, 
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so choosing 5 locations as in Figure 7.3 would deploy search objects at each end point and at 
three locations between them.

Caution: Although the field is named Num. Of Search Objects the value displayed in it  
actually determines the number of deployment locations.  The number of search objects  
to deploy at each location is set elsewhere.  The total number of search objects deployed 
is the number of deployment locations multiplied by the number of search objects 
deployed at each.

7.5.2 Configuring Search Object Parameters
Search objects deployed by the track line manager must be configured just as normal search 
objects are.  The manager automatically calculates the drift starting point time and position of the 
search objects it deploys but you must still set their type, including the presence or lack of a 
drogue, and their initial position error.  Leeway parameters are assumed to be normal for the 
selected type(s).  For details on each of a search object's four parameters, see the Before You 
Begin section of Chapter 6: Search Objects And The Search Object Manager.

7.5.2.1 Search Object Type  

The two tables at the bottom of the Deploy Search Objects tab are used to set the number and 
type of search objects the Trackline Manager will deploy at each location.  The left table lists 
search objects without drogue and the right table lists search objects with drogue.  To select one 
or more of these objects, click on the leftmost check box in the double row of boxes to the left of 
each type.  You may select as many types from one or both lists as you require; a search object 
corresponding to each type will be deployed at each of the deployment locations.

7.5.2.2 Drift Starting Point  

Drift starting points for each search object deployed by the Trackline Manager are automatically 
calculated based on the time of each position on the track line.

7.5.2.3 Initial Position Error  

To set the initial position error for objects deployed by the Trackline Manager, enter values into 
the Fix and DR fields in the same manner as described in .  These values apply to all objects 
deployed by the manager.

7.5.2.4 Leeway Parameters  

Leeway parameters are assumed to be normal for the selected search object type(s).  The 
Trackline Manager has no facility for adjusting leeway parameters.
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7.5.3 Deploying the Search Objects and the Search Object List
Once you have selected a distribution pattern and configured the search objects' parameters, you 
may deploy them by clicking the Deploy Search Objects button.  This automatically chooses a 
colour for each object type and deploys the selected combination of objects at each deployment 
location.  The same colour is used for a particular object type at each location, so that you may 
easily see which icons and drift tracks correspond to that object type in each group.

All of the search objects deployed by the Trackline Manager are listed on the manager's third tab, 
the Search Object List tab, as shown below:

Search objects tied to a track line also appear in the Search Object Manager's search object list.

7.6 Modifying Deployed Search Objects
Once search objects are deployed by the Trackline Manager, they appear in the Search Object 
Manager where they can be modified individually like any other search object.  Specifically, 
leeway parameters may be set via the Search Object Manager if they differ from the default 
values for a search object's type.  Any other change normally possible within the Search Object 
Manager, such as icon colour, activity status, presence or lack of a drogue, etc. may also be made 
to search objects deployed by the Trackline Manager.

Changes made to one search object via the Search Object Manager do not affect others in its 
deployment location, nor to others of the same type at other deployment locations.

7.6.1.1 Changing Activity Status  

In addition to toggling a single object between an active and inactive state in the Search Object 
Manager, you may make a particular search object deployed by the Trackline Manager active or 
inactive at all its deployment locations at once.  To do so, open the Deploy Search Objects tab of 
the manager and click the rightmost check box in the pair of boxes to the left of the search 
object's type (in the column labeled v for visibility).  This has the same effect as making each of 
the individual objects active or inactive within the Search Object Manager.  See Chapter 6: 
Search Objects And The Search Object Manager for more information.

7.7 Deleting and Redeploying Search Objects
An individual search object deployed by the Trackline Manager may be deleted via the Search 
Object Manager in the usual fashion by selecting it in that manager and clicking the Delete 
button.  The search objects deployed by the Trackline Manager may also be deleted en masse via 
the Trackline Manager itself by switching to its Search Objects List tab and clicking the Clear 
Search Objects button.

If you change the track line or wish to alter the types or distribution of search objects tied to it, 
you may redeploy the track line's search objects by clicking the Deploy Search Objects button in 
the Trackline Manager a second time.  There is no need to delete previously deployed search 
objects before doing so, as the Trackline Manager keeps track of which search objects are tied to 

67



Chapter 7: Track Lines and the Trackline Manager

a track line and, when objects are redeployed, removes all previous objects from the Search 
Object Manager and the canvas before the adding new ones.  You may redeploy search objects 
along a track line repeatedly.

Note that clearing a track line does not delete the search objects deployed by the Trackline 
Manager.  The search objects will remain on the canvas and in the Search Object Manager until 
they are deleted via either manager, cleared in the Trackline Manager, or until the objects are 
redeployed via the Trackline Manager. 
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Chapter 8
Environmental Time Series Data and 

the Time Series Editor

Much of the current and wind data that CANSARP uses to simulate drift is organized as time 
series.  It is important to understand how to read and interpret these time series in order to use 
them correctly; specifically, an understanding of time series is particularly important when 
adding wind or current data into a simulation manually.  This chapter explains how to read and 
interpret time series.  It also introduces the Time Series Editor and explains how it is used to add 
and modify environmental data.

In this chapter, you will learn:
• How environmental data is arranged in vectors and time series

• How to display time series on the canvas 

• How to open time series in the Time Series Editor

• How to use the Time Series Editor

• How to interpret time series data

• How to add new time series

• How to modify existing time series

8.1 Before you begin...

8.1.1 Vectors and Time Series
A single piece of data in an environmental time series is called a vector.  Vectors represent speed 
and direction; each also has a time stamp that identifies when the the wind or current was moving 
in the given direction at the given speed.  In CANSARP, a time series is a collection of such 
vectors all at the same latitude and longitude; it gives a picture of how winds or currents are 
changing over time in that location.  A time series may contain many vectors or just a single one.

Caution: Although some of the canvas menu options refer to vectors, these options 
actually act on complete time series, not on individual vectors.
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8.1.2 Range of Influence
Because environmental data isn't available in every single location for every moment in time, 
CANSARP fills in the gaps between data points by allowing each vector to exert its influence 
over a wider region and a span of time.  The region is referred to as the time series' radius of  
influence and the span of time as its persistence.  Collectively, these two values are the time 
series' range of influence.  The default radius and persistence of different types of environmental 
data are show in Table 1.

Data type Radius of Influence Persistence
Wind 100 NM +/- 3 hours

Current 10 NM +/- 3 hours
SLDMB 10 NM +/- 0.5 hours

Table 8.1: Default range of influence by environmental data type

Whatever its range of influence, a vector's speed and direction is considered to apply to the entire 
region within the given radius about its position and for the given number of hours before and 
after its time stamp. 

As more than one vector may exert its influence over a given point at a given time, CANSARP 
employs an interpolation method which combines the data from up to eight vectors distributed 
about the given point to produce these intermediate values.

8.1.3 Only Some Data May Be Opened
Not all of the environmental data CANSARP uses is arranged in time series and not all of it can 
be opened in the Time Series Editor.  All data entered by an SMC (measured currents, subjective 
currents and subjective wind) may be opened and edited.  CMC wind data and SLDMB current 
data may also be opened and read but care should be taken when editing these types of data.  For 
more information on editing data from external sources, see the sections on CMC and SLDMB 
data in the next two chapters.

Caution: In CANSARP 5.0 version 4.9.5.9 Grand Banks model data may also be opened 
in the Time Series Editor but it should not be edited.

Other types of data, such as sea, tidal currents, and IML currents do not have the same data 
format and cannot be opened in the Time Series Editor.

8.2 Displaying Time Series on the Canvas
Time series of all types appear on the canvas as an Х; the colour of the Х indicates the type of 
data.  If the time series is not deactivated and it contains a vector whose range of influence covers 
the time currently displayed on the scenario clock, the Х is superimposed with another icon that 
indicates whether the time series contains current data (an arrow) or wind data (a feather).  For 
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more information on colour coding and the icons associated with each type of environmental 
data, see Chapter 9: Environmental Data: Current Data And Models and Chapter 10: Environmental
Data: Wind Data And Models.

The following table lists the default colour scheme for environmental time series (these colours 
can be changed in the Map Properties window):

Type of Data Colour
Subjective Wind Red

CMC Wind Cornflower blue
Measured Current Sea green
Subjective Current Orange red
Modeled Current Medium blue

Table 8.2: Colour of time series icons by environmental data type

8.3 Opening a Time Series in the Time Series Editor 

8.3.1 Opening a Time Series from the Canvas
The easiest way to open a time series of any type in the Time Series Editor is to left click on its 
icon on the canvas.  In order to do this the icon must be visible, so first make sure the appropriate 
data type is turned on in the Map Options sidebar to the left of the canvas.  For instance, to open 
a measured current time series, make sure the checkbox labeled Measured Currents is checked. 
When you left click on the icon, the Time Series Editor opens and contains the selected time 
series.

8.3.2 Opening User Entered Data from a Manager
Three types of environmental data are entered directly into the simulation by an SMC: measured 
currents, subjective currents and subjective winds.  These types of data may be opened in the 
Time Series Editor from their respective managers.  To do this, open the manager in question, 
switch to the tab labeled with the type of data you wish to open, select a time series from the list 
displayed and then click the Edit Time Series button. 
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All other environmental data is loaded from external sources and, though it is possible to read 
some of it in its time series format, care should be taken when editing this data.  Generally 
speaking, changes to data from external sources should be limited to changing its activation 
status.  These types of data may only be opened by left clicking on the time series' icons as 
described previously.

Note: If you make any change to a time series containing CMC wind data, it is  
automatically converted to a subjective wind and, from that point on, it is considered a 
subjective wind for purposes of calculations and for display on the canvas.  Its ID 
remains unchanged to indicate its original source, but its icon colour changes to match 
other subjective winds.
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8.4 Interpreting Time Series Data
Once opened, a time series appears in the Time Series Editor.  The name of the window will 
change depending on the type of data but its fields and their function remain the same regardless.

8.4.1 Time Series Parameters
The top portion of the Time Series Editor displays the parameters of the time series itself: its ID, 
its position, its range of influence and its activation status.  This information applies to every 
vector that the time series contains.
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8.4.1.1 Time Series ID and Position  

Every time series has an ID that indicates the source of the data.  For instance, the time series in 
Figure 8.3 has the ID ANAL/FCST because it contains analyzed and forecast wind data from the 
CMC.  Other examples of IDs are the call sign of the ship that provided the data, the ID of the 
buoy or weather station that measured it, or the name of the data model that generated it.  User 
entered data is automatically assigned an ID according to its type.

Because more than one time series will have the same source, this ID is not unique.  When data is 
entered correctly, however, each source will usually produce only one time series at a given 
latitude and longitude, so the time series' position along with its ID should identify it uniquely.

8.4.1.2 Range of Influence  

Recall from the Before You Begin... section of this chapter that a vector represents wind or current 
speed and direction at a specific latitude and longitude at a particular moment in time but exerts 
its influence over a larger region for a longer span of time.  This radius and time span are set by 
the series to which the vector belongs and are common to all vectors a time series contains.

The number of hours displayed in the Time field in the series parameters section of the editor 
window indicates the number of hours before and after each vector's time stamp during which the 
vector's speed and direction will apply.  The distance displayed in the Radius field indicates the 
extent of the geographic region in which the same is true.  

In the above example, the time series' range of influence is three hours and 100 nautical miles. 
Looking at the vector that is highlighted in the vector list as an example (see Figure 8.3), 
CANSARP will assume that wind speed is 12.0 knots per hour at 200.0 degrees within 100 NM 
of 47:0.00N, 059:0.00W from 15:00 GMT to 21:00 GMT.  These values are adjusted if other 
vectors from other time series are influencing the same region at the same time using 
CANSARP's interpolation method.

8.4.1.3 Activation Status  

A time series may be deactivated so that it isn't used in drift calculations even when the current or 
wind force it belongs to is turned on.  To toggle a series' activation status, click on the checkbox 
labeled Deactivate.  See Section 8.6 later in this chapter for further details.

8.4.2 Vector List
This table displays all the vectors that make up the time series.  A series may contain only a 
single vector or may contain many.  SLDMB data, for instance, contains only one vector per 
series because the buoys continually move, whereas some CMC data series can contain 50 
vectors or more.

The table displays the time stamp, direction and speed of each vector in the series.  If there are 
more than four vectors, you may see the others by dragging the slider in the scrollbar on the right 
side of the table up and down or by rolling the mouse's wheel over the table.
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8.4.3 Vector Parameters
When a vector is selected in the vector list, its vector parameters (time stamp, direction and 
speed) are also displayed in the fields below the vector list.  These fields may be used to modify 
the parameters of the selected vector or to add a new vector to the series as described in the next 
section.

8.5 Adding a New Time Series
To add a new environmental data time series to the simulation, right click on the canvas at the 
time series' latitude and longitude and then choose the type of data you wish to add from the 
menu that appears.  Don't be too concerned about clicking at exactly the right position as this can 
be corrected easily later if need be.

This will open the Time Series Editor and set its series parameters by default.  The time series' 
position is set by the location at which you clicked on the canvas.  Its range of influence is set to 
3 hours and 100 NM in the case of current vectors, or to the default values set on the Wind 
Options tab of the Wind Manager in the case of winds (which is also 3 hours and 100 NM unless 
it has been changed).  If the time series is a subjective wind, its ID is set to WIND.  If it is a 
measured current, its ID is set to MEASURE.  If it is a subjective current, its ID is set to SUBJ.

A new time series contains no vectors until you add one.  If you close the Time Series Editor 
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without adding any vectors, the time series will be empty.  An empty time series has no impact on 
drift calculations.

8.5.1 Adding the First Vector to a Time Series
When an empty time series is opened or when a new time series is added, the Time field in the 
vector parameters section defaults to the time currently displayed on the scenario clock and the 
Direction and Speed fields default to 0.  To add a vector to such a series, adjust the time, 
direction and speed of the new vector as required by entering new values into these fields.  Once 
all three fields are set, click the Apply button at the bottom of the editor window to add the vector 
to the time series.  The new vector will appear in the vector list.

8.5.1.1 Direction of Wind and Current Vectors  

Wind vectors are drawn upwind, in the direction the wind is blowing from.  A wind vector with a 
direction of 315º describes a wind blowing from the northwest to the southeast.  If the time on the 
scenario clock is within the vector's range of influence, the wind's “arrow” (the line plus the 
feathers) points downwind.  Think of it like an arrow flying at a target, with the head of the arrow 
in the target and the feathers pointing back in the direction from which the arrow came.

Current vectors are drawn downstream, in the direction the water is moving.  A current vector 
with a direction of  315º describes a current flowing from to northwest.  If the time on the 
scenario clock is within the vector's range of influence, the current's arrow icon points 
downstream.

8.5.1.2 The Vector Compass  

Alternately, you may set the speed and direction of the selected vector by “drawing” it on the 
vector compass near the bottom of the Time Series Editor.  The angles of the compass are labeled 
around its perimeter.  The speeds represented by the concentric circles are labeled along the right 
side of the horizontal axis.  For example, in Figure 8.3 the circles are labeled 10, 20, and 30 so a 
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vector drawn on the compass would be between 0 and 30 kph.

The compass defaults to medium speeds, which are 10-30 kph for winds and 2-6 kph for currents. 
Before drawing a vector on the compass, you may change this scale to one that makes it easier to 
“draw” the vector's speed.  To change the scale, click on the scale selection button to the right of 
the compass.  The low, medium and high ranges vary depending on the type of data, as indicated 
in the following table:

Scale Wind (kph) Current (kph)
Low 5, 10, 15 1, 2, 3

Medium 10, 20, 30 2, 4, 6
High 20, 40, 60 3, 6, 9

Table 8.3: Speed scale ranges in vector compass by environmental data type

Once the speed scale is set, left click within the compass at the point which indicates the correct 
direction and speed of the vector.  For instance, if the wind is blowing from the northwest at 20 
kph, click along the 315º axis on the 20 kph line.  When you do so, the direction and speed of the 
selected vector are set corresponding to the point at which you clicked and the new values appear 
in the Direction and Speed fields below the vector list.  

You may also left click and hold the mouse button down while you drag the vector line around 
the compass.  The Direction and Speed fields change as the mouse pointer moves so that you can 
see the result of releasing the mouse at any point.  When you do release the mouse, the selected 
vector is modified and the fields are set.

8.5.2 Adding Additional Vectors to a Time Series
Once a time series contains at least one vector, one of its vectors is always selected and that 
vector's parameters appear in the fields below the vector list.  To add a new vector, change the 
Direction and Speed fields as necessary using either method described above, and then change 
the Time field and click Apply.  The new vector will be inserted into the vector list in 
chronological order.  

Note that changing a vector's direction and/or speed and clicking Apply without changing its time 
will simply modify the selected vector rather than create a new one.

8.6 Modifying a Time Series
Once a series is open in the Time Series Editor, you may modify its series parameters as well as 
the individual vectors.

8.6.1 Changing Time Series Parameters
To modify a time series parameter (ID, position or range of influence), simply modify the 
contents of the field(s) you wish to change and then click the Apply button.
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8.6.2 Deactivating a Time Series
When a time series is deactivated, it exerts no influence on the region surrounding it and is not 
included in interpolation calculations.  When a time series is activated, it only influences the 
region surrounding it and is only included in interpolation calculations if its drift force is turned 
on.

To deactivate a time series, click the checkbox labeled Deactivate at the top of the editor window, 
to the right of the time series' ID.  To reactivate it, click the checkbox a second time.

8.6.3 Adding a New Vector
The procedure for adding a new vector to an existing time series is the same as that for adding a 
vector to a new time series.  See the previous section for details.

8.6.4 Deleting a Vector
To delete a vector from a time series, select that vector in the vector list and then click the Delete 
button at the bottom of the editor window.

8.6.5 Modifying a Vector
To modify a particular vector, select that vector in the vector list.  Its time stamp, speed, and 
direction will appear in the corresponding fields below the vector list.  You may modify its 
direction and speed by entering new values into the fields or by using the vector compass as 
described in the previous section.

Note that you cannot change an existing vector's time simply by changing the value that appears 
in the Time field when it is selected, as this adds a new vector instead of changing the existing 
one.  To change an existing vector's time, select the existing vector, change its time and click 
Apply (to add the new vector with the same direction and speed as the existing one), then re-
select the original vector in the vector list and delete it as described above.
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8.7 Deleting a Time Series
There are two ways of deleting a time series entirely: via the canvas menu or from the Wind or 
Current Manager.

Any time series may be deleted via the canvas menu.  To do so, right click on its icon on the 
canvas and then choose Delete Wind/Current Vector from the menu when it appears.  The icon 
must be visible on the canvas to do this, so first make sure the appropriate data type is turned on 
in the Map Options sidebar to the left of the canvas.  For instance, to delete a wind time series, 
make sure the checkbox labeled Subjective Winds is checked.  Any time series may be deleted 
from the canvas using this method. 

User entered time series (subjective winds, measured currents and subjective currents) may be 
deleted from their respective managers.  To do so, open the Wind or Current Manager as 
appropriate and switch to the tab that corresponds to the type of data you wish to delete.  All the 
time series of the type indicated by the tab's title will be listed in the table that appears on that 
tab.  If the table seems incomplete, click the Update List button to refresh the list.  Select the 
series you wish delete from the list and click the Delete button (see Figure 8.3).  
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Hint: Unless a time series was entered by mistake, it may be preferable to deactivate the 
series rather than deleting it so that you have the option of reactivating it later should 
you decide to include it in drift calculations again.  When a series is deactivated, it has 
no impact on calculations so the effect is the same as deleting it.

Chapter 9
Environmental Data: Current Data and Models

CANSARP makes use of as many as seven different types of current data in its drift calculations, 
including data produced by static and dynamic models, data entered by the user as measured or 
subjective currents, and data loaded from self locating datum marker buoys (SLDMBs).

This chapter introduces each type of current data and explains how they interact and when each 
type is appropriate to use.  It also introduces the Current Manager and how it is used to 
manipulate current data.

In this chapter, you will learn
• What types of current data are used by CANSARP

• How these types are prioritized and which types are preemptive and additive

• How dynamic models and static data models differ

• How dynamic current model data is acquired

• How measured currents and subjective currents differ and when to use each

• How to load and use data from SLDMBs

• How and when to use the various data models

• Which data models require the use of wind driven currents and which do not

• What geographic regions are covered by each data model

• How to override the default selection of tidal currents

• How to change the appearance of current vectors on the canvas
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9.1 Before you begin...

9.1.1 Data Priority and Additive vs. Preemptive Data Types
All current data types have a priority; if a search object falls within the range of influence of 
more than one type of data, the types with higher priority are used in drift calculations before 
types with lower priority.  Furthermore, all current data types are either preemptive or additive. 
Generally speaking, real time data and the dynamic models are preemptive while the static 
models are additive.  Table 9.1 lists the various types of data in order of priority from high to low 
and indicates whether each type is preemptive or additive.

Data Type Rule for Combination
Measured Currents Preemptive

SLDMB Preemptive
IML Gulf Preemptive

Grand Banks Preemptive
Subjective Currents Preemptive OR Additive (set by user)

Wind Driven Currents Additive
Tidal Currents Additive (but preempts Sea)
Sea Currents Additive (but preempted by Tidal)

Table 9.1: The priority and rules for combination of current data types.

If a preemptive data type has priority in a drift calculation, it is used to the exclusion of all other 
types.  If an additive data type has priority, it is used in combination with all other additive types. 
The one exception is tidal and sea currents: as indicated in Table 9.1, tidal currents preempt sea 
currents in regions where the two types of data overlap.

Only current forces that are turned on in the Current Forces sidebar are considered when 
determining which forces to use in calculations.  If a data type is not enabled in the sidebar, it will 
not be used in drift calculations nor will it preempt data types of lower priority.  Similarly, 
deactivated data is not used in calculations and does not preempt data of lower priority.

The sections in this chapter related to each data type go into further detail about that type's 
priority and ability to preempt or combine with other types.  For more details about how current 
forces are used in drift calculations, refer to Chapter 11.. 

9.1.2 Time Series Terminology
This chapter makes frequent use of terms defined in the Before You Begin... section of Chapter 8: 
Environmental Time Series Data And  The Time Series Editor, specifically time series and vector, 
and persistence, radius and range of influence.  You should be familiar with these terms before 
reading the rest of this chapter.

Although the term range of influence is defined in the context of the time series data format, the 
same concept applies to all types of current data.  The range of influence of other data types 
cannot be modified by the user, however.
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9.1.3 Entering and Modifying Time Series Data
Measured currents, subjective currents, SLDMB data and the data produced by the Grand Banks 
model all share the standard time series format discussed in Chapter 8: Environmental Time Series
Data And  The Time Series Editor.  Although this chapter discusses when to use measured and 
subjective currents, it does not go into detail about how to add them to a scenario, nor does it give 
details on using the Time Series Editor to edit any of these data types.  For detailed instructions 
related to working with data in the time series format, refer to Chapter 8.  Specifically, you may 
wish to review the sections on adding, modifying and deleting time series before reading the rest 
of this chapter and the sections on measured currents and subjective currents in particular.

9.1.4 CANSARP 5.0 Technical Manual
This user manual introduces each data model used by CANSARP only briefly.  Further 
information, including technical details relating to the coverage and theoretical basis of these 
models may be found in the separate CANSARP V5.0 Technical Manual.

9.2 Types of Current Data

9.2.1 Modeled Current Data
Most of the current data used by CANSARP is the product of complex mathematical models that 
attempt to describe the currents and/or tides in various geographic regions.  Some of these are 
static, meaning that the systems of equations that make up the models do not change, while 
others are dynamic, meaning that the systems evolve over time based on actual observations and 
near real time inputs.

The two categories of current models are described briefly in this section; each individual model 
is described in more detail later in this chapter.

9.2.1.1 Static Data Models  

CANSARP's tidal and sea current models are static.  They are based on historical data, seasonal 
averages and, in some cases, phases of the moon.  Because there are no near real time inputs 
driving these models, they may be less accurate than dynamic models.

Generally speaking, the tidal and sea current models used by CANSARP do not include the effect 
of wind on surface currents, so these must be used in conjunction with wind driven current to 
best represent total water current.  The International Ice Patrol (IIP) data model is the one 
exception to this rule: it does include the effect of wind on the water.

The mathematical systems that comprise these models as well as the databases they require to 
function are installed directly on the CANSARP workstation so they are always available to the 
program.

The tidal and sea current models in CANSARP V5.0 have not changed since CANSARP V3.3.
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9.2.1.2 Dynamic Data Models  

In contrast to the static tidal and sea models, the IML Gulf and Grand Banks models are dynamic. 
They are based on actual observations and dynamic wind models rather than historical averages, 
and they evolve over time to better represent changing environmental conditions.  Because they 
are driven by near-real time inputs, these models reflect environmental conditions more 
accurately than static models are able to.

Given the higher confidence in the output of the dynamic data models, CANSARP allows them 
to preempt the static models in regions where dynamic and static grids overlap.  As well, because 
the dynamic current models already include the effect of wind on surface currents, they also 
preempt wind driven current so as not to double count its effect.

These dynamic models are created and maintained by third parties and are not part of CANSARP 
or located on the workstation; instead, their output is downloaded onto the workstation each day 
as it becomes available.  See Section 9.3 later in this chapter for information about how IML and 
Grand Banks data is acquired.

The dynamic data models are new to CANSARP V5.0.  Although this version contains only two 
such models, it is hoped that future versions of the program will include more models of this sort 
so that all regions of the country have access to this type of high confidence data.

9.2.1.3 Modeled Current Data Grids  

All of CANSARP's current models, static and dynamic, produce data distributed over the regions 
they cover in a grid-like pattern.  Some of these grids are more dense than others geographically, 
and some contain data points with shorter intervals of time.  In the case of static models, most 
also have seasonal variations that reflect the changes in currents between the summer and winter 
months.  

9.2.2 Non-modeled Data – User Entered Currents and SLDMBs
CANSARP also makes use of current data which is not the product of any kind of model, such as 
actual on scene observations entered by the user, data loaded into the program from self locating 
datum marker buoys (SLDMBs), or data from other external sources such as pilot charts or tide 
tables (also entered by the user).  Subjective currents and SLDMB data are implemented in 
CANSARP V5 in much the same way as in V3.3.  One type of user entered data, measured 
currents, is new in V5.0.

9.2.3 Wind Driven Currents
Assuming it has wind data to work with, CANSARP is able to calculate the effects of wind on 
surface currents.  Wind driven currents are not technically a type of current data but rather the 
inclusion of an additional mathematical formula based on local winds into drift calculations.  See 
Chapter 10: Environmental Data: Wind Data And Models for more details on how this is 
accomplished.  The discussion of wind driven currents in this chapter is limited to whether it is 
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appropriate to combine this extra calculation with various current types.

Note that, in the case of additive data models, it is up to the user to decide whether or not wind 
driven currents are added to the calculation.  Preemptive models never use wind driven currents.

9.3 Acquisition of Dynamic Model Data
As mentioned previously, CANSARP's tidal and sea current models are static; they are part of the 
program and the databases on which they rely are installed directly on the CANSARP 
workstation.  This means tidal and sea model data is always available for use in any scenario 
regardless of the time period the scenario covers.

In contrast to the static models, the IML Gulf and Grand Banks dynamic models are completely 
external to CANSARP.  These models are developed and maintained by third parties; the output 
they produce is sent to the CANSARP servers at the Coast Guard College on a daily basis.  The 
time of this transmission varies so, to ensure that new data is acquired as quickly as possible, the 
CANSARP workstation in each RCC queries the Coast Guard College servers hourly for new 
data.  When new data becomes available, it is downloaded to the workstation.  If there is an 
interruption of service by the third parties that maintain these external models or a problem with 
the data acquisition system, new data may not be downloaded to the CANSARP workstation and 
therefore may not be available within CANSARP.

When new dynamic model data is downloaded to the workstation, it is not immediately available 
within the program.  In the case of the Grand Banks model, newly acquired data may be loaded 
into the scenario in the usual fashion (refer to Section 9.9.2.1).  In the case of IML Gulf data, you 
must close CANSARP and restart the program to begin using the newly downloaded data.

9.3.1.1 The Watchdog  

You may determine how recently new dynamic current data was acquired by checking the 
Watchdog.
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To open the watchdog, select Watchdog from the Managers Menu, or click the Watchdog button 
on the Managers toolbar.  The time at which data of each type was most recently acquired 
appears in the fields to the right of the corresponding labels.

Note that the Watchdog cannot tell you if historical IML Gulf or Grand Banks data is available. 
To determine whether dynamic current model data is available for a historical drift, you must turn 
on the display of the particular data model in the display options sidebar and then, in the case of 
the Grand Banks model, load the data for the given time period.  If no current vectors appear on 
the canvas, no data is available for that time period.

9.4 Displaying Currents on the Canvas
In order for a current of any kind to appear on the canvas, the appropriate display option must be 
turned on in the display options sidebar.  Tidal and sea current grids are only displayed on the 
canvas if a search object has been deployed within their boundaries.  All other current vectors 
appear on the canvas even if no search objects have been deployed.

When displayed on the canvas, current vectors of any kind appear as arrow icons that point in the 
direction of flow.  If the data is formatted as a time series (as are measured and subjective 
currents, SLDMB data and Grand Banks data), this arrow is superimposed upon an Х.  If an Х 
appears without an arrow, this indicates that the time currently displayed on the scenario clock 
falls outside the range of influence of the time series data at that location.  See Chapter 8: 
Environmental Time Series Data And  The Time Series Editor for further information about time 
series and their ranges of influence.

The colour of the arrow and the Х correspond to the type of current data, as indicated in Table
9.2: 
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Type of Data Colour
Measured Current Sea green

Modeled Current and SLDMBs Medium blue
Subjective Current Orange red

Table 9.2: Default colour of current data icons

The relative size of the arrows indicates the force of the current: the larger the arrow, the stronger 
the current.  The arrows are scaled according to the current zoom factor and appear larger the 
further you zoom in.  If Scales is turned on in the display options sidebar, a scale bar at the top of 
the canvas indicates the speed in knots that corresponds to various sizes of arrows at the current 
zoom factor, as shown in Figure 9.2

9.4.1.1 Changing the Appearance of Current Icons  

It is possible to change the colour and size of current vectors in the Map Properties dialog box. 
To open this dialog box, select Map Properties from the View Menu, or click on the Map 
Properties button on the managers tool bar.
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To change the colour of a particular type of current data, click the Color button to the left of the 
corresponding label and then select a new colour from the dialog box that appears.

To change the size of current vectors, left click the blue slider labeled Current Vectors Scale (%) 
at the bottom of the dialog box and, while holding down the mouse button, drag it to the left or 
right.  Dragging it left will reduce the scale percentage; dragging it to the right will increase it. 
The larger the scale percentage, the larger the arrow icons will appear.  

You must click Apply to see the effect of either change on the canvas.

9.5 The Current Manager
Most operations relating to current data are carried out via the Current Manager.  To open the 
manager, select Current Manager from the Managers menu, click on the Current Manager button 
on the managers toolbar, or press the F10 key while holding down the Ctrl key.

The first time the Current Manager is opened, its first tab is displayed:

The Current Models tab lists the various current models as well as the other types of current data 
and allows you to select which will be used in drift calculations.  The table displayed on this tab 
is equivalent to the Current Forces sidebar and changes made in either place are immediately 
reflected in the other.  Both list the various types of current data in order of priority.

In addition to the Current Models tab, the Current Manager contains a tab for each type of current 
data apart from sea currents.  The operations specific to each type of data are carried out on the 
corresponding tab, as described in the following sections of this chapter.

88

Figure 9.4: The Current  
Models tab of the Current 
Manager.



Chapter 9: Environmental Data: Current Data and Models

9.6 Measured Currents
Measured currents are new in CANSARP V5.0 but are closely related to the subjective currents 
familiar to users of CANSARP V3.  They are used to represent on scene, real time observations 
in which the user has high degree of confidence, such as readings from instruments on board 
vessels or other weather sensing platforms in the area.  Because of this high degree of 
confidence, measured currents preempt all other types of current data, including SLDMB data. 
This is different from the behaviour of subjective currents in both V3 and V5.

Note: The methods for adding measured currents to a scenario are covered in Chapter 8: 
Environmental Time Series Data And  The Time Series Editor.

9.6.1 The Measured Currents tab of the Current Manager
Once measured currents time series have been added to the scenario, they appear in the table on 
the Measured Currents tab of the Current Manager.

The table that comprises the bulk of this tab displays all of the measured currents that have been 
added to the scenario.  As indicated by the column headings, the table displays each time series' 
ID, its position, and its activation status (see Chapter 8).  

If the Current Manager is open when a new measured current is added to the scenario, the new 
current will not immediately appear in the table; likewise, if the manager open when a measured 
current is deactivated or deleted, this change is not immediately reflected in the table.  If the table 
appears incomplete or out of date, click the Update List button at the bottom right to update it.

89

Figure 9.5: The Current  
Manager's Measured 
Currents tab



Chapter 9: Environmental Data: Current Data and Models

9.6.2 Editing a Measured Current
To edit a particular measured current time series in the Time Series Editor, select it in the table 
and then click the Edit Time-series button.  Alternately, you may left click on the current's icon 
on the canvas.

See Chapter 8 for further information on editing currents in the Time Series Editor.

9.6.3 Deleting Measured Currents
To delete a particular measured current entirely, select it in the table and then click the Delete 
button.

To discard all measured currents from the active scenario, select Discard from the File Menu and 
then select Measured Currents from the submenu that appears.

9.7 SLDMBs
Dropped near the scene of an incident and allowed to drift with the current, self locating datum 
marker buoys (SLDMBs) are a source of highly reliable, real time data in which there is usually a 
high degree of confidence.

Once dropped, an SLDMB uses the GPS satellite network to record its position on an hourly 
basis; it transmits this GPS position history as well as various types of sensor data constantly so 
that, when a NOAA polar-orbiting satellite that is part of the ARGOS network passes overhead, it 
receives this information and passes it on to Service Argos to be processed.  The processed data is 
downloaded by the CANSARP workstation every 15 minutes.

Note: Although SLDMBs transmit their data constantly, it cannot be processed by Service 
Argos until a polar-orbiting satellite passes overhead and is able to receive the data.  For 
this reason, it can sometimes be several hours after a buoy is dropped before its data is  
available in CANSARP.  This is especially true of buoys dropped in locations such as 
narrow fjords where transmitter visibility to overhead satellites is restricted.

SLDMB data loaded into CANSARP is preempted by measured currents entered by the user but 
preempts all other current data.  

9.7.1 PIW Mode vs. Life Raft Mode
SLDMBs may be deployed in either PIW mode or life raft mode.  

Note: For the purposes of CANSARP, only data from SLDMBs deployed in PIW mode is  
useful.  Data from SLDMBs deployed in life raft mode should not be used.
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This is because an SLDMB deployed in PIW mode has a drogue attached that is calibrated to 
neutralize the effect of leeway on the inflated part of the buoy.  Without this drogue, an SLDMB 
is affected by leeway and so any data collected from that buoy is compromised.  In effect, if such 
a buoy is used within CANSARP, the leeway effects of a life raft are added to the leeway 
calculations for any search object type and cannot be removed.  For instance, life rafts will be 
subject to double the expected amount of leeway and PIWs, which shouldn't be subject to leeway 
at all, will affected by leeway as a life raft would.

If it is desirable to load the data from an SLDMB deployed in life raft mode into CANSARP for 
some reason, care should be taken to ensure this data is not used in drift calculations.  If no 
SLDMBs deployed in PIW mode are loaded, simply turning off SLDMB data in the Current 
Forces sidebar will suffice.  If SLDMBs deployed in PIW mode are also loaded into the scenario 
and should be used in drift calculations, every vector from any SLDMBs deployed in life raft 
mode should be deactivated so that they are not used in drift calculations.

9.7.2 GPS vs. Argos 0-3
Although SLDMBs are equipped with GPS receivers and transmit their GPS position history 
along with their sensor data, Service Argos also uses a Doppler shift algorithm to calculate the 
buoy's position at the moment each transmission is received.  This can be useful if the GPS 
receiver on the buoy fails or the GPS position data is unavailable for some reason.  Calculating 
the buoy's position using this method introduces a certain amount of error, so these calculated 
positions are categorized as 0, 1, 2, or 3 according to how accurate they are guaranteed to be (the 
higher the number, the more accurate the calculated position):

Argos Category Position accurate to
Argos 3 within 150 m
Argos 2 Between 150 m and 350 m
Argos 1 Between 350 m and 1000 m
Argos 0 Greater than 1000 m

Table 9.3: Accuracy of calculated position in Argos data

There are usually two sets of position data associated with each SLDMB, GPS position data and 
Argos 0-3 data, but occasionally only one of these is available.  When the GPS position data is 
available, it should be used.  If it is not available, Argos position data may be used instead.  Argos 
3 position data is fairly accurate and Argos 2 position data is acceptable, but Argos 1 or 0 data 
should be used with caution or not at all.

9.7.3 The SLDMB Tab of the Current Manager
SLDMB data is loaded into CANSARP via the SLDMB tab of the Current Manager.
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9.7.4 Displaying available SLDMBs
The table at the top of the tab lists SLDMBs that were active during the time period indicated by 
the Days Before and After fields near the bottom of the window.  When the tab is first opened, 
this table will be blank; it is updated whenever the Update List button in the lower left corner of 
the window is clicked.

To generate a list of active SLDMBs, you must first indicate the time period of interest.  By 
default, CANSARP looks for SLDMBs active during the 30 days prior to the scenario date and 
10 days after, as indicated in Figure 9.24, but this period can be extended to as much as a year 
before or after the scenario date.

Note: Only the date of the final transmission from the buoy is considered when 
determining which buoys to include in this list, so buoys that continued to transmit after  
the specified time frame will not appear.  SLDMBs are set to sink after five days, so any 
buoy actually transmitting on the scenario clock date should appear in the list as long as 
days after is at least 6.

Once the days before and after are set, click the Update List button to generate a new list.  Once 
generated, a list will not change until updated another time, even if the date on the scenario clock 
changes.

The table displays five columns of information for each SLDMB.  From left to right, these are 
ID, deployment mode, time stamp (including date), latitude, longitude, and sea surface 
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temperature.  SLDMBs in the list are sorted by ID.  Deployment mode is P for SLDMBs 
deployed in PIW mode, R for those deployed in life raft mode, or N when this data is not 
available.  The time stamp, lat/lon and sea surface temperature listed all correspond to the most 
recent reading from the given SLDMB.

9.7.4.1 Loading an SLDMB into the Active Scenario  

To load an SLDMB into the scenario, select it in the list of active SLDMBs, then select the type 
of position data you wish to load for that SLDMB – either GPS or Argos.  To do this, click either 
the GPS button or the Argos button.  The button will stay depressed to indicate the set of data to 
be loaded.  For example, in Figure 9.24, Argos position data has been selected.  

When loading Argos data, you must also specify which categories of Argos data you want to load 
(refer to Section.9.7.2).  To do so, click the check boxes to the left of each category of data to be 
loaded (note that these boxes are only enabled once Argos position data is selected).  For 
example, in Figure 9.24, Argos 3 and Argos 2 data have been selected.  You may select more than 
one type but the data associated with all of the selected types will only be as accurate as the least  
accurate category selected.  See Section 9.7.5.1 for further information.

If you know in advance that the default range of influence is inappropriate for the selected 
SLDMB, you may change it before loading the SLDMB.  Otherwise, use the default range of 
influence but refer to Section 9.7.8 for further information.

Once the buoy is selected, the type and categories of position data are chosen and the default 
range of influence is determined, click the Load button to load the SLDMB's data into the 
scenario.  Only data transmitted by the buoy during the date range specified by the Days Before 
and After fields will be loaded, even if it began transmitting before or continued to transmit after 
this period of time.

After loading the SLDMB, you should review its details to ensure that the type of data (GPS or 
Argos) requested was actually available.  In some cases, only GPS or Argos data is available; if a 
type is requested but unavailable, the details for the SLDMB will be empty.

9.7.5 SLDMB Details
Once loaded, you may view the details of the particular buoy by selecting it in the list of active 
SLDMBs and clicking the Details button to open the SLDMB Details window.
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The table in this window displays each current vector associated with the selected SLDMB. 
These vectors all appear on the canvas as described in Section 3.4.

The first column in the table indicates whether each vector is active (A, as above) or has been 
deactivated (D).  Deactivated vectors are not used in drift calculations.  The second column 
displays its ID, preceded by two characters that indicate the type of position data: GP for GPS 
position data, and 0A, 1A, 2A or 3A for Argos position data (the numeral indicates the least 
accurate category of Argos position data included in the list – refer to Section 9.7.5.1).  For 
example, in Figure 9.23 the buoy ID begins with 2A, indicating that the vectors were categorized 
as Argos 2 or above.  The third column displays the time at which the buoy's position was 
determined and the next two columns display its latitude and longitude at that time.  The sixth 
column indicates the direction in which it was traveling and the seventh its speed.  The last 
column displays the sea surface temperature at each time and indicates whether this value is an 
actual reading from the buoy's sensors (R, as above) or has been extrapolated from other values 
(E) (see Section 9.7.5.2).

9.7.5.1 Calculation of Direction and Speed  

An SLDMB's direction and rate of travel are calculated values rather than sensor readings. 
CANSARP compares the position and time stamp of each vector with the position and time 
stamp of the preceding vector and determines how fast the buoy must have traveled and in which 
direction to reach the new location at the given time.

This is of particular importance when Argos position data is being used for two reasons.  Firstly, 
the list of current vectors associated with an SLDMB depends on which categories of data are 
loaded, so if a different combination of categories is selected and the SLDMB is reloaded, a 
vector's direction and speed will change if a different vector precedes it in the revised list. 
Secondly, because a vector's direction and speed depend on and influence that of other vectors, 
this information is only as accurate as the least accurate vector in the entire list.  Therefore, all 
the vectors in the list are considered to have this same least degree of accuracy.  For example, in 
Figure 9.23.4 Argos 3 vectors may appear in the list, but these vectors are considered to be 
accurate only to within 350 m rather than 150 m because their direction and speed may be based 
on Argos 2 vectors.

9.7.5.2 Extrapolation of Deployment Mode and Temperature Readings  

Deployment mode and actual sea surface temperatures are only included with Argos position 
data.  For GPS position data, CANSARP extrapolates these values based on those in the given 
SLDMB's Argos data.  If no Argos data is available for an SLDMB, deployment mode and 
temperature data will not be either.

9.7.5.3 Deleting an Individual SLDMB Vector  

You should always skim an SLDMB's details for inconsistencies and determine whether the data 
looks reasonable.  Occasionally something may happen that calls the validity of an SLDMB's 
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data into question – it might transmit data more frequently than expected, or fail to work properly 
in some way.  Buoys may also wash ashore or become trapped in ice; on occasion they have even 
been picked up by vessels and taken away from the scene of an incident.  

If none of an SLDMB's data looks reasonable, you should discard the SLDMB entirely (see 
Section 9.7.6).  If most of the SLDMB's data does look reasonable but some of it does not, you 
can keep the general body of data and remove only those vectors that appear suspect.  You have 
two options in this case: deleting the suspect vectors or deactivating them.  

To delete an individual vector, select it in the SLDMB Details table and click the Delete button. 
This may only be done when the SLDMB Details window is open; the change is reflected in the 
table immediately. 

Alternately, you may right click on the vector's icon on the canvas and select Delete 
Wind/Current from the canvas menu when it appears.  The SLDMB Details window need not be 
open when this is done; if it is, the change is not reflected in the table until the window is 
refreshed.  To refresh the window, click the Details button on the Current Manager's SLDMB tab, 
or close the window and reopen it.

Hint: It may be preferable to deactivate a vector rather than deleting it so that you have 
the option of reactivating it later should you decide to include it in drift calculations 
again, or as a reminder of why the vector isn't being used in calculations.  When a vector 
is deactivated, it has no impact on calculations so the effect is the same as deleting it.

9.7.5.4 Deactivating an Individual SLDMB Vector  

To deactivate an individual vector, select it in the SLDMB Details table and click the Deactivate 
button.  To reactivate it later, select it in the list and click the Activate button.  The A or D in the 
first column indicates whether a vector is activated or deactivated.  This may only be done when 
the SLDMB Details window is open; the change is reflected in the table immediately.

Alternately, you may left click on the vector's icon on the canvas at any time and then check or 
uncheck the checkbox labeled Deactivated in the Time Series Editor when it appears.  The 
SLDMB Details window need not be open when this is done; if it is, the change is not reflected 
in the table until the window is refreshed.  To refresh the window, click the Details button on the 
Current Manager's SLDMB tab, or close the window and reopen it.

9.7.5.5 Printing SLDMB Details  

To print the details of a given SLDMB, open it in the SLDMB Details window and select any one 
of its vectors, then click the Print button.

The printed version of an SLDMB's details includes its ID and its range of influence as well as 
the lat/lon of its most recent vector and the temperature at that time, if available.  The time stamp, 
direction and speed are printed for each individual vector in the list.
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Caution: An individual vector's range of influence may differ from the norm for a given 
SLDMB if it has been modified in the Time Series Editor.  There is no way to tell from the 
printed details if this is the case.

In future versions of CANSARP, the position of each individual vector will be included in 
the printed details.

9.7.6 Discarding SLDMB Data
If you decide not to use a particular SLDMB's data for some reason (see Section 9.7.5.3), you 
may discard it completely.  This unloads all of its data from the active scenario but has no effect 
on the SLDMB data downloaded onto the CANSARP workstation.

To discard an SLDMB from the active scenario, select it in the table on the SLDMB tab of the 
Current Manager and click the Discard button.  The icons marking the SLDMB's vectors will 
disappear from the canvas.

To discard all the SLDMB data currently loaded into the scenario, select Discard from the File 
Menu and then select SLDMB from the submenu that appears.

9.7.7 Reloading SLDMB Data
You may reload an SLDMB after it has already been loaded.  This is useful if you wish to switch 
from GPS position data to Argos position data or vice versa, to include a different combination of 
Argos position data categories in the vector list, to reset the SLDMB's default range of influence, 
or if you have changed or deleted some of the SLDMB's vectors and wish to reset them all to 
their original values.

Before reloading an SLDMB, you should discard it to ensure that the previous information is 
completely cleared.  The method for reloading an SLDMB is exactly the same as loading it the 
first time – refer to Section 9.7.4.1.

Note: When you reload an SLDMB, any vectors previously deleted are recovered, any 
vectors previously deactivated are reactivated, and all vectors are reset to the SLDMB's 
default range of influence.

9.7.8 Range of Influence
SLDMB data has the same time series format as many other types of current data and therefore 
has a range of influence (refer to the Before You Begin... section of Chapter 8).  Because the 
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buoys generally calculate their position once per hour, the default persistence for SLDMB data is 
30 minutes.  They have the same 10 NM radius of influence as other currents.

The time intervals between Argos position data are less consistent than GPS data.  It is a good 
idea to inspect the details of the downloaded data (see Section 9.7.5.3) and determine the median 
interval between points; if it is not one hour, the default range of influence for the buoy should be 
set to half of this median value and the buoy should be reloaded so that all its vectors have the 
new range of influence.

Note that this is the default persistence.  If some of the vectors have a significantly different time 
interval than the median, you can change the persistence for those particular vectors in the Time 
Series Editor.  See Chapter 8 for details.

Because any SLDMB whose data is used in CANSARP was deployed in PIW mode (refer  
to Section 9.7.1), search objects of other types may drift beyond the range of influence of  
the SLDMB's data.  An SLDMB deployment plan should be followed to ensure that  
SLDMB data is continuously available for the duration of the search.

9.7.9 Viewing SLDMB Data in the Time Series Editor
SLDMB data has the standard time series format but, because each reading from an SLDMB is 
potentially at a different latitude and longitude than every other, each time series contains only a 
single vector and each vector appears on the canvas as a separate time series.  Because it is in the 
time series format, SLDMB data may be opened in the Time Series Editor.  To do so, left click on 
an SLDMB vector icon on the canvas.  

Caution: Although SLDMB vectors can be modified in the Time Series Editor, doing so is  
not recommended as there is no indication afterwards that the data used in drift  
calculations is not the same as that transmitted from the SLDMB.  Modifications should 
be limited to activating or deactivating vectors.

As of CANSARP 5.0 version 4.9.5.28, modified SLDMB vectors do not turn into 
subjective currents.  This may change in future versions of the program.
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9.8 The IML Data Model (Dynamic)
The IML Gulf data model is produced and maintained by the Institute Maurice Lamontagne in 
Mont-Joli, Québec.  It provides current data in the region shown in Figure 9.8.

IML data is preempted by measured currents and SLDMB data.  It preempts subjective, wind 
driven, tidal and sea currents.  Technically, IML data also preempts Grand Banks data but since 
the two data grids do not overlap, this has no impact on drift calculations.

There is no need to load IML data into a scenario; although it is not saved, it is automatically 
loaded as required to perform drift calculations.  However, if new IML data is downloaded onto 
the CANSARP workstation while the program is running, it does not immediately become 
available.  You must quit CANSARP and restart the program to access the newly acquired data.

The IML grid is very dense.  Drifts in this area take longer to calculate than drifts  
elsewhere because of the density of the data.
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9.9 The Grand Banks Data Model (Dynamic)
The Grand Banks data model is produced and maintained by the Bedford Institute of 
Oceanography (BIO) in Dartmouth, Nova Scotia.  It provides current data in the region shown in 
Figure 9.22

Grand Banks data is preempted by both measured currents and SLDMB data.  Technically, IML 
data also preempts Grand Banks data but since the two data grids do not overlap, this has no 
impact on drift calculations.  Grand Banks data preempts Subjective, Wind Driven, Tidal and Sea 
currents.

9.9.1.1 Grand Banks Data Format  

In CANSARP V5.0, Grand Banks data is the only current data model that has the same time 
series format as user entered currents.  In contrast to the IML, tidal and sea current models, 
Grand Banks data have a persistence and radius of influence that can be modified, and the arrow 
icons that represent Grand Banks currents appear on the canvas superimposed on Хs that indicate 
these series may be opened and manipulated in the Time Series Editor.  However, see Section 
9.9.3.
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9.9.2 The Current Manager's Grand Banks Model tab
The data produced by the Grand Banks model is used in a fashion more similar to the CMC wind 
model than the IML current model.  Like the winds, Grand Banks data is in time series format 
and, like winds, it must be loaded into a scenario before it can be used in drift calculations.  

Caution: Unlike CMC winds, Grand Banks data is not saved with the scenario.  Each 
time a previously saved scenario is loaded into memory, Grand Banks data must be 
loaded again.

These operations are performed on the Grand Banks model tab of the Current Manager:

9.9.2.1 Loading Grand Banks current data  

To load Grand Banks Data, you must first open the Grand Banks tab of the Current Manager.  To 
do so, select Current Manager from the Managers Menu, press the Current Manager button the 
Managers button bar or press the F10 key while holding down the Ctrl key.  Once the manager is 
open, switch to its Grand Banks Model tab if it is not already visible.

As for other currents, the persistence of Grand Banks data defaults to +/- 3 hours and its radius of 
influence defaults to 10 NM.  You may change these values before loading the data.  Each time 
series will have the given range of influence when initially loaded but you may modify individual 
series afterwards, as described in Chapter 8.

To change the default range of influence, select the text in the Time and/or Radius fields and 

100

Figure 9.10: The Grand 
Banks Model tab of the 
Current Manager



Chapter 9: Environmental Data: Current Data and Models

change it to the new values.  There is no need to click Apply for the new values to be accepted.  

If Grand Banks data has already been loaded, changing the range of influence settings 
will not affect the data already in memory.  You must reload the data for the new range of  
influence settings to take effect.

Before loading the data, you must also specify which dates you wish to load data for.  By default, 
the time span is the same as for CMC winds: 10 days prior to the date which currently appears on 
the scenario clock and 2 days after.  The Days Before and After fields are always relative to the 
scenario clock, so verify that the scenario clock is set to the appropriate date before loading the 
data.

Once the default range of influence and the time span of data has been set, click the Load button 
to load the data into the active scenario.  

If there is data available for the given frame of time, the Grand Banks options will  
automatically turn on in both the display options sidebar and the Current Forces sidebar.  
If these changes do not occur automatically, it indicates that no Grand Banks data is  
available for the time frame used.

9.9.2.2 Reloading Grand Banks Data  

If new Grand Banks Data is acquired while CANSARP is running, you may begin using the 
newly acquired data by reloading the data.  As well, reloading the data is necessary if you change 
the default range of influence and wish the new defaults to apply to vectors already in memory.

To reload Grand Banks data, follow the same procedure as for loading it initially as described in 
Section 9.9.2.1.

Note: If you reload the data, any deleted vectors are restored, any deactivated vectors are 
reactivated, and any modified vectors are reset to their original values.

9.9.3 Modifying Grand Banks data
Because Grand Banks data is in the standard time series format, it can be opened and edited in 
the Time Series Editor as described in Chapter 8.
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Caution: Although Grand Banks data can be modified in the Time Series Editor, doing so 
is not recommended as there is no indication afterwards that the data used in drift  
calculations is not the same as that downloaded from BIO.  Modifications should be 
limited to activating or deactivating individual vectors.

9.9.3.1 Deactivating and Deleting Grand Banks data  

Like other time series data, you may deactivate or delete individual Grand Banks time series after 
the data has been loaded.  If you suspect that a time series contains incorrect data, consider 
deactivating or deleting the time series rather than modifying it.  The methods for deactivating 
and deleting time series are discussed in Chapter 8.

9.10 Subjective Currents
Subjective currents are very similar to measured currents, with two major differences.  Firstly, 
they are preempted by SLDMBs and the dynamic current models.  Secondly, they may be set as 
either preemptive or additive with respect to wind driven, tidal and sea currents.  This is because 
subjective currents are used to represent two different types of current data: estimations of on 
scene conditions in which there is low confidence for some reason but which represents total 
water current (TWC), or data from other sources such as pilot charts or tide tables that do not 
include TWC.  Depending on how they are used in the simulation, the preemptive/additive mode 
of subjective currents may need to be changed.  Note that all subjective currents are treated in the 
same way: they are either all additive or all preemptive.

Caution: If you make subjective currents additive in one scenario and then create a new 
scenario without closing CANSARP first, the new scenario will also use subjective 
currents in additive mode.  When you add a subjective current to a scenario, you should 
always check to see how it is being used.

The methods for adding subjective currents to a scenario and for working with them once they've 
been added are covered in Chapter 8: Environmental Time Series Data And  The Time Series Editor.

9.10.1 Subjective Currents Used as Low Confidence Real Time Data
If on scene conditions have been estimated in some way or prior knowledge of the area suggests 
what they may be, this information can be added to the simulation as subjective currents.  This 
allows such estimates to be preempted by actual observations from the scene when and where 
they are available but to still affect drift in those regions and during those times when there is no 
higher confidence data available.

If such estimates or prior knowledge represent total water current, subjective currents should be 
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left as preemptive so that the effect of wind is not added twice.  If they do not, the currents should 
be made additive so that the effects of wind may be included.

9.10.2 Subjective Currents Used to Represent Charts or Tables
Subjective currents may also be used to represent data from other external sources, such as sea 
currents or tidal currents in regions for which CANSARP has no data, or information taken from 
pilot charts.  Data from these and other similar sources do not include the effect of wind on the 
water and so do not reflect total water current.  When used in this way, subjective currents should 
be used additively with wind driven currents.

9.10.3 The Subjective Currents Tab of the Current Manager
Once subjective currents time series have been added to the scenario, they will appear in the table 
on the Subjective Currents tab of the Current Manager:

The table that comprises the bulk of this tab displays all of the subjective currents that have been 
added to the scenario.  As indicated by the column headings, the table displays each time series' 
ID, its position, and its activation status (see Chapter 8).  

Note that, if this window is already open when a new subjective current is added to the scenario, 
the new current will not immediately appear in the table; likewise, if the window is already open 
when a subjective current is deactivated or deleted, this change is not immediately reflected in the 
table.  If the table appears incomplete or out of date, click the Update List button at the bottom 
right to update it.
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9.10.4 Making Subjective Currents Preemptive or Additive
Subjective currents are preemptive by default.  To switch them from preemptive to additive or 
vice versa, locate the two buttons labeled Preemptive and Additive at the bottom left of the tab. 
One of these buttons is always depressed, indicating how subjective currents are currently being 
used.  For example, in Figure 9.11 subjective currents have been made additive as indicated by 
the depressed Additive button.  To change between modes, simply click the other button.

9.10.5 Editing a Subjective Current
To edit a particular time series, select it in the table by left clicking on it and then click the Edit 
Time-series button.  This will open the Time Series Editor with the selected time series 
displayed.  Alternately, you may left click on the current's icon on the canvas.

See Chapter 8 for further information on editing currents in the Time Series Editor.

9.10.6 Deleting Subjective Currents
To delete a particular subjective current entirely, select it in the table and then click the Delete 
button.

To discard all subjective currents from the active scenario, select Discard from the File Menu and 
then select Subj. Current Data from the submenu that appears.

9.11 Tidal Current Data Models (Static)
CANSARP contains static models that produce grids of tidal data for certain geographic areas. 
Because these models are part of the program itself and the databases they rely on are installed 
directly on the CANSARP workstation, tidal data is always available within CANSARP.

The grids that the tidal data models produce are more dense than most other current models, both 
in terms of geographic distribution and in terms of the time interval between data points.  Unlike 
the other data models, tidal data is available in 15 minute increments; for this reason, the 
positions of search objects drifting through tidal regions are calculated in 15-minute time steps 
rather than the one hour time steps used elsewhere.

Tidal data is additive with wind driven currents and subjective currents if they are set to additive 
mode.  It is preempted by all other data types except sea currents.

Note: Although each is an additive data type, tidal current data preempts sea current  
data in regions where tidal and sea grids overlap because the data is more dense and 
tidal effects are typically much stronger.
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9.11.1 Tidal Grid Boundaries and Seasons
CANSARP includes tidal models for four geographic regions: the west coast of British 
Columbia, the Bay of Fundy and Gulf of Maine, the Gulf of St. Lawrence, and the Straits of 
Georgia and Juan de Fuca.  There are multiple grids for each region, as described in the following 
sections.

9.11.1.1 Tidal Grids for the west coast of British Columbia  

Figure 9.12 shows the BC_Coast.win tidal grid, which is used in the region during the winter 
months.  The BC_Coast.sum grid covers the same geographic region but the data changes to 
reflect seasonal differences in currents.

9.11.1.2 Tidal Grids for the Straits of Georgia and Juan de Fuca (GF7)  

There are three tidal grids available in CANSARP for use in the Strait of Georgia and Juan de 
Fuca Strait, all of which cover the same geographic region as the GF7_medium grid shown in 
Figure 9.13.  The differences between the three grids depend on the activity of the Fraser River at 
different times of the year.

The choice between Low, Medium and High is determined by obtaining the daily flow rate for 
the Fraser River at Hope, from the Water Survey of Canada.  The methods to determine the 
velocity data in these three grids for Strait of Georgia is different than Juan de Fuca Strait. You 
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may refer to CANSARP V5.0 Technical Manual for more details on the three different sets of 
tidal harmonic constants used to obtain velocities.

9.11.1.3 Tidal Grids for the Bay of Fundy/Gulf of Maine  

Tidal data for the Bay of Fundy and Gulf of Maine are based on a numerical model – for further 
details, refer to the CANSARP V5.0 Technical Manual. 

The model domain covers the entire Bay of Fundy and Gulf of Maine out to the continental shelf, 
as well as a portion of the Scotian Shelf and the area south of Cape Cod.  This area is subdivided 
into five smaller grids, as shown in Figures 9.14 through 9.18.

There are no seasonal grids for the Bay of Fundy as currents in the region are not strongly 
dominated by seasonal change in coastal runoff.

Caution: The original numerical model included the effects of the drying bank region in 
the inner part of the Bay of Fundy. However, CANSARP considers these regions to be 
always covered by water and computes vectors for these areas. Controllers should 
exercise caution when assigning SRUs to these areas.
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Note: Because of strong tidal currents in the northern region of the Scotian shelf, there 
will be a significant change in the drift of a search object as it moves from the tidal grid 
region into the neighbouring sea current grid or vice versa.

Figure 9.14: The 
Fundy1 tidal grid 
region
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Figure 9.15: The 
Fundy2 tidal grid 
region

Figure 9.16: The 
Fundy3 tidal grid 
region
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Figure 9.17: The 
Fundy4 tidal grid 
region

Figure 9.18: The 
Fundy5 tidal grid 
region
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9.11.1.4 Tidal Grids for the Gulf of St. Lawrence  

Figure 9.19 shows the St_Lawrence.win tidal grid, which is used in the region during the winter 
months.  The St_Lawrence.sum grid covers the same geographic region but the data changes to 
reflect seasonal differences in currents.

9.11.1.5 Displaying Tidal Grids on the Canvas  

The tidal grids shown in Figures 9.15 through 9.19 are only displayed on the canvas if a search 
object is located within their geographic boundaries.  To view a particular tidal grid on the 
canvas, first turn on Tidal Currents in the display options sidebar and then add a search object in 
the geographic region covered by the grid.  To view more than one tidal grid at a time, add search 
objects in each region.  

When tidal grids are displayed on the canvas, you may see how the tidal data changes over short 
periods of time by advancing the scenario clock in 15 minute increments and then refreshing the 
screen.
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9.11.2 The Tidal Models tab of the Current Manager – Overriding the Default Grid
There is usually no need to specify which tidal grids to use in drift calculations; CANSARP 
automatically selects tidal grids depending on the location of search objects and the time period 
of the drift.  You may, however, override the default selection by choosing another on the Tidal 
Currents tab of the Current Manager:

To use an alternate tidal grid in place of the default, first select the Override Default Tidal Grid 
With: button to activate the drop down menu to its right.  When the menu becomes active , click 
on the down arrow to expand the drop down menu as shown in  and then select the grid you wish 
to use.  Only those grids with seasonal variations are listed; although there are multiple Bay of 
Fundy tidal grids, only one grid applies at any given longitude and latitude regardless of season.

If the selected grid covers the geographic region of the drift, it will be used instead of the default 
selection; otherwise the default will still be used.  For example, if the search objects are located 
off the east coast of Vancouver Island and a Bay of Fundy tidal grid is selected, CANSARP will 
continue to use the GF7 grid appropriate for the time of year.

To revert to using the internally selected grid, select the Use Defaults radio button.  This will grey 
out the Override Default Tidal Grid With: field, indicating that the tidal grid displayed in the field 
is no longer overriding the default selection.

9.11.2.1 Viewing Tidal Grids in the Current Manager  

You may view the tidal grid diagrams on the Tidal Currents tab of the Current Manager without 
placing search objects within the tidal regions.  To do so, simply select the grid you wish to 
display from the View Tide Grids menu as shown in Figure 9.10.
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To clear the tidal grid diagram, select the blank line at the top of the drop down menu.

9.12 Sea Current Data Models (Static)
CANSARP's static sea current models produce current grids for portions of the east and west 
coast and for four of the Great Lakes.  CANSARP also includes the International Ice Patrol (IIP) 
model which covers the region dominated by the Labrador current.  As with tidal grids, some sea 
current grids have seasonal variations.

Because the sea current models are part of the program itself and the databases they rely on are 
installed directly on the CANSARP workstation, sea current data is always available within 
CANSARP.

Sea current data is additive with wind driven currents and subjective currents if they are set to 
additive mode.  It is preempted by all other data types including tidal currents.

Note: Although each is an additive data type, tidal current data preempts sea current  
data in regions where tidal and sea grids overlap because tidal data is more dense and 
tidal effects are typically much stronger.

9.12.1.1 The West Coast Sea Current Grid  

The region covered by the west coast sea current model is shown in Figure 9.5.  The grid shown 
is the winter grid, which is used from October to April; the summer grid is used from May to 
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September.  These time frames are somewhat arbitrary, but are related to the wind regime along 
the coast.

The summer grid is appropriate for use when the mean wind on the west coast assumes a 
behaviour characterized by a high pressure system in the Gulf of Alaska and northwesterly winds 
along the coast.  The winter grid should be used when the pressure system is characterized by a 
low pressure cell in the Gulf of Alaska and the typical wind along the coast has switched to a 
flow from the southeast.  However, see Section 9.12.2.

9.12.1.2 The East Coast Sea Current Grid  

The region covered by the east coast sea current model is shown in Figure 9.28.  The grid shown 
is the winter grid, which is used from October to April; the summer grid is used from May to 
September.

A number of different data sources were used to construct the east coast grid.  Refer to the 
CANSARP V5.0 Technical Manual for more details on the construction of seasonal velocity 
fields.
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9.12.1.3 The International Ice Patrol (IIP) Current Grid  

The International Ice Patrol (IIP) prepares sea current data based on an ongoing program of 
drifter tracking.  This data has been incorporated into CANSARP's east coast sea current model 
but is also available in a separate grid, shown in Figure 9.27.  

This model is valid at any time of the year as there is little seasonal variability reported for the 
Labrador Current which dominates the IIP database.  Refer to CANSARP V5.0 Technical Manual 
for more details on this subject.

Caution: When the IIP grid is used, surface wind driven currents should not be used, as  
their effect is already incorporated into the grid.
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9.12.1.4 The Great Lakes Sea Grids  

The grids for Lakes Erie, Huron, Ontario and Superior are shown in Figures 9.25 through 9.26. 
There are no seasonal variants for these regions.

Caution: The Great Lakes sea grids are included in CANSARP for completeness, but 
their origin and quality have not been verified.
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Figure 9.25: The 
Lake Erie sea 
current grid

Figure 9.26: The 
Lake Huron sea 
current grid
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Figure 9.27: The 
Lake Ontario  sea 
current grid

Figure 9.28: The 
Lake Superior sea 
current grid
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9.12.2 Overriding Default Sea Currents
CANSARP automatically selects the appropriate sea grid to use in calculations depending on the 
location of search objects and the date of the drift.  As of CANSARP 5.0 version 4.9.5.28, there is 
no way to override the internal selection of sea current grids.

In future versions of CANSARP, the Current Manager will include a Sea Currents tab 
that will function very much like its Tidal Currents tab.  When this is added, it will be 
possible to override the internal selection of sea current grids.

9.12.2.1 Displaying Sea Grids on the Canvas  

The sea grids shown in Figures 9.16 through 9.17 are only displayed on the canvas if a search 
object is located within their geographic boundaries.  To view a particular sea grid on the canvas, 
first turn on Sea Currents in the display options sidebar and then add a search object in the 
geographic region covered by the grid.  To view more than one sea grid at a time, add search 
objects in each region.

Chapter 10
Environmental Data: Wind Data and Models

In contrast to the many sources of current data, CANSARP uses wind data from only two sources 
in its drift calculations: data from the Canadian Meteorological Centre (CMC) and data entered 
directly by the user in the form of subjective winds.  The CMC wind data, however, includes 
modeled historical data, modeled forecast data and also actual observations.

This chapter introduces these types of wind data and explains how they interact and influence 
drift.  It also introduces the Wind Manager and how it is used to manipulate wind data and drift 
calculations.

In this chapter, you will learn
• What types of wind data are used by CANSARP

• How CMC wind data is acquired by the CANSARP workstation

• How to load and use CMC wind data

• What geographic regions are covered by each the CMC wind data model

• How to change the appearance of wind vectors on the canvas
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• How to disable the use of CMC and subjective wind data in leeway and wind driven current 
calculations

• How to toggle the use of Ekman drift in calculations of wind driven current

10.1 Before you begin...

10.1.1 Data Priority
Unlike current data, all wind data has the same priority and none of it is preemptive.  That is, 
CMC winds and subjective winds are combined when performing drift calculations, assuming 
neither one has been disabled.

10.1.2 Time Series Terminology
This chapter makes frequent use of terms defined in the Before You Begin... section of Chapter 8, 
specifically time series and vector, and persistence, radius and range of influence.  You should be 
familiar with these terms before reading the rest of this chapter.

10.1.3 Entering and Modifying Time Series Data
All wind data shares the standard time series format discussed in Chapter 8: Environmental Time
Series Data And  The Time Series Editor.  Although this chapter discusses when and how to use 
subjective winds, it does not go into detail about how to add them to a scenario, nor does it give 
details on using the Time Series Editor.

For detailed instructions related to working with data in the time series format, refer to Chapter 
8.  Specifically, you may wish to review the sections on adding, modifying and deleting time 
series before reading the rest of this chapter.

10.1.4 Leeway and Ekman drift
This chapter discusses how to turn leeway and Ekman drift on and off but does not go into detail 
about how they are used in drift calculations.  For further information on these topics, please 
refer to Chapter 11 : Drift And Search Area Determination.

10.1.5 CANSARP 5.0 Technical Manual
This user manual introduces the CMC dynamic wind model only briefly.  Further information, 
including technical details relating to its coverage and theoretical basis may be found in the 
separate CANSARP V5.0 Technical Manual.

10.2 Displaying Winds on the Canvas
In order for wind of any kind to appear on the canvas, the appropriate display option must be 
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turned on in the display options sidebar.

When displayed on the canvas, wind vectors appear as feather icons that point downwind (the 
feathered end of the icon is upwind) superimposed upon an Х.  If an Х appears without a feather, 
this indicates that the time currently displayed on the scenario clock falls outside the range of 
influence of the time series data at that location.  See 8: Environmental Time Series Data and  the
Time Series Editor for further information about time series and their ranges of influence.

The colour of the feather and the Х correspond to the type of wind data, as indicated in Table
10.1: 

Type of Data Colour
Subjective Winds Red

CMC Winds Cornflower Blue
Table 10.1: Default colour of wind data icons

The number of barbs on the feather indicates the speed of the wind: no barb appears until wind 
speed is at least 2.5 knots; beyond that, each 5 knots adds half a barb to the feather.  In this way, 
each feather indicates 10 knots on average and each half feather indicates 5 knots on average. 
For instance, a feather with two and a half barbs indicates that wind speed is at least 22.5 knots 
but no greater than 27.5, or 25 knots on average (the subjective wind in Figure 10.4, shown in 
red, is 25 kts).  At extremely high wind speeds, increments of 50 knots are indicated by triangular 
barbs.

As well, when the Wind Manager is open, each wind vector is labeled either On or Off to indicate 
whether the vector is active or has been deactivated or disabled.  In Figure 10.4, the three vectors 
on the right have been deactivated.

10.2.1.1 Changing the Appearance of Wind Icons  

It is possible to change the colour and size of wind vectors in the Map Properties dialog box.  To 
open this dialog box, select Map Properties from the View Menu, or click on the Map Properties 
button on the managers tool bar.
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the Wind Manager 
is open.
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To change the colour of a particular type of wind data, click the Color button to the left of the 
corresponding label and then select a new colour from the dialog box that appears.

To change the size of wind vectors, left click the blue slider labeled Wind Vectors Scale (%) at 
the bottom of the dialog box and, while holding down the mouse button, drag it to the left or 
right.  Dragging it left will reduce the scale percentage; dragging it to the right will increase it. 
The larger the scale percentage, the larger the feather icons will appear.  

You must click Apply to see the effect of either change on the canvas.

To reset the size and colour of all vectors, click the Reset button at the bottom of the window and 
then Apply.

10.3 The Wind Manager
Most operations relating to wind data are carried out via the Wind Manager.  To open the 
manager, select Wind Manager from the Managers menu, click on the Wind Manager button on 
the managers toolbar, or press the F10 key while holding down the Ctrl key.

The Wind Manager overrides the default behaviour of clicking with the left mouse button 
on the canvas regardless of which tab is open.  This is indicated in the status bar at the 
bottom left of the CANSARP window.  See Section 10.3.2.2 for more information.
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Map Properties  
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vectors are 
displayed at 40% 
by default but this  
may be adjusted.
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10.3.1 The Wind Models Tab
The first time the Wind Manager is opened, its first tab is displayed.

The Wind Models tab lets you set how wind data should be used in drift calculations.  The table 
displayed at the top of this tab is equivalent to the Wind Forces sidebar and changes made in 
either place are immediately reflected in the other.  

If Leeway is selected in the table, the effects of leeway will be applied to each search object that 
has not specifically deactivated it.  Refer to Chapter 6: Search Objects And The Search Object
Manager and Chapter 11: Drift And Search Area Determination for further information.  Leeway is 
turned on automatically whenever a subjective wind vector is added to the scenario or CMC 
winds are loaded.

The status of the check box labeled Use Ekman drift determines how Wind Driven Currents are 
calculated; by default, Ekman's method is not used.  Refer to Chapter 11 for further information.

Finally, the Wind Models tab allows you to deactivate all subjective winds and/or CMC winds as 
a group.  Wind data that is disabled is not used to calculate leeway or wind driven currents.  To 
disable a category of wind data, click the check box to the left of the appropriate label.  To re-
enable it, click the check box a second time.
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10.3.2 The Wind Options Tab
The Wind Options tab of the Wind Manager allows you to set various parameters related to all 
wind vectors, and to activate or deactivate multiple wind vectors at one time.  It is also used to 
load CMC wind data into the scenario.

The Wind Region field is not used in CANSARP V5.0.  Future versions of the program 
may use a high density wind field that could slow down calculations due to the density of  
the data.  In an effort to keep calculations as fast as possible, this field will be used to 
specify the geographic region for which CMC data should be loaded so that only data 
necessary for calculations is read into the program.
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10.3.2.1 Time Series Default Range of Influence  

This section of the Wind Options tab sets the default range of influence for all wind vectors that 
are added or loaded into the scenario: the Time Range field sets the persistence of the winds and 
the Wind Range field sets their radius of influence.  These values are used for CMC wind data 
loaded into the scenario and also to fill the corresponding fields of the Time Series Editor when a 
new subjective wind is added.  The range of influence of an individual vector may be changed in 
the Time Series Editor as usual (see 8).

The persistence of all wind vectors is initially set to +/- 3 hours because CMC Analyzed/Forecast 
data is updated every 6 hours.  The radius of influence is initially set to 100 NM because CMC 
Analyzed/Forecast winds are spaced approximately 120 NM apart: a radius of influence of 100 
NM ensures sufficient overlap between data points to prevent gaps in wind data without creating 
so much overlap that calculations are slowed unduly.  If the radius is reduced to the point that 
wind vectors do not overlap, a search object may drift into a region for which there is no wind 
available.  If this happens, leeway cannot act upon the object, nor can wind driven currents be 
calculated.

To change the default range of influence, select the text in the Time Range and/or Wind Range 
fields and change it to the desired value(s).  To apply this change only to winds added or loaded 
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after the change is made, select the New Winds radio button.  To apply it to all winds, including 
those previously added or loaded into the scenario, select the All Winds radio button.  In either 
case, you must click Apply at the bottom of the window before this change takes effect.

To reset the Time Range and Wind Range fields to the values last applied, click the Discard Edits 
button at the bottom of the window.  To reset them to their original default values, click the Use 
Defaults button.

10.3.2.2 Deactivating and Reactivating Groups of Wind Vectors  

The Options section of the Wind Options tab allows you to activate or deactivate groups of wind 
vectors selected by geographic proximity.  See Section 8.6 for an example of when and why this 
feature is important.

To select wind vectors, click the left button of the mouse on the canvas and, while holding the 
button down, drag the mouse to draw a bounding line around the vectors.  If the radio button 
labeled Rectangle is selected in the Wind Options tab, clicking and dragging in this manner 
draws a bounding box on the canvas.  If the Ellipse radio button is selected instead, clicking and 
dragging in this manner draws a bounding ellipse.  The boundary does not disappear when you 
release the mouse button so you may change the boundary from rectangle to ellipse or vice versa 
after it is drawn.

Once a boundary is drawn, you may manipulate the vectors inside it and/or the vectors outside of 
it.  For instance, to turn deactivate the vectors inside the boundary, click the Off button to the 
right of the Toggle Time Series Inside Box: label.  To activate the vectors outside the boundary, 
click the On button to the right of the Toggle Time Series Outside Box: label.

Once these adjustments are made, you must Apply your changes.

10.3.2.3 Loading CMC Winds  

The bottom portion of the Wind Options tab relates to loading CMC winds into the scenario.  See 
Section 10.4.3 for further information.

10.3.3 The Subjective Winds Tab
This tab functions exactly like the Measured Currents tab of the Current Manager.  For further 
information, refer to Section 10.6.

10.4 CMC Winds
The bulk of the wind data used by CANSARP comes from the Canadian Meteorological Centre 
(CMC) in Dorval, Québec.  It is downloaded onto the CANSARP workstation and can then be 
loaded into a scenario where it is used to calculate leeway and wind driven currents.
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10.4.1 Types of Data: Analyzed, Forecast and Observed
The CMC provides the Coast Guard with two kinds of modeled wind data for use in CANSARP: 
analyzed data and forecast data.  This is the same data used by the Institute Maurice Lamontagne 
and the Bedford Institute of Oceanography in their dynamic current models.  Like those models, 
the CMC's wind model is based on actual observations and the CMC makes these actual 
observations available to the Coast Guard as well.

10.4.1.1 Analyzed/Forecast Data  

Analyzed winds are the output of the Global Environmental Multiscale (GEM) model, the 
primary model used by the CMC for all its analysis and forecasting.  Based on actual 
observations from weather stations and other sources, this model is able to fill in data for points 
where no observations have been made.  This analyzed data is produced every six hours.

The GEM model uses the same actual to predict wind speed and direction up to 48 hours in 
advance.  This forecast data is produced every 12 hours.

Although they are slightly different, both types of wind data identified as ANAL/FCST when 
opened in the Time Series Editor.

10.4.1.2 Observed Data  

In addition to the analyzed and forecast output of the GEM model, the CMC makes the actual 
observations used as inputs into the model available to the Coast Guard.  These observations 
come from the CMC's own weather stations as well as vessels that transmit weather data to the 
CMC, and may be updated as often as once an hour.

Observed data is identified with the call sign or ID of the weather station or vessel that provided 
it when opened in the Time Series Editor. 

10.4.1.3 CMC Wind Data Grid  

Generally speaking, the CANSARP workstation downloads analyzed and forecast data from the 
CMC on a two degree grid.  Specifically, it downloads data at one point for every two degrees of 
longitude and latitude, assuming that these positions are not on land.  If a point of land interrupts 
this two degree grid in such a way that no data points are within one degree of coastal waters, an 
additional data point has been requested to fill in the gap.  This grid covers the Great Lakes and 
other locations specifically requested but does not generally cover rivers or smaller inland bodies 
of water.  

To request that additional analyzed/forecast data points be included in downloads from the CMC, 
contact the CANSARP Maintenance Officer at the Canadian Coast Guard College.

All observed data from the same regions are downloaded.  That is, observed data is not restricted 
to the two degree grid.  This results in a higher density of wind data in regions with high vessel 
traffic.
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10.4.2 Acquisition of CMC Data
As mentioned, new observed data is available from the CMC as often as hourly, whereas new 
analyzed data is produced every six hours and new forecast data is produced every 12 hours.

To ensure newly available data is acquired as quickly as possible, the CANSARP workstation in 
each RCC queries the CMC servers hourly.   When new data does become available, it is 
downloaded to the workstation.  If there is an interruption of service at the CMC or a problem 
with the data acquisition system, new data may not be downloaded to the CANSARP workstation 
and therefore may not be available within CANSARP.

Newly acquired wind data may be loaded into the scenario in the usual fashion as soon as it has 
been downloaded (refer to Section 10.4.3).

10.4.2.1 The Watchdog  

You may determine how recently new wind data was acquired by checking the Watchdog.

To open the watchdog, select Watchdog from the Managers Menu, or click the Watchdog button 
on the Managers toolbar.  The time at which data of each type was most recently acquired 
appears in the fields to the right of the corresponding labels.

10.4.2.2 Historical Wind Data  

Historical wind data, both observed and analyzed, is available going back as far as the fall of 
1993, though some RCCs keep less historical data on their local systems.  If necessary, historical 
data missing from a local system may be requested from the Coast Guard College.

Note that the Watchdog cannot tell you if historical wind data is available.  To determine whether 
data is available for a historical drift, you must turn on the display of CMC winds in the display 
options sidebar and then load the data for the given time period.  If no wind vectors appear on the 
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canvas, no data is available.

10.4.3 Loading CMC Wind Data into a Scenario
To load CMC Wind Data, open the Wind Options tab of the Wind Manager.  To do so, select 
Wind Manager from the Managers Menu, press the Wind Manager button the Managers button 
bar or press the F10 key while holding down the Ctrl key.  Once the manager is open, switch to 
its CMC Model tab if it is not already visible.

The persistence and radius of influence of CMC wind data is set by the time series default range 
of influence.  See Section 10.3.2.1 for more information.

Before loading the data, you must also specify which dates you wish to load data for.  By default, 
the time span is 10 days prior to the date which currently appears on the scenario clock and 2 
days after.  You may change these settings by selecting the value(s) in the Days Before and/or 
After fields and changing them as desired.  These fields are always relative to the scenario clock, 
so verify that the scenario clock is set to the appropriate date before loading the data.

Once the default range of influence and the date range have been set, click the Load button to 
load the data into the active scenario.  

Caution: If you change the default range of influence or the Days Before or After fields  
and then load CMC wind data before clicking Apply, the new settings are not used.

Once CMC wind data is downloaded, a field of wind vectors as described in Section 10.2 
will appear on the canvas if there is data available for the specified time period.

Note: CMC winds will not replace subjective winds already added to the scenario.  If a  
CMC wind time series has the same latitude and longitude as a subjective wind, it will  
not be loaded.

Downloading CMC winds automatically turns on Wind Driven Currents in the Current 
Forces sidebar and Leeway in the Wind Forces sidebar.  If there is data available for the 
given frame of time, CMC Winds will also automatically turn on in the Display Options 
sidebar.

10.4.3.1 Reloading CMC Wind Data  

If new CMC wind data is acquired while CANSARP is running, you may begin using the newly 
acquired data by reloading winds.  To reload CMC winds, follow the same procedure as for 
loading it initially as described in Section 10.4.3.
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Note: If you reload the data, any deleted vectors are restored if there is no subjective 
wind vector at the same position.  Any modified wind vectors that have become subjective 
winds are NOT replaced with the original CMC vector.  See Section 10.4.3.2 for more 
information.

10.4.3.2 Modifying CMC Wind Data  

Because CMC wind data is in the standard time series format, it can be opened and edited in the 
Time Series Editor as described in Chapter 8: Environmental Time Series Data And  The Time
Series Editor.  Specifically, you may deactivate or delete individual CMC time series after the 
data has been loaded.  If you suspect that a time series contains incorrect data, consider 
deactivating or deleting the time series rather than modifying it.

Although CMC wind data can be modified in the Time Series Editor, doing so is not  
recommended as there is no indication afterwards that the data used in drift calculations 
is not the same as that downloaded from BIO.  Modifications should be limited to 
activating or deactivating individual vectors.

Making any change to a CMC wind time series automatically converts the data into a 
subjective wind; the time series will behave in all ways as a subjective wind rather than 
a CMC wind thereafter.  This means it will only be displayed when the Subjective Winds 
display option is selected, it will be activated or deactivated according to the rules for 
Subjective Winds, and if CMC winds are reloaded, the time series will not be reset to its  
original values.

10.4.4 Disabling or Re-enabling CMC Wind Data
You may disable all CMC wind data by opening the Wind Models table of the Wind Manager and 
clicking the check box labeled Disable CMC Wind.  When CMC winds are disabled, no CMC 
wind data is used in the calculation of leeway or wind driven currents, regardless of the 
individual time series' activation status and all CMC wind vectors visible on the canvas are 
labeled Off.

To re-enable CMC winds, click the check box a second time so that the check mark disappears.

10.5 Subjective Winds
Because wind data has no priority and no type of wind data preempts another, subjective winds 
are analogous to both measured currents and subjective currents.  They are used to represent on 
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scene, real time observations in which the user has high degree of confidence, as well as for data 
from other sources, such as estimated conditions, information from charts, or prior knowledge of 
the search area.

Note: The methods for adding subjective winds to a scenario are covered in Chapter 8: 
Environmental Time Series Data And  The Time Series Editor.

Adding a subjective wind to the scenario automatically turns on Wind Driven Currents in 
the Current Forces sidebar, Leeway in the Wind Forces sidebar and Subjective Winds in 
the Display Options sidebar.

133



Chapter 10: Environmental Data: Wind Data and Models

10.6 The Subjective Winds tab of the Wind Manager
Once subjective winds time series have been added to the scenario, they appear in the table on the 
Subjective Winds tab of the Wind Manager.

The table that comprises the bulk of this tab displays all of the subjective winds that have been 
added to the scenario.  As indicated by the column headings, the table displays each time series' 
ID, its position, and its activation status (see Chapter 8).

If the Wind Manager is open when a new subjective wind is added to the scenario, the new wind 
will not immediately appear in the table; likewise, if the manager is open when a subjective wind 
is deactivated or deleted, this change is not immediately reflected in the table.  If the table 
appears incomplete or out of date, click the Update List button at the bottom right to update it.

10.6.1 Editing a Subjective Wind
To edit a particular subjective wind time series in the Time Series Editor, select it in the table and 
then click the Edit Time-series button.  Alternately, you may left click on the wind's icon on the 
canvas.

See Chapter 8 for further information on editing winds in the Time Series Editor.
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Figure 10.6: The 
Subjective Currents tab of  
the Wind Manager
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10.6.2 Deleting Subjective Winds
To delete a particular subjective wind entirely, select it in the table and then click the Delete 
button.

To discard all subjective winds from the active scenario, select Discard from the File Menu and 
then select Subjective Winds from the submenu that appears.

10.6.3 Disabling and Re-enabling Subjective Wind Data
You may disable all subjective wind data by opening the Wind Models table of the Wind 
Manager and clicking the check box labeled Disable Subjective Wind.  When subjective winds 
are disabled, no subjective wind data is used in the calculation of leeway or wind driven currents, 
regardless of the individual time series' activation status and all subjective wind vectors visible 
on the canvas are labeled Off.

To re-enable subjective winds, click the check box a second time so that the check mark 
disappears.

10.7 Case Study: Wind patterns on the west coast of British Columbia
The fjords on the west coast of British Columbia provide an example of when turning on or off 
regions of wind vectors is critical.  Consider an example of the CMC wind data for part of the 
area, shown in Figure 10.2.
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Figure 10.7: CMC 
wind data for a 
region on the west  
coast of British 
Columbia.  The 
shore colour has 
been turned off and 
the vectors are 
enlarged to show 
detail.  Compare the 
wind vectors in the 
fjords with those off  
the coast.
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The interpolated wind field (refer to 11) produced when all the CMC data shown in Figure 10.2 is 
active is shown in Figure 10.8.

Figure 10.8: The 
interpolated wind 
field produced when 
all CMC data is  
active.

Figure 10.9: A 
bounding box 
around the coastal  
wind vector and 
that in the fjord.  
Note that the Wind 
Manager must be 
open for the 
bounding box or the 
On/Off status of  
wind vectors to be 
displayed.
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However, given the topology of the region, the offshore winds clearly should not affect the blue 
search object.  In this case, it is appropriate to use only the onshore winds in drift calculations.  In 
Figure 10.9, a bounding box has been drawn around only those vectors and, using the buttons on 
the Wind Options tab of the Wind Manager, the vectors outside the box have been turned off.

Winds turned off in this way do not contribute to the interpolated wind field.  The interpolation 
field produced by the vectors turned on in Figure 10.9 is shown in Figure 10.10.  Notice how the 
vectors have changed direction since Figure 10.8.

Figure 10.10: The 
interpolated wind 
field based only on 
the winds active in  
Figure 10.2.

This 
wind field is appropriate for drift calculations pertaining to search objects located in the fjord, but 
obviously not for search objects offshore.  If it is determined that the onshore winds should not 
influence the red search object in Figure 10.2, a bounding box may be drawn as in Figure 10.9 
and those vectors inside the box turned off instead of those outside.  In this case, the interpolated 
wind field in Figure 10.11 is produced instead.

In this case, the situation is opposite that in Figure 10.9: the vectors inside the bounding box are 
off and those outside are on.  Compare the vectors in the vicinity of the red search object in 
particular.  This may be a more appropriate wind field to use for offshore search objects 
depending on their proximity to the outflow of the winds passing down the fjords.
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Figure 10.11: he 
interpolation field  
based on winds 
outside the 
boundary shown in 
Figure 10.2.  In this 
case, the vectors  
within the bounding 
line are off and 
those outside are 
on.  Compare the 
vectors near the red 
search object to  
those near the 
object in Figure
10.8.
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Drift and Search Area Determination

11.1 Selecting Drift Forces

11.1.1 Current Forces (preemptive vs. additive)

11.1.2 Leeway
In the context of CANSARP, leeway is the effect of wind on the exposed portion of a search 
object.  When leeway is used in drift calculations, this effect is applied to certain search objects  
in addition to the effects of currents.
All objects other than PIW have some degree of leeway; default parameters depend on type of 
object and are set automatically in SOM.
Individual objects may be set to ignore the effects of leeway (search object manager), or leeway 
may be turned off for all search objects (sidebar/wind manager).
Adding any wind data to the scenario turns leeway on in the sidebar.
Leeway calcs consider all winds added to a scenario that haven't been disabled or deactivated.  
Individual vectors may be deactivated or CMC and/or Subjective Winds may be disabled as a 
group.

11.1.3 Wind Driven Currents
Assuming it has wind data to work with, CANSARP is able to calculate the effects of wind on 
surface winds.  Wind driven currents are not technically a type of wind data but rather the 
inclusion of an additional mathematical formula based on local winds into drift calculations.  
See the next chapter, Environmental Data: Wind Data and Models, for more details on how this  
is accomplished.  The discussion of wind driven currents in this chapter is limited to whether it is  
appropriate to combine this extra calculation with various wind types.
Note that, in the case of additive currents, it is up to the user to decide whether or not wind 
driven currents are added to the calculation.  Preemptive models never use wind driven currents.

11.1.4 Ekman Method of WDC Calculation

11.1.5 Interpolation
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11.2 Performing a Drift

11.2.1 Datum Time

11.2.2 Project Forward

11.2.3 Reverse Drifts

11.2.4 Changing the Scenario Clock and Redrifting

11.2.5 Deactivated Search Objects Don't Drift

11.3 Displaying Drifts

11.3.1 Drift Tracks

11.3.2 Drift Errors (15 mins)

11.3.3 Don't Clear Drift Tracks

11.3.4 Drift Track Starting Times

11.4 The Search Area Polygon

11.4.1 The Polygon Manager

11.4.2 Probability of Detection
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Chapter 12
Effort Allocation: SRUs and the SRU Manager

After search objects have been drifted and the search area has been determined, resources may be 
allocated to conduct a search of that area.  CANSARP uses the SRU Manager to handle most 
operations related to Search and Rescue Units (SRUs).  

In this chapter, you will learn
• How to use the SRU Manager to add search and rescue units to a scenario

• How to add SRUs into a scenario from the SRU Database

• How to duplicate or delete SRUs from a scenario

• How the fields of the SRU Manager's Details tab describe an SRU and a particular search

• How the fields of the SRU Manager's Calculations tab affect an SRU's search pattern

• How to use the Transit Editor

12.1 Before you begin...
This chapter deals with adding SRUs to a scenario but not with manipulating search patterns.  For 
information on search patterns, see Chapter 13 – Effort Allocation: Search Patterns.

12.2 The SRU Manager
Most operations related to SRUs are carried out via the SRU Manager.  To open the manager, 
choose SRU Manager from the Managers menu, click on the SRU Manager button on the 
managers tool bar, or type F11 while holding down the Control key.  

The SRU list at the top of the manager window contains all the SRUs that have been added to the 
scenario.  This list displays each SRU's name and the time and position of its commence search 
point (CSP).  Immediately below the list are buttons that allow you to add new SRUs, or 
duplicate or delete an existing SRU.  

Below the SRU list and buttons are two tabs that contain the details related to each SRU and the 
various parameters used to calculate its initial search pattern.  The information displayed in the 
tabs' fields corresponds to the SRU that is currently selected in the SRU list.  Likewise, the 
Pattern Type field below these tabs displays the type of pattern the selected SRU will use and the 
Edit button to the right of the tab allows you to manipulate the SRU's search pattern directly.
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12.2.1 Details Tab
The Details tab (shown in Figure 12.1) displays the characteristics of the SRU currently selected 
in the SRU list and the type of search object it is looking for.  To select an SRU, left click on its 
line in the list.

12.2.1.1 SRU Name  

The SRU's name identifies which SRU is selected in the SRU list.  It also appears in reports and 
the SRU's tasking form, and in the SRU's icon when its search pattern is minimized (refer to 
Section 12.8).   The name may contain letters, numbers and other characters but spaces are 
replaced with the underscore character.  It cannot be more than 20 characters; names longer than 
this will be truncated when you click Apply.  More than one SRU can have the same name, 
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Figure 12.1: The SRU 
Manager window with 
Details tab displayed
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although this may lead to confusion.

When an SRU is added from the SRU Database, its name is set automatically.  Otherwise, 
CANSARP assigns each new SRU the same name: New_SRU.  While it is not strictly necessary 
to rename SRUs, it is a good idea to change each SRU's name to something unique and 
meaningful to make it easier to tell them apart, especially in reports or when minimized.  

Hint: It may be helpful to put distinguishing characters at the beginning of an SRU's 
name rather than the end because only the first few characters of an SRU's name are 
displayed in its icon and in the SRU list.  For example, the names Hercules1, Hercules2, 
and Hercules3 will all look the same when minimized, whereas 1Hercules, 2Hercules,  
3Hercules will be easier to distinguish.

To change the SRU name, highlight the text in the SRU Name field and replace it with another 
name.

12.2.1.2 Colour  

CANSARP automatically assigns each SRU a different colour that is used for the SRU's search 
pattern and for its icon when it is minimized.   Although CANSARP attempts to pick a colour 
that isn't already used by an SRU or search object, sometimes the colour selected may be very 
similar to one already in use.  As well, some colours do not appear well on certain screens or 
print well on certain printers.  For these reasons, it may be desirable to change an SRU's colour.

To change the colour of an SRU, click the Color button.  A dialog box will appear with a list of 
colours, as shown in Figure 12.2.
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Figure 12.2: The SRU 
Colour dialog box
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Select a new colour from the list by left clicking on it.  The chosen colour will appear in the field 
at the bottom of the dialog box.  When the colour you wish to use is selected, click the OK button. 
The dialog box will close and the new colour will appear next to the Color button in the SRU 
Manager.  You must click Apply for the change to take effect.  

12.2.1.3 CSP (Lat, Lon and Time)  

The Lat, Lon and Time fields display the position and time of the selected SRU's CSP.  The 
information in these fields is also displayed in the table at the top of the manager window and in 
the Pattern Editor when the SRU's pattern is edited.  

To change the SRU's CSP, select the information in any of these fields and replace it.  You must 
click Apply for any change to these values to take effect; changing the latitude and/or longitude 
will move the SRU's pattern on the canvas but will not reset it.  Changing its time does not 
affects its search pattern.

12.2.1.4 Search Object Type  

The Search Object Type field indicates the type of search object that the selected SRU is 
searching for, which is used to determine various parameters such as weather factor and speed 
factor, and therefore also contributes to the calculation of sweep width.  Since the presence or 
lack of a drogue has no impact on these values, there is no need or way to specify whether the 
SRU is searching for an object with a drogue.

An SRU is set to look for a type of search object but is not tied to any particular search object that 
has been added to the scenario, even if the SRU was added from the Search Object Manager via 
the Allocate SRU button.  

If an SRU is looking for more than one search object, its search object type should be set to the 
object with the narrowest sweep width.  If, for example, a single SRU is looking for a large ship 
and also persons in the water, its type should be set to PIW.  This will yield an initial search 
pattern with a coverage appropriate for the PIWs, who will be much more difficult to spot than 
the larger ship.

To change the type of search object, click on the small arrow button to the right of the Search 
Object Type field to expand the drop down menu of types and select one from the list.  Because 
sweep width depends on search object type, changing the search object type resets the SRU's 
search pattern.

12.2.1.5 SRU Type  

The SRU Type field indicates the type of SRU performing the search and, in the case of aircraft, 
the altitude of the SRU.  This setting is used to determine initial speed settings, speed factor and 
therefore sweep width, and also aircraft correction factor (refer to Section 12.2.2.6).

To change the type of SRU, click on the small arrow button to the right of the SRU Type field to 
expand the drop down menu of types and select one from the list.  Changing the SRU type resets 
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the SRU's search pattern.

If an SRU aircraft type is chosen that flies at an altitude for which there is insufficient visibility 
(determined by comparison with the value in the Visibility field of the Scenario Manager), a 
warning box appears.  CANSARP still allows the use of the given type of SRU, but the warning 
must be acknowledged by clicking OK to close this box.  Each time the given SRU is selected, 
including when the SRU Manager is opened, CANSARP will warn again about the lack of 
visibility.

12.2.1.6 Searching Speed (V)  

The Searching Speed field indicates the speed at which the vessel or aircraft will travel while 
searching.  Note that this is not the same as its transit speed, i.e. the speed at which it can travel to 
and from the search area.  Searching speed determines, among other things, sweep width, total 
track length (with on-scene time) and initial track spacing.

The searching speed of a vessel defaults to 5.0 knots and must fall into the range of 1.0 to 50.0 
knots.  The searching speed of a helicopter defaults to 50.0 knots and must fall into the range of 
30.0 knots and 500.0 knots.  The searching speed of a fixed wing aircraft defaults to 140.0 knots 
and must fall into the range of 30.0 knots and 500.0 knots.

To change the SRU's search speed, select the value in the Searching Speed and replace it, or use 
the small arrows to the right of the field to increase or decrease it.  

Changing the searching speed resets the SRU's search pattern.

12.2.1.7 SRU Position Error (Y)  

The SRU Position Error fields display the SRU's navigation method and the error associated with 
it.  An SRU's position error contributes to the size of the minimax circles drawn around every 
search object but not to the smaller circles drawn around individual particles that form the arc of 
probability.  If more than one SRU has been added to the scenario, the largest SRU position error 
is used for all search objects and the others are ignored.

An SRU's navigation system defaults to GPS and its error to the 0.25 NM appropriate for that 
type but this information can be changed by selecting a different navigation method from the left 
drop down menu, which will enter an appropriate value into the right error field, or by entering a 
new value directly into the error field.

12.2.1.8 Search Number  

The search number field indicates the search number as set in the Scenario Manager.  This value 
is used to determine any factors that depend on search number for all SRUs added to a scenario.

12.2.1.9 Additional Buttons  

Clicking on the Center On button will recentre the canvas on the selected SRU.  This is useful if 
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an SRU has been added from the SRU Database and is positioned at its home base.

Clicking on the Print Tasking button prepares the tasking form for the selected SRU.

12.2.2 Calculations Tab
The Calculations tab of the SRU Manager (shown in Figure 12.3) deals with many of the 
variables used to calculate an initial search pattern for the selected SRU.  These variables include 
those related to sweep width and track spacing and time available on scene as well as the 
requested coverage factor.

12.2.2.1 Weather Factor (Fw)  

Weather factor is calculated internally according to Figure 7D-11 Weather Condition Factor of the 
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Figure 12.3: The SRU 
Manager window with 
Calculation tab displayed
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National SAR Manual, and is based on the SRU's search object type (set on the Details tab, see 
Section 12.2.1) and the sea state set in the Scenario Manager.  

Weather factor is used in the calculation of sweep width and therefore initial track spacing.  This 
value cannot be modified directly.

12.2.2.2 Speed Factor (Fv)  

Speed factor is calculated internally according to Figure 7D-12 Search Aircraft Speed Correction 
Factor of the National SAR Manual or interpolated for speeds above those shown in the table. 
The value is only calculated for aircraft; for vessels, it is set to 1.0 in order to eliminate its effect. 

Speed factor is used in the calculation of sweep width and therefore initial track spacing.  This 
value cannot be modified directly.

12.2.2.3 Fatigue Factor (Ff)  

Fatigue factor indicates the sharpness of the crew aboard the SRU.   This value defaults to 1.0 to 
eliminate its effect but should be set to 0.8 when the crew is likely fatigued.  

According to the National SAR Manual, the “crew will be fatigued if they have been 
involved in a search for an extended period, and they may exhibit signs of fatigue which 
include: missed communications; problems with memory; irritability; and increased time 
to complete tasks or make decisions.” (NSM, Chapter 7, p 62).

Fatigue factor is used in the calculation of sweep width and therefore initial track spacing. 
Changing the fatigue factor will recalculate sweep width and track spacing and will therefore 
reset the SRU's search pattern.  To change it, select one of the suggested values from the Fatigue 
Factor drop down menu or enter a new value between 0.1 and 1.0 into the field and then click 
Apply.

12.2.2.4 Sweep Width (W)  

Sweep width is calculated internally according to the formula W = Wu x Fw x Ff  x Fv and uses the 
values in the Weather Factor, Speed Factor and Fatigue Factor fields as well as the uncorrected 
sweep width tables in Annex 7D – Sweep Width Tables of the National SAR Manual (Figures 
7D-1 through 7D-9).

This value is used with requested coverage factor to determine initial track spacing in search 
patterns.  It cannot be modified directly but any change that alters an SRU's sweep width will 
reset its search pattern as well.

12.2.2.5 SRU Endurance  

The value in the SRU Endurance field indicates the total number of hours for which an SRU can 
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be tasked.  The SRU's transit time is subtracted from this value and the result is multiplied by the 
the aircraft correction factor to determine on scene endurance which is the amount of time the 
SRU has available to actually traverse its search pattern.

When using the Transit Editor, the value in the SRU Endurance field should include transit time. 
If you know the transit time, it may be easier to simply subtract it from the SRU's total endurance 
and enter the result into the SRU Endurance field rather than using the Transit Editor.  Similarly, 
if you know the amount of time the SRU expects to have on scene, enter this value into the SRU 
Endurance field and refrain from using the Transit Editor.  For more information on the Transit 
Editor, see Section 12.9.

To change the SRU's endurance, select the value in the field and replace it with another value 
between 1.0 and 100.0 or use the arrows to the right of the field to increase or decrease the value 
shown.  Changing the SRU's endurance resets its search pattern.  

You must click Apply before a change to the SRU's endurance will take effect.

12.2.2.6 Aircraft Correction Factor  

The aircraft correction factor is multiplied by the SRU's total endurance to determine the amount 
of time on scene that can actually be spent traversing a search pattern.  The aircraft correction 
factor accounts for the fact that aircraft must make wide turns outside the search area at the end 
of each leg to change direction and also allows them some time to circle back to investigate 
potential sightings.  

The aircraft correction factor is automatically set to 0.85 for helicopters and fixed wing aircraft. 
For vessels, it is set to 1.0 to eliminate its effect.  It may be changed to any value between 0.05 
and 2.0. Altering an SRU's aircraft correction factor recalculates its on scene endurance and 
therefore resets its search pattern.  

You must click Apply before a change to the aircraft correction factor will take effect.

12.2.2.7 On-Scene Endurance  

On-scene endurance is the amount of time an SRU has on scene to actually traverse a search 
pattern.  It is calculated by multiplying the SRU's total endurance in the SRU Endurance field by 
the aircraft correction factor and then subtracting its transit time, if any.

12.2.2.8 Transit Time  

An SRU's transit time is subtracted from its total endurance before the result is multiplied by the 
aircraft correction factor to determine on scene endurance.  If you know the transit time, simply 
subtract it from the SRU's total endurance and enter the result into the SRU Endurance field 
rather than using the Transit Editor.  

If you know the SRU's origin and its final destination after concluding its search but not the time 
required to travel to and from the scene, you may use the Transit Editor to calculate its transit 
time.  In this case, the result will be displayed in the Transit Time field.
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Transit Time cannot be modified directly.  To modify it either adjust the SRU Endurance field 
(refer to Section 12.2.2.5) or use the Transit Editor (refer to Section 12.9).  In either case, 
changing the SRU's transit time alters its time on scene and therefore resets its search pattern.  

12.2.2.9 Requested Coverage Factor  

Coverage factor is a measure of search effectiveness or quality and is the ratio between sweep 
width and track spacing.  The requested coverage factor is used to determine the track spacing of 
an SRU's initial search pattern.  This value defaults to 1.0, which leaves no gaps or uncovered 
area within the pattern.  If time or resources are limited, this number may be reduced as far as 
0.05; if the area is small and excess resources are available, it may be increased to as much as 
2.0.

Note: Only the parallel sweep and expanding square search patterns make use of  
requested coverage factor.  

You must click Apply before a change to the requested coverage factor will take effect.  Changing 
it will reset the SRU's search pattern.

12.2.3 Pattern Type
The Pattern Type field is visible at the bottom of the SRU Manager window regardless of which 
tab is displayed above it and indicates type of search pattern the SRU is to use.  To change the 
pattern type, click the arrow to the right of the Pattern Type field and select another type from the 
drop down menu that appears and then click Apply.  

To open an SRU's search pattern in the Search Pattern Editor, click the Edit button to the right 
side of the field. See Chapter 13 – Effort Allocation: Search Patterns  for details on editing search 
patterns.

12.3 Adding a New SRU
To add a new SRU from the SRU Manager, click the New SRU button below the list of SRUs; 
this adds a new SRU to the scenario and adds a corresponding search pattern to the canvas.  The 
new SRU will be named “New_SRU” and its colour will be assigned automatically.  The same 
colour is used to display the search pattern, which defaults to a parallel sweep track optimized for 
the initial parameters described previously and outline in Table 12.1.

If there is already at least one search object, the new SRU's commence search point (CSP) will be 
located at the first search object's latitude and longitude and its search object type will be set to 
that of the first search object.  If no search objects have been added to the scenario yet, the new 
SRU will be positioned at the centre of the canvas and its search object type is set to PIW.  

In either case, the other fields of the details and calculations tabs are filled in with the same initial 
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values, which are also used to determine an initial parallel sweep track for the SRU:
Parameter Default Initial Value

Type Fixed wing, 300 feet altitude
Search Speed 140 knots

Navigation System GPS
Position Error 0.25 NM

Search Pattern Type Parallel sweep
Fatigue Factor (Ff) 1.00
SRU Endurance 1.00 hours

Aircraft Correction factor 0.85
Requested Coverage 1.00

Table 12.1: A generic SRU's default values

The SRU's initial sweep width, track spacing and total track length are calculated based on these 
values and the other values calculated internally, such as weather factor and speed factor.  These 
parameters are discussed in Sections 12.2.1 and 12.2.2.

12.3.1 Adding a New SRU from the SRU Database
You may also add a new SRU by selecting one that has previously been added to the SRU 
database.  In this case, the parameters listed in Table 12.1 will be set according to the information 
in the database instead of to the default values.

To add an SRU from the database, click the SRU Database button.  This will open the SRU 
Database Resources window:  

This window displays a list of SRU categories that can be expanded to show the individual SRUs 
each contains. For example, in Figure 12.4, the Secondary Marine category has been expanded so 
that four SRUs are visible.  The ID, type, base and a brief description are displayed for each SRU 
in the list.  

150

Figure 12.4: The SRU Database window with the list of Secondary Marine resources  
expanded.
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Note: SRUs will only appear in the SRU Database if they have previously been added to 
the database by the CANSARP administrator and that the database of resources may 
vary from one RCC to another.  New resources may only be added to the database when 
CANSARP is running in admin mode.

To add a particular SRU to a scenario, select it in the list, then click the Select button and then 
the Close button.  The selected SRU will now appear in the SRU list in the SRU Manager and the 
fields of the Details and Calculation tabs will be filled automatically with the values entered into 
the database for the selected SRU.  You should check to make sure the database settings for the 
SRU apply in the given situation and modify any parameters as circumstances require.

When added from the SRU database, an SRU's CSP will be set to the first search object in the 
search object list if there is one.  If there is not, the SRU will be located at its home base.

Hint: If you add an SRU from the database and aren't sure where it was positioned, click 
the Center On button to recentre the canvas on the selected SRU.

12.3.2 Adding an SRU from the Canvas Menu
To add a new SRU from the canvas menu instead of the SRU Manager, right click at the SRU's 
intended position and select Allocate SRU from the canvas menu when it appears.  This has the 
same effect as using the New SRU button except that the new SRU will be positioned at the point 
where you clicked rather than at the first search object or the centre of the canvas.  SRUs cannot 
be added from the SRU Database from the canvas menu.

12.3.3 Adding an SRU from the Search Object Manager
You may also add an SRU for a particular search object by selecting that object in the Search 
Object Manager and then clicking on the Allocate SRU button located below the search object 
list.  This has the same effect as adding the SRU from the SRU Manager, except that the new 
SRU will have the same position as the search object, the SRU's type will be set to that of the 
search object, and its search speed may vary from the default 140 knots; again, these values will 
be used to determine the initial search pattern.

Caution: SRUs are not tied to a specific search object in the Search Object Manager. If  
an SRU is allocated from within the Search Object Manager, its search object type is set  
to the search object currently selected, but no link is created between the two.  If that  
search object is later modified or deleted, it will have no effect on the SRU.

151



Chapter 12: Effort Allocation: SRUs and the SRU Manager

12.4 Duplicating an SRU
You may duplicate an existing SRU by clicking the Duplicate SRU button below the SRU list in 
the SRU Manager.  This makes an exact copy of the SRU, including its transit points (see Section 
12.9) and its search pattern, except that a different colour is assigned to the new SRU.  You may 
then change any of the new SRU's parameters as described in Sections 12.2.1 and 12.2.2 if 
desired.

Hint: The new SRU will have the same name as the original.  It may be helpful to change 
its name to something unique so that it is easier to tell the two apart in the SRU list, in  
printed reports and SRU tasking forms, and when both are minimized on the canvas.

12.5 Deleting an SRU
To delete an SRU, select it in the SRU list by left clicking on it and then click the Delete button. 
Alternately, you may right click on the SRU's search pattern or icon and select Delete SRU from 
the canvas menu when it appears.  

Caution: If more than one search pattern covers the position on which you right click,  
the SRU that appears first in the SRU list will be manipulated.  This is usually the pattern 
on the bottom of the stack rather than the one visible on top.  For this reason, you should 
avoid deleting stacked SRUs via the canvas menu.

12.6 Modifying an existing SRU
Once an SRU has been added, many of its parameters may be modified.  If a field in the Details 
or the Calculation tab is greyed out, it is a read-only field containing a variable that is calculated 
internally based on information entered in other places.  The fields that are not read-only  may be 
modified directly by the user.

To change one or more parameters of a given SRU, open the SRU Manager and then select the 
particular SRU in the list at the top of the manager window by left clicking on it.  Alternately, 
you may right click on the SRU's search pattern or icon and select Edit SRU from the canvas 
menu when it appears.  This will open the SRU Manager with the given SRU already selected.  In 
either case, the selected SRU's parameters will be displayed in the various fields of the Details 
and Calculation tabs.  

Any changes made to the editable fields of the SRU Manager will only take effect once the Apply 
button is clicked.  If you close the SRU Manager without applying a change, you will be 
prompted to Apply the change before the window closes.  If you wish to discard your changes, 
close the window without applying them.
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Note: Applying any change that affects sweep width, on scene endurance or search 
pattern type will reset an SRU's search pattern to one optimized for the new values.

12.7 Deleting an SRU
To delete an SRU, select it in the list at the top of the SRU Manager window and then click the 
Delete SRU button.  Alternatively, you may right click on the SRU's search pattern on the canvas 
or on its minimized icon and select Delete SRU from the canvas menu when it appears.

Note: If the SRU just deleted had a larger SRU position error than any remaining SRUs,  
you must refresh the screen to display the new, smaller minimax circle.  See Section 
12.2.1.7 for more information.

12.8 SRUs and the Canvas Menu
To add a new SRU from the canvas menu, right click at the SRU's intended position and select 
Allocate SRU from the canvas menu when it appears.  This has the same effect as using the New 
SRU button in the SRU Manager (see Section 12.3) except that the new SRU will be positioned 
at the point where you clicked rather than at the first search object or the centre of the canvas.

To delete an SRU from the canvas menu, right click on the SRU's search pattern and then select 
Delete SRU from the canvas menu when it appears.

To open the SRU Manager with a particular SRU selected so that it may be modified, right click 
on the SRU's search pattern and then select Edit SRU from the canvas menu when it appears.

Caution: If more than one search pattern covers the position on which you right click to 
open the canvas menu, the SRU that appears first in the SRU list, usually the pattern on 
the bottom of the stack rather than the one visible on top, will be manipulated.  For this  
reason, you should avoid deleting stacked SRUs via the canvas menu and should check to 
make sure that the SRU you wish to modify is the one selected when the SRU Manager 
opens.

To minimize an SRU's search pattern from the canvas menu, right click on the search pattern and 
select Minimize Pattern from the canvas menu when it appears.  See the Before You Begin... 
section of Chapter 13 – Effort Allocation: Search Patterns for further information on minimizing 
search patterns.
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Hint: If an SRU has been minimized, you may use the canvas menu to manipulate it by 
right clicking on its icon instead of its search pattern.

12.9 The Transit Editor
The Transit Editor can be used to estimate an SRU's time on scene and transit time to and from 
the scene when its position before the search and its destination after the search are known but 
the time required to travel to and from the search area is not. 

Hint: If the time required for an SRU to travel to and from the scene is known, simply 
subtract this time from the SRU's endurance on the Calculations tab of the SRU Manager 
and do not use the Transit Editor.

Calculation of transit time depends on the location of the SRU's CSP, so the pattern should be 
moved to the correct location before transit time is calculated.

Note: Calculating a transit time recalculates the SRU's on scene endurance time, which 
in turn resets the SRU's pattern.  If you plan to use the Transit Editor, you should 
calculate the transit time before modifying the SRU's search pattern.

To open the Transit Editor, first select the SRU for which you wish to calculate a transit time in 
the SRU Manager, then switch to the Calculations tab if necessary and click the Transit Editor 
button.  To calculate the SRU's transit time, follow the instructions in each of the following 
subsections.

12.9.1 SRU Start Point / Home Base
The SRU Start Point / Home Base region of the Transit Editor displays the latitude and longitude 
of the SRU's original position before traveling to the search area and the time at which it leaves 
this location.  If the transit time is up to date (see previous note), the remaining fields in this 
region indicate the distance from the starting point to the CSP and the time required to travel this 
distance at the transit speed set at the bottom of the editor window.
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To set the SRU's starting point position, enter a latitude and/or longitude into the Lat and/or Lon 
fields in the SRU Start Point / Home Base region.  Alternately, you  may set the position with the 
mouse by first making sure the Edit SRU Start Point radio button is selected at the bottom of the 
editor window and then clicking on the canvas at your chosen position.

12.9.1.1 Start Point Time and CSP  

When an SRU is first opened in the Transit Editor, its starting time and CSP time are the same. 
Whenever a transit time is recalculated for the SRU, its starting time stays constant and its CSP is 
adjusted to account for the time required to travel from the Start Point to the CSP at the speed 
displayed in the Transit Speed field at the bottom of the Transit Editor window.  This change to 
CSP is immediately reflected in the SRU manager as well.  The SRU's End Search Point time and 
Recovery Point time are also recalculated in the same fashion.

You may change the SRU's starting point time by entering a new value into the Time field within 

155

Figure 12.5: The Transit  
Editor



Chapter 12: Effort Allocation: SRUs and the SRU Manager

the Start Point / Home base region of the Transit Editor.  Doing so will adjust the CSP time, End 
Search Point time and Recovery Point time as well once the transit time is recalculated.

12.9.2 Commence Search Point
The Commence Search Point region of the Transit Editor displays the latitude and longitude of 
the SRU's CSP and the time at which it will arrive at this position.  These fields are set 
automatically by the values in the SRU Manager and cannot be changed within the Transit Editor 
itself.  

Note: Changing an SRU's CSP outside of the Transit Editor invalidates any previously 
calculated transit time and so automatically turns off the Use Transit Time option in the 
SRU manager for the given SRU.

12.9.3 End Search Point
The End Search Point region of the Transit Editor displays the latitude and longitude of the 
SRU's End Search Point at the time at which it will arrive at this position.  These fields are set 
automatically and cannot be changed except by manipulating the search pattern itself.

Note: Manipulating an SRU's search pattern may invalidate any previously calculated 
transit time and so automatically turns off the Use Transit Time option in the SRU 
manager for the given SRU.

12.9.4 Recovery Point
The Recover Point region of the Transit Editor displays the latitude and longitude of the SRU's 
final destination after traversing its search pattern, and the time at which it will reach this location 
traveling from its ESP at the speed displayed in the Transit Speed field at the bottom of the editor 
window.  If the transit time is up to date (see earlier note), the remaining fields in this region 
indicate the distance from the ESP to the recovery point and the time required to travel this 
distance at the transit speed.

To set the SRU's recovery point position, enter a latitude and/or longitude into the Lat and/or Lon 
fields in the SRU Recovery Point region.  Alternately, you  may set the position with the mouse 
by first making sure the Edit Final Destination radio button is selected at the bottom of the editor 
window and then clicking on the canvas at your chosen position.

12.9.5 Transit Speed
An SRU's transit speed is the speed at which it will travel to and from the scene rather than the 
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speed it will travel while traversing its search pattern.  This value defaults to the SRU's search 
speed so will likely need to be increased.  It can be changed to anything from 1 to 1500 knots by 
entering a new value into the field or by using the arrows to the right of the field to increase or 
decrease the value shown.

12.9.6 Recalculating Transit Time
Once a start point, recovery point and transit speed are set for the SRU, you must click the 
Recalculate Transit Time button at the bottom of the editor window to actually calculate the time 
required to travel to and from the scene.  When you do so, the Recalculate Transit Time button 
will grey out, indicating that the values in all of the editor's various fields are up to date.  

Recalculating the transit time will also automatically turn on the Use Transit Time check box in 
the SRU Manager and enter the transit time into the Transit Time field beside it.  This value will 
be subtracted by the SRU's corrected endurance (see Section 12.2.2.6) to determine its on scene 
endurance.  Recalculating an SRU's transit time also resets its search pattern to one optimized for 
its new on scene endurance.

12.9.7 Transit Time Recalculation Required
If the Recalculate Transit Time button at the bottom of the Transit Editor window is activated 
(i.e. not greyed out), the calculated times and distances in the editor's read-only fields may no 
longer be valid. In addition to happening whenever a change is made to one of the editable fields 
in the Transit Editor, this condition may be triggered by changes made elsewhere in the program. 
For example, moving a search pattern to a new position or changing the SRU's endurance 
invalidates a previously calculated transit time.  

As well, when a change is made to an SRU's details or search pattern that invalidates a previously 
determined transit time, the words “Recalculation Required” will flash at the bottom of the SRU 
Manager's Calculation tab whether or not the Transit Editor is open.

To make sure that the information displayed in the Transit Editor's fields is current, recalculate 
the transit time whenever the Recalculate Transit Time button is activated but be warned: doing 
so will reset the SRU's search pattern.

In some cases when a previously calculated transit time is unusable, such as when the SRU's 
endurance is reduced to less time than required to travel to and from the scene, the Use Transit 
Time check box may be deactivated and the value of the Transit Time field on the SRU 
Manager's Calculations tab reset to 0.  When this happens, the SRU Start Point and Recovery 
Point values are left unchanged in the Transit Editor window to facilitate recalculation of its 
transit time.

12.9.8 The Transit Time Paradox
Calculating a transit time recalculates the SRU's on scene endurance time, which in turn resets 
the SRU's pattern.  If you plan to use the Transit Editor, you should calculate the transit time 
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before modifying the SRU's search pattern so that your modifications are not lost.. 

However, modifying the SRU's search pattern in such a way that its CSP, ESP or time on scene is 
altered means that a previously calculated transit time is no longer valid.  If the change is not 
significant, the estimated transit time will likely still be useful.  If it is significant, however, and 
you are relying on the Transit Editor to determine time on scene or on scene endurance, it might 
be wise to measure the new transit distance with the linear range ruler and use this distance and 
the SRU's transit speed to calculate the actual transit time and time on scene and compare it to the 
estimated values.  

Alternately, you could save the scenario, recalculate the transit time and make note of the new 
estimate and time on scene and then reload the SRUs by selecting Reload from the File menu and 
then SAR Units from the menu of scenario components when it appears.  Once the SAR Units are 
reloaded, subtract the estimated transit time from the SRU's total endurance, enter this new value 
into the SRU Endurance field on the Calculations tab of the SRU Manager and the new CSP time 
on scene into the Time field on the Details tab, and do not use the Transit Editor to calculate 
transit time. 
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CANSARP provides four types of search patterns for each SRU: parallel sweep, expanding 
square, sector search and custom track.  The custom track pattern editor may be used to define 
any type of search pattern but is most commonly used for trackline return, trackline non-return 
and coastal crawl patterns as described in the National SAR Manual.  

In this chapter, you will learn
• How to set an SRU's search pattern type

• How to minimize an SRU's search pattern

• How to open an SRU's search pattern in the Search Pattern Editor

• How to manipulate an SRU's search pattern with the mouse

• How to manipulate an SRU's search pattern via the keyboard

• The differences between the various search pattern types

• How to use the Custom Track Pattern Editor to create a custom search pattern

• How to use the Custom Track Pattern Editor to create a coast crawl pattern

13.1 Before you begin...

13.1.1 Setting Pattern Type
All new SRUs default to using a parallel sweep search pattern.  To change the SRU's pattern to 
another type, select it in the SRU List at the top of the SRU Manager window and then choose 
another pattern type from the Pattern Type drop down menu at the bottom of the manager 
window.

13.1.2 Minimizing an SRU's pattern
To reduce clutter on the canvas, you can minimize individual SRUs so that their search patterns 
are not displayed.  This is also known as “iconifying” them.  Minimizing an SRU removes its 
pattern from the canvas and creates an icon in the bottom left corner of the canvas window to 
represent it instead.  When a pattern is minimized, you may right click on the SRU's icon and use 
the canvas menu just as if you'd clicked on its pattern.  
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To minimize a single SRU, double left click on its pattern on the canvas or right click once on the 
pattern and select Minimize Pattern from the canvas menu when it appears.  To maximize it 
again, left click once on its icon.

To minimize all SRUs at once, type F4 while holding down the Control key.  This same key 
combination will maximize all SRUs again.

13.2 The Search Pattern Editor
To modify an SRU's search pattern, you must open it in the Search Pattern Editor.  This is true 
whether you plan to modify it with the mouse or the keyboard.

There are three ways to open an SRU's search pattern in the Search Pattern Editor: by left 
clicking on its pattern on the canvas; by right clicking on its pattern (or on its icon, if minimized) 
and selecting Edit Pattern from the canvas menu when it appears; or by opening the SRU 
Manager, selecting the given SRU, and then clicking the Edit button at the bottom of the manager 
window.  

Only one Search Pattern Editor window of any type (parallel track, sector search, expanding 
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Figure 13.1: The Parallel  
Sweep Search Pattern 
Editor.  Note that other  
types of patterns look 
slightly different when 
opened in the Search 
Pattern Editor.
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square, or custom track) may be open at a time.  If the Search Pattern Editor is already open when 
you open another search pattern, the first Search Pattern Editor window will close.

Figure 13.1 shows the Parallel Sweep Search Pattern Editor.  The two read only fields at the top 
of the editor window display the SRU's name (set in the SRU Manager) and the search number 
(set in the Scenario Manager).  Below this are four regions which are common to all pattern 
types, although their contents may vary from one type to the next.

13.2.1 Search Pattern CSP
Every search pattern type has a CSP region that contains three fields related to the SRU's 
commence search point (CSP): Lat, Lon and Time.  These are initially set according to the 
information in the corresponding fields of the SRU Manager, but may be modified from the 
keyboard.  Changes to a pattern's CSP are reflected in the SRU Manager as well.  

Caution: Changing an SRU's CSP invalidates a previously calculated transit time, so the 
SRU's on scene endurance may no longer be accurate.  When you move an SRU, 
consider whether or not the change will have a significant impact on its transit time.

13.2.2 Search Pattern Details
Each search pattern type has a slightly different combination of fields in this region of the Search 
Pattern Editor.  See the description of the individual search patterns later in this chapter.

13.2.3 Search Pattern Coverage
The Coverage region of the Search Pattern Editor describes the effectiveness of the individual 
SRU as well as the combined effectiveness of all the SRU that have been added to the scenario.

All types of search patterns share the same six fields, as described below.  These fields are read 
only and are either filled in with information set in other managers or with values calculated 
internally.

13.2.3.1 Coverage Factor – Requested and Achieved  

Coverage factor is the ratio between track spacing and sweep width.  The Coverage Factor 
Requested field displays the value set in the SRU Manager (see Chapter 12 – Effort Allocation: 
SRUs And The SRU Manager) and is used to calculate an initial track spacing whenever the SRU's 
search pattern is reset.  When requested coverage factor is 1.0, the initial track spacing will be 
equal to the SRU's sweep width.  

The value in the Coverage Factor Achieved field indicates the search pattern's actual track 
spacing to sweep width ratio, which may be different from the coverage factor requested in the 
SRU manager if the pattern has been modified.  When a search pattern's track packing is altered, 
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whether by entering a new value via the keyboard or by stretching it with the mouse, the ratio 
between it and the SRU's sweep width will change as well.  

Note: Coverage factor cannot be calculated for a Custom Track pattern, so its Achieved 
value is simply set to 1.0.  The achieved coverage factor for Sector Search patterns is 
calculated using the mid-leg track spacing.

13.2.3.2 Probability of Detection – This Pattern  

The value in the Probability of Detection (POD) This Pattern field indicates the effectiveness of 
the individual SRU.  It is calculated based on the SRU's achieved coverage factor and the search 
number as described in Section 5.26 – Probability Of Detection and Figure 5-3 – Coverage Factor 
Vs. Probability Of Detection of the National SAR Manual.  The individual SRU's POD is not based 
on the search area polygon or on any other SRUs in the scenario.

13.2.3.3 Probability of Detection – Polygon  

If a search area polygon has been added to the scenario, CANSARP can calculate a Polygon 
POD.  This Polygon POD is a measure of the combined coverage of the search area polygon by 
all the SRUs added to the scenario.

This Polygon POD is calculated as follows:

• The individual POD for each SRU is calculated.

• Each SRU's individual POD is multiplied by the proportion of the search area polygon that its 
search pattern covers (in terms of area searched) to produce a scaled POD that ignores parts 
of the search pattern that are outside the polygon.

• The scaled PODs for all SRUs are summed together, accounting for regions where multiple 
search patterns overlap.  

To calculate the Polygon POD, click the Polygon POD button at the bottom of the Search Pattern 
Editor.  The resulting sum will be displayed in the Probability of Detection - Polygon field.

Caution: Polygon POD is not the same as the cumulative POD calculated in the manual  
method, nor does it relate to the POD of repeated searches.

13.2.3.4 On-Scene Endurance – SRU and Pattern  

The On-scene Endurance – SRU field indicates the amount of time an SRU has available on 
scene, as calculated in the SRU Manager (refer to Section 12.2.2.7 of Chapter 12 – Effort  
Allocation: SRUs And The SRU Manager). The On-scene Endurance – Pattern field indicates the 
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amount of time required for the SRU to actually traverse the search pattern.  

Whenever a search pattern is reset, it is recalculated to maximize but not exceed the SRU's 
endurance.  If the search pattern is modified via the mouse or keyboard in such a way that the 
time required to traverse the pattern exceeds the SRU's endurance, the phrase “> AVAILABLE” 
will flash next to the Accept button below the Coverage region as a warning that endurance has 
been exceeded.  To acknowledge the warning, click the Accept button.  The text will stop 
flashing but remain visible until the pattern is changed in such a way that the Pattern endurance 
does not exceed the SRU's time on scene.

13.2.4 Overlap vs. Non-overlap
Another feature common to some search pattern types is the ability to allow or disallow 
overlapping with other search patterns.  

By default, CANSARP allows search patterns to overlap one another on the canvas.  You may 
choose to change this behaviour, however, as may be desirable in the case of two aircraft flying 
near one another at the same altitude.  Turning off the ability to overlap also allows you to use the 
mouse to make two patterns abut one another and ensure that there are no gaps left between them 
without the duplication of effort that would result from having their patterns overlap.

To turn off the overlap option for an SRU, open the Search Pattern Editor and click on the No 
radio button to the right of the Permit Overlap? label.  In order to prevent two patterns from 
overlapping, overlap must be disabled for both patterns.  In this way, two aircraft may be 
prevented from overlapping one another but still be allowed to overlap with vessels below them.

Hint: If two patterns are already overlapping, you will not be able to disable overlapping 
for them both.  You must first move one so that the two do not overlap, and then disable 
overlapping.  

Note: If the CSP of a pattern for which overlapping has been disabled is changed via the 
keyboard in such a way that it now overlaps another pattern for which overlapping has 
been disabled, overlapping will be reenabled for the pattern that was moved.

As of CANSARP 5.0, overlap may only be turned off for Parallel Sweep and Expanding 
Square patterns.

13.3 Editing Search Patterns Graphically with the Mouse
Search patterns may be manipulated graphically by using the mouse to drag, rotate, or stretch the 
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pattern.  The pattern must still be opened in the Search Pattern Editor in order to be manipulated 
in this way. 

Hint: When manipulating any search pattern with the mouse, you must always use the 
middle mouse button.

Changes made to a search pattern with the mouse are applied and reflected in the Search Pattern 
Editor immediately.

13.3.1 Moving a Search Pattern with the Mouse
To move a search pattern, middle click and hold anywhere within the pattern's boundary, then 
drag it to the desired location.  This works for every type of search pattern.

13.3.2 Stretching a Search Pattern with the Mouse
To stretch a search pattern, middle click and hold outside the boundaries of the pattern near one 
of its edges, and drag the mouse.  This has different effects depending on the type of search 
pattern as described in the sections on each type of pattern later in this chapter.

13.3.3 Rotating a Search Pattern
To rotate a search pattern, middle click and hold outside the boundaries of the search pattern near 
one of its corners or end points, and then drag the mouse to spin the pattern.  Sector search 
patterns rotate about their centre point; all other patterns rotate about the corner opposite the one 
near which you clicked.

Hint: You don't need to click very close to the pattern to stretch or rotate it and clicking 
farther away will avoid moving the pattern by accident.  However, clicking fairly close to 
the pattern will make it easier to control whether you're dragging a side (stretching the 
pattern) or a corner (rotating the pattern).

13.3.4 Rotating Patterns via Keyboard and Mouse
When rotated with the mouse, search patterns rotate about the opposite corner (except sector 
searches, which rotate about their centre point).  Most search patterns may also be rotated via the 
keyboard by changing the value in the Orientation field of the Search Pattern Editor.  When this 
is done, a search pattern rotates about its CSP rather than a corner point.
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Caution: This difference in rotation points means that the two methods of rotating a 
search pattern do not cancel each other out.  That is, rotating a search pattern by first  
one method and then the other does not necessarily return the pattern to its original 
position but rather can “walk” it across the canvas.  The Parallel Sweep Search Pattern 
(SS)

Figure 13.2 shows a typical parallel sweep pattern in the Search Pattern Editor.

13.3.5 Parallel Sweep – Search Pattern Details
A parallel sweep pattern has four editable fields and one read-only field in its Search Pattern 
Details region:

• The Orientation field indicates the bearing of the pattern's first search leg.  An SRU 
traversing this pattern will leave from the CSP at this heading.

• The Search Leg Length (L) field indicates the length of each search leg.  An SRU traversing 
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this pattern will travel this distance before turning to the right or left to cross the track spacing 
to the next search leg.

• The Track Spacing (S) field indicates the distance between search legs.

• The Track Count (n) field indicates the number of search legs in the pattern.

• The Total Track (TT) field indicates the total length of the search pattern.

Editing any of these fields via the keyboard affects only the field(s) that were directly modified. 
The values in unmodified editable fields are preserved and Total Track (TT) is recalculated.  If 
the new total track length exceeds the SRU's on scene endurance, the phrase “> AVAILABLE” will 
flash below the Coverage region of the pattern editor, as described in Section 13.2.3.4.

13.3.6 Parallel Sweep – Additional Options
A parallel sweep pattern has two additional options: overlap and orientation.  These options are 
adjusted via the radio buttons near the bottom of the editor window.  

The Orientation Right/Left option determines the direction of creep, i.e. the direction the SRU 
will turn at the end of its first search leg.  If Right is selected, the SRU will turn right (relative to 
its heading, not the canvas) at the end of its first search leg.  If Left is selected, it will turn left 
instead.

The Permit Overlap? option determines whether or not the the search pattern may overlap with 
others on the canvas.  If On is selected, the pattern is allowed to overlap with other patterns, 
including those for which overlapping has been disabled.  If Off is selected, the pattern will not 
be able to overlap with other patterns for which overlapping has also been disabled.  See Section 
13.2.4 for further information on overlapping.

13.3.7 Stretching a Parallel Sweep Pattern with the Mouse
When a parallel sweep pattern is stretched with the mouse (see Section 13.3.2), the result 
depends on which of the adjustment options is selected at the bottom of the Search Pattern Editor 
window.  To choose between these options, simply click the radio button to the left of the option 
you wish to use.

13.3.7.1 Adjust S (Track Spacing)  

When Adjust S is selected, stretching a search pattern with the mouse will increase or decrease 
the distance between search legs.  All other parameters are left unchanged, and total track length 
is recalculated.

When this option is selected, you will only be able to stretch a pattern in the direction of creep. 
Stretching it in the opposite direction (against its creep) will affect the track spacing but will 
extend or contract the pattern in the direction of creep, leaving its right/left orientation and CSP 
unchanged. Stretching it in the direction of its orientation will have no effect.
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13.3.7.2 Adjust L (Search Leg Length)  

When Adjust L is selected, stretching a search pattern with the mouse will increase or decrease 
the length of its search legs.  All other parameters are left unchanged, and total track length is 
recalculated.

When this option is selected, you will only be able to stretch a pattern in the direction of its 
orientation, i.e. the heading of its first search leg  Stretching it in the opposite direction will affect 
the length of search legs but will extend or contract the pattern in the direction of the first search 
leg, leaving its CSP unchanged. Stretching it in the direction of its creep will have no effect.

13.3.7.3 Adjust n (Track Count)  

When Adjust n is selected, stretching a search pattern with the mouse will increase or decrease 
the number of search legs.  All other parameters are left unchanged, and total track length is 
recalculated.

When this option is selected, you will only be able to stretch a pattern in the direction of creep. 
Stretching it in the opposite direction (against its creep) will affect the number of search legs but 
will extend or contract the pattern in the direction of creep, leaving its right/left orientation and 
CSP unchanged. Stretching it in the direction of its orientation will have no effect.

13.3.7.4 Adjust L & S (Search Leg Length and Track Spacing)  

When Adjust L & S is selected, stretching a search pattern with the mouse will affect both search 
leg length and track spacing, leaving total track length and all other parameters unchanged.  
If the pattern is stretched in direction of creep, track spacing is increased or decreased, and search 
leg length is extended or contracted as required to keep the total track length constant.

If the pattern is stretched in the direction (or opposite direction from) its first search leg's 
orientation, search leg length is increased or decreased and track spacing is expanded or 
contracted as required to keep the total track length constant.

13.3.7.5 Adjust L & n (Search Leg Length and Track Count)  

When Adjust L & n is selected, stretching a search pattern with the mouse will affect both search 
leg length and track count, leaving total track length and all other parameters unchanged.  
If the pattern is stretched in direction of creep, track count is increased or decreased, and search 
leg length is extended or contracted as required to keep the total track length constant.

If the pattern is stretched in the direction (or opposite direction from) its first search leg's 
orientation, search leg length is increased or decreased and the number of search legs is reduced 
or increased as required to keep the total track length constant.

Figure 13.3 shows a typical parallel sweep pattern on the canvas.
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13.4 The Expanding Square Search Pattern (SS)

13.4.1 Expanding Square – Search Pattern Details
Figure 13.4 shows a typical expanding square pattern in the Search Pattern Editor:

An expanding square pattern has three editable fields and one read-only field in its Search Pattern 
Details region:

• The Orientation field indicates the bearing of the pattern's first search leg.  An SRU 
traversing this pattern will leave from the CSP at this heading.

• The Track Spacing (S) field indicates the distance between search legs.

• The Turn Count (n) field indicates the number of times the SRU must turn to traverse the 
pattern.

• The Total Track (TT) field indicates the total length of the search pattern.

Changing either track spacing or total track length from the keyboard leaves the other value 
unchanged and recalculates the number of turns required.  Changing both at once also 
recalculates the turn count.

If the new total track length exceeds the SRU's on scene endurance, the phrase “> AVAILABLE” 
will flash below the Coverage region of the Search Pattern Editor, as described in Section 
13.2.3.4.
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13.4.2 Expanding Square – Additional Options
An expanding square pattern has two additional options: overlap and orientation.  These options 
are adjusted via the radio buttons near the bottom of the editor window.  

The Orientation Right/Left option determines the direction of creep, i.e. the direction the SRU 
will turn at the end of each search leg.  If Right is selected, the SRU will turn right (relative to its 
heading, not the canvas) at the end each leg; if Left is selected, it will turn left instead.

The Permit Overlap? option determines whether or not the the search pattern may overlap with 
others on the canvas.  If On is selected, the pattern is allowed to overlap with other patterns, 
including those for which overlapping has been disabled.  If Off is selected, the pattern will not 
be able to overlap with other patterns for which overlapping has also been disabled.  See Section 
13.2.4 for further information on overlapping.

13.4.3 Stretching an Expanding Square Pattern with the Mouse
When an expanding square pattern is stretched with the mouse (see Section 13.3.2), the result 
depends on which of the adjustment options is selected at the bottom of the Search Pattern Editor 
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window.  To choose between these options, simply click the radio button to the left of the option 
you wish to use.

13.4.3.1 Adjust S (Track Spacing)  

When Adjust S is selected, stretching a search pattern with the mouse will increase or decrease 
the distance between search legs.  Total track length (TT) is preserved, and the turn count is 
recalculated.

13.4.3.2 Adjust TT (Total Track)  

When Adjust TT is selected, stretching a search pattern with the mouse will increase or decrease 
the length of its search legs.  All other parameters are left unchanged, and total track length is 
recalculated.

Figure 13.5 shows a typical expanding square pattern on the canvas.

13.5 The Sector Search Pattern (VS)
Figure 13.6 shows a typical sector search pattern in the Search Pattern Editor.

13.5.1 Sector Search – Search Pattern Details
A sector search pattern has two editable fields and four read-only fields in its Search Pattern 
Details region:

• The Orientation field indicates the bearing of the pattern's first search leg.  An SRU 
traversing this pattern will leave from the CSP at this heading.
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• The Search Leg Length (L) field indicates the length of each search leg.  In a sector search, 
this is the distance from the centre of the search pattern to the perimeter.

• The Track Spacing (S) field indicates the distance between search legs.  This is the same 
distance as the search leg length.

• The Sector Angle (SA) field indicates the interior angle of each turn the SRU makes along the 
track.  This is always 60º.

• The SRU Turn Angle field indicates the angle at which the SRU must turn relative to its 
current heading.  This is always 120º.

• The Turn Count (n) field indicates the number of times the search pattern crosses the center 
point of the pattern.  This is always 6.

Changing the search leg length recalculates track spacing and total track length.  If the new total 
track length exceeds the SRU's on scene endurance, the phrase “> AVAILABLE” will flash below 
the Coverage region of the Search Pattern Editor, as described in Section 13.2.3.4.

13.5.2 Sector Search – Additional Options
A sector search pattern has one additional option: CSP.  This option is adjusted via the radio 
buttons near the bottom of the editor window.  
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The CSP at Centre/Perimeter option determines the location of the CSP.  If Centre is selected, 
the pattern is drawn with the CSP located at the centre point of the pattern, i.e. the location at 
which all the search legs cross.  If Perimeter is selected, the pattern is drawn with the CSP on the 
perimeter, so that the SRU will travel at the given bearing towards the centre point on the first 
search leg.

13.5.3 Stretching a Sector Search Pattern with the Mouse
When a sector search pattern is stretched with the mouse (see Section 13.3.2), the length of each 
search leg is increased or decreased.  

Figure 13.7 shows a typical sector search pattern on the canvas.

13.6 The Custom Track Search Pattern
A custom track search pattern is essentially a series of points on a track, much like a track line 
(see Chapter 7: Track Lines And The Trackline Manager ).  It can be used to create any kind of 
pattern but is most often used to represent trackline return, trackline non-return and coast crawl 
patterns.

Because of the unique nature of a custom track pattern, the Search Pattern Editor has a number of 
additional fields when a custom track pattern is opened.  
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Note: When working with a Custom Track, the Lat and Lon fields in the CSP region at  
the top of the Search Pattern Editor simply mirror the values in the Lat and Lon fields 
above the list of points near the bottom of the editor window.  Changing the CSP Lat and 
Lon fields will have no effect.  In the rest of this section, references to the Lat and Lon 
fields refer to the fields immediately above the list of points, not those in the CSP region.

One example of a Custom Track Pattern Editor is shown in Figure 13.8.

13.6.1 Custom Track – Search Pattern Details
A custom track pattern has only one field in its Search Pattern Details region: Total Track (TT). 
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This field displays the total length of the custom track and is not editable.

13.6.2 Manipulating a Custom Track Search Pattern
When a search pattern is first changed to a custom track, it will be drawn as a line consisting of 
two line segments as shown in Figure 13.9.  

The total length of the line is determined by the SRU's searching speed and its time on scene. 
The line will extend from the CSP at a 45º angle for half the line's length, then turn 90º at an 
interior point and continue for the rest of its length at that bearing.

The points that make up the custom track are listed in a table in the Positions region near the 
bottom of the editor window.  The buttons above this table can be used to add new points via the 
keyboard or mouse, or to modify or delete existing points.

13.6.2.1 Adding a New Point via the Keyboard  

To add a new point to a custom track via the keyboard, first decide which existing point it will go 
before or after and select that point in the table.  Next, select the BEFORE or the AFTER radio 
button immediately above the Lat and Lon fields as appropriate.  When adding a point to the 
beginning of the line, select the first point and then BEFORE.  When adding a point to the end of 
the line, select the last point and then AFTER.  Finally, enter the latitude and longitude of the new 
point into the Lat and Lon fields above the list of points and then click the Apply button to the 
right of those fields.

13.6.2.2 Moving a Point via the Keyboard  

To move an existing point on a custom track via the keyboard, select that point in the table.  Next, 
select the AT radio button above the Lat and Lon fields and then enter the new latitude and/or 
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longitude into the fields and click Apply.

13.6.2.3 Deleting a Point via the Keyboard  

To delete an existing point on a custom track via the keyboard, select that point in the table and 
then click the Delete button.

13.6.2.4 Adding a New Point with the Mouse  

To add a new interior point (i.e. a point between two existing points) to a custom track using the 
mouse, first select the Add Turning Point On Existing Segment radio button at the top of the 
Positions region of the editor window.  Next, point the mouse at the line segment to which you 
wish to add the point, and middle click on the line and hold down the mouse button.  Finally, drag 
the mouse to move the point to its new position.

To add a new end point, it is easiest to add a new interior point to the first or last line segment 
and drag it to the desired end position, and then delete the first or final point as appropriate (see 
Section 13.6.2.3).

13.6.2.5 Moving a Point with the Mouse  

To move an existing point on a custom track via the keyboard, first select the Move Point radio 
button at the top of the Positions region of the editor window.  Next, point the mouse at the point 
on the line that you wish to move, and middle click on the point and hold down the mouse button. 
Finally, drag the mouse to move the point to its new position.

Hint: When adding or moving points to a custom track search pattern with the mouse, it  
is extremely helpful to have markers located on the canvas at the end and turning points.  
See the tutorial at the end of this manual for an example.

13.6.3 Using the Custom Track Pattern for a Coast Crawl
The remaining buttons at the bottom of the Custom Track Search Pattern Editor allow you to 
create a coast crawl search pattern.  

Note: This use of the Custom Track is ideal for calculating how far along the coastline a 
particular SRU can search within the time it has available but is not well suited to 
actually tasking an SRU, as it produces a long series of closely spaced turning points.

When working with a Coast Crawl pattern, the Lat and Lon fields in the CSP region at the top of 
the Search Pattern Editor merely reflect the values in the CSP On Coast Lat and Lon fields at the 
bottom of the editor window.  Changing the CSP Lat and Lon fields will have no effect. 
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Similarly, the Apply button has no effect on a Coast Crawl pattern – instead, you must use the 
Coast Crawl button at the bottom of the window to apply any changes and recalculate the pattern.

13.6.3.1 Creating a Coast Crawl Pattern  

The first step is creating a coast crawl track is to move the CSP to the point on the coast where 
the pattern should begin.  This is most easily accomplished by dragging the custom track line 
with the mouse, as described in Section 13.3.1.

Hint: The CSP must be no farther from shore than the SRU's sweep width.  When the 
SRU's search object type is set to PIW, this distance is very short, so it may be helpful to 
zoom in to the maximum extent when moving the CSP.

Once the CSP has been moved to the desired location, click the Coast Crawl button to calculate 
the coast crawl pattern.  Figure 13.10 shows a typical coast crawl pattern on the canvas.

13.6.3.2 Circumnavigating an Island  

If the pattern completely circumnavigates an island and there is time left in the SRU's on-scene 
endurance, you will be asked whether or not the pattern should continue to retrace its path until 
the SRU's entire endurance is consumed.  

13.6.3.3 Coast Crawl Pattern Options  

A coast crawl pattern has two additional options: SRU to keep land on left or right, and loop 
factor.
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The SRU To Keep Land On Left/Right option determines which direction the SRU will travel 
along the coastline.

Track smoothing is controlled by the value in the Loop Factor field at the bottom of the Custom 
Track Pattern Editor window.  Loops in the search track that are smaller than or equal to the loop 
factor times the width of the track will be removed.  This value defaults to 2 and in practice it 
should be kept small, between 0 and 4.  A value of 0 in this field turns off smoothing completely; 
that is, no loops at all will be removed.  Negative numbers are not allowed.
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Chapter 14
Printing, Reports and the Logging System

14.1 Print Scenario
To print a copy of the active scenario, select Print Scenario from the File Menu or type Ctrl-F12. 
This brings up the Print Scenario dialog box: 

All but two of these reports are identical to those produced by the Reports Editor (see Section 
XX.XX).  The two exceptions are Current View and Subjective Winds Only, which are available 
only through the Print Scenario feature.  Current View prints a screen shot of the canvas at its 
current position and zoom level, including all map elements currently displayed upon it. 
Subjective Winds Only prints wind vector data for all user entered and modified winds that impact 
drift calculations.  This includes both subjective winds and CMC winds that have been modified. 
See 10: Environmental Data: Wind Data and Models for more information on user modified 
winds.

Figure 14.1: The Print  
Scenario dialog box
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If data is available to produce a report, its name appears in bold in the dialog box; if a report's 
name is greyed out, there is no data available to produce it.  

Wind and current vectors are only included in reports if they impact drift calculations; 
vectors added to the scenario that do not affect drift are not included in reports.  The 
wind and current data reports will not be available in the Print Scenario dialog box even 
if you have added vectors to the scenario if none of those vectors impact drift.

To select a report for printing, click on the check box to the left of the its name.  If multiple 
reports are selected, you may choose to print them as separate documents or compiled into a 
single document.  Once the reports you wish to print are selected, click Print to send the reports 
to the printer.

The Current View and the Notes reports always print as separate documents.  If you 
select one of these reports in addition to other reports, you will need to confirm printing 
of each separate report.

14.2 Notes Editor

14.3 Reports Editor

14.4 SRU Tasking Forms

14.5 Log M anager

14.5.1 Scenario Log

14.5.2 Case Log

14.5.3 System Log
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Additional Tools and Advanced Topics

15.1 Administrator Mode

15.1.1 Modifying SRU Database

15.1.2 Modifying Default Views

15.2 Advanced Display Options

15.2.1 Chart Editor

15.2.2 View Editor

15.3 ASTRO
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Tutorial: Fishing Vessel Zebellos
 (Trackline Overdue)

The Zebellos exercise is used in the Maritime Search Planning (MSP) course to teach manual 
search planning in the trackline overdue situation.  This tutorial will walk you through the steps 
of planning the same search using CANSARP.

In this tutorial, you will learn:
• How to use markers to facilitate working with search patterns

• How to use a variety of tools to zoom in and out and pan around on the canvas

• How to save a new view and load previously saved views

• How to use both the linear and variable range ruler

• How to use the Trackline Manager to define a trackline and deploy search objects

• How to add subjective currents and winds to a simulation

• How to use marine charts

• How to allocate a resource from the SRU database or allocate a new SRU and adjust it as 
required

• How to manipulate a custom track search pattern

• How to use the Sweep Width and Body of Water Searched display options to evaluate search 
coverage

• How to turn off leeway divergence so that CANSARP produces a single drift track as in the 
manual method

How to use this tutorial
This tutorial is divided into several sections of related steps.  Each section is prefaced with an 
explanation of the procedures to come: why the steps are performed and what they are meant to 
achieve.  Additional explanations are inserted into the procedures themselves to further clarify 
certain steps.
All the text in this font are instructions for you to follow.  If an instruction appears in italics, the 
instruction is expanded upon in the following sub-steps.  For instance, steps 6.2.1 through 6.2.5 
explain how to perform step 6.2.
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If the instructions branch at some point, a box like this one will indicate which step(s) to follow 
in different situations.  Follow only those steps which apply to your particular situation.

Scenario:
On June 9th at 2000 (UTC), JRCC Victoria is informed that a trawler, the ZEBELLOS (20 m) is 
overdue at Egg Island (51º15'N, 127º50'W).  The vessel was last reported departing anchorage at 
Nissen Bight, position 50º48.5'N, 128º18.8'W at 09/2500 (UTC).  At that time, the intention of 
the skipper was to set course for Nahwitti Bar fairway buoy and then direct to 0.5 M east of Egg 
Island.  The average speed made good on these courses is estimated at 9 knots.  

On scene conditions

On scene conditions are reported as:
Visibility: 20 M
Sea state: 1 m swell

Environmental Data

The average total water current (TWC) at the following points is estimated as:

Nissen Bight: 333ºT at 1.0 kn
Nahwitti Bar Fairway Buoy: 280ºT at 1.5 kn
Egg Island: 240ºT at 2.0 kn

Average surface winds are reported as: NW (315ºT) at 15 kn

Effort Allocation

The CCGC Cape Sutil, presently off Cape Scott, can be tasked to conduct a visual search for the 
fishing vessel starting at 2000 (UTC).

Type: 47 foot lifeboat
Maximum speed: 25 kn
Search speed: 15 kn
Crew: 4 (rested)

Assumptions

As in the manual exercise, certain assumptions are made: that the Sutil's position at 20:00 is the 
CSP and that Nissen Bight is within 6 NM of this position so it is not necessary to extend the 
datum before the search commences, that the Zebellos is navigating by GPS, and that winds and 
currents remain constant throughout the search.
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Marine Chart

In the manual exercise, the search plan is plotted on chart 3605 Quatsino Sound to Queen 
Charlotte Strait.  In CANSARP, this chart has the ID 360501.  It will be used to locate the SRU's 
starting point and the Nahwitti Bar fairway buoy, as well as to compare the CANSAR results 
with those of the manual method.

Step by step instructions for planning this search using CANSARP
You will begin the search plan by starting CANSARP, logging in as the active SMC, and then 
changing the view to Vancouver Island where the incident occurred.  If you do not have a view of 
Vancouver Island saved, instructions are provided for creating one.

 1 Start CANSARP...

 1.1 Double click on CANSARP icon on desktop to launch program

 1.2 Enter your name in the dialog box that appears and click APPLY
 2 Create a new case...

 2.1 Open the File Menu and select New Case/Scenario or click the New Case button on the 
toolbar

 2.2 Enter case number (e.g. Tutorial-Zebellos) in the Case Number field

 2.3 Enter scenario name (e.g. Plan1) in the Scenario Name field

 2.4 Click OK
 2.5 Set scenario clock to LKP: 2007/06/09 15:00 Z

 3 Change view (if default view is not Vancouver Island)...

 3.1 Open the View Menu and select Load View

If Vancouver Island appears in the list of saved views at the top of the window, complete the 
rest of step 3 and then skip step 4.  Otherwise, go directly to step 4.

 3.2 Select Vancouver Island in the table at the top of the window

 3.3 Click Load
 3.4 Click Close

 4 Create a new saved view of Vancouver Island...

 4.1 Close the Load View dialog box

 4.2 Zoom all the way out so that the entire country is visible...

 4.2.1 Select View Editor from the View Menu or click the View Editor button on the 
managers toolbar

 4.2.2 Right click on the up arrow to the left of the Scale field.  This selects the maximum ratio 
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available, which corresponds to the minimum zoom factor

 4.2.3 Click Apply and then Close
 4.3 Pan and zoom to Vancouver Island...

 4.3.1 Click the Pan Tool (the hand) on the toolbar to select it

 4.3.2 Click and drag to the right until the west coast is visible on the canvas

 4.3.3 Click the Zoom To Tool (the magnifying glass) on the toolbar to select it

 4.3.4 Click and drag a box around Vancouver Island

 4.3.5 Click the Default Pointer Tool on the toolbar to select it

 4.4 Save the current view...

 4.4.1 Select Save View As... from the View Menu

 4.4.2 Enter the name Vancouver Island in the dialog box that appears and click Save
 5 Set on scene conditions...

 5.1 Open the Managers Menu and select Scenario Manager
 5.2 Enter 20 in the Visibility field

 5.3 Enter 1.0 in the Sea State field

 5.4 click OK

The rest of the search plan is made easier if important locations are marked on the canvas in 
advance.  The next few steps add markers for the vessel's route (Nissen Bight, Nahwitti Buoy, 
and Destination) to use when adding the vessel's track line and one for the Sutil's starting point to 
use when manipulating the search pattern.  

Because the scenario outline gives the lat and lon of Egg Island but not the vessel's actual 
destination, this point will be determined using the variable range ruler.  The location of the 
Nahwitti Bar fairway buoy is determined by consulting the marine chart for the region.

The Nissen Bight, Nahwitti Buoy and Destination markers will also be used when adding 
environmental data, as the measurements provided are from these same locations.

 6 Add markers...

 6.1 Open the Managers Menu and select Markers Manager or click the Markers button on the 
toolbar

 6.2 Add a marker at Nissen Bight...

 6.2.1 Enter Nissen Bight in the Label field

 6.2.2 Enter 50:48.5N in the Lat field and 128:18.8W in the Lon field

 6.2.3 Click New Marker
 6.2.4 Turn off Show Date And Time
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 6.2.5 Click Apply
 6.3 Add a marker at Egg Island...

 6.3.1 Enter Egg Island in Label field

 6.3.2 Enter 51:15N in Lat field and 127:50W in Lon field

 6.3.3 Click New Marker
 6.3.4 Turn off Show Date And Time
 6.3.5 Click Apply

 6.4 Close the marker tool

 6.5 Add a marker at the vessel's destination (.5 NM east of Egg Island)...

 6.5.1 Shift the canvas view to the Egg Island marker...

 6.5.1.1 Click on the Re-centering Tool on the toolbar to select it

 6.5.1.2 Left click on Egg Island marker to recenter the canvas view on marker

 6.5.1.3 Open the View Menu and select View Editor
 6.5.1.4 Right click on the down arrow to the right of the Scale field.  This automatically 

enters the minimum value in the field – in this case, the maximum zoom level.

 6.5.1.5 Click Apply
 6.5.1.6 Close the View Editor

 6.5.1.7 Still using the re-centering tool, left click on the Egg Island marker again to center 
canvas view on marker if necessary

 6.5.1.8 Click on the Default Pointer Tool button on the toolbar to turn off the Re-centering 
tool

 6.5.2 Use the Variable Range Ruler tool to help position the Destination marker...

 6.5.2.1 Click on Variable Range Ruler Tool button on toolbar

 6.5.2.2 Left click on the Egg Island marker and drag until the circle's radius is 0.5 NM

 6.5.2.3 Leave the Variable Range Ruler window open so the circle stays on the canvas

 6.5.2.4 Reopen the Marker tool

 6.5.2.5 Left click on right edge of the circle, directly east of Egg Island marker (this should 
be at 51:15.0N, 127:49.20W)

 6.5.2.6 Click New Marker in marker tool to add a marker at that position

 6.5.3 Change the marker's Label to Destination

 6.5.4 Adjust its Lat and Lon if necessary

 6.5.5 Turn off Show Date And Time
 6.5.6 Click Apply

 6.6 Hide the Egg Island marker to avoid confusion in later steps...

 6.6.1 Select Egg Island marker in the marker list
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 6.6.2 Turn off Show Label
 6.6.3 Turn off Show Symbol
 6.6.4 Click Apply

 6.7 Close the marker tool and the variable range ruler tool

 6.8 Add a marker at the Nahwitti Bar fairway buoy...

 6.8.1 Reload Vancouver Island view (see step 3)

 6.8.2 Click on the Magnifying Glass Tool on the toolbar

 6.8.3 Using magnifying glass tool, left click and drag to draw a box around the Destination 
and Nissen Bight markers.  Make the box as small as possible while still including both 
markers.

 6.8.4 Click on the Default Pointer Tool on the toolbar to turn off the Magnifying Glass tool

 6.8.5 Turn on Marine Charts in the display options sidebar

 6.8.6 Confirm that Chart #360501 (Quatsino Sound to/) is visible on the canvas...

 6.8.6.1 Open the Managers Menu and select Chart Manager or click on the Chart 
Manager button on the managers toolbar

 6.8.6.2 If Chart #360501 is not selected, click the checkbox to the left of its ID

 6.8.6.3 Turn off all other marine charts

 6.8.6.4 Turn on Lock Currently Displayed Maps

Note: If Chart #360501 does not appear in the Chart Manager's list of charts, close the 
manager and zoom out slightly, then reopen the manager.  The Manager only lists charts 
available at the current scale and closer zoom factors.  Even with charts locked you may 
find that another chart appears in place of #360501 when you zoom in or out or pan 
around the canvas.  If this happens, reopen the manager and select the correct chart  
again.

 6.8.6.5 Click Apply
 6.8.6.6 Click Close

 6.8.7 Locate Nahwitti Bar fairway buoy on the marine chart (west of Hope Island)

 6.8.8 Right click on the canvas at the location of the Nahwitti Bar fairway buoy 

 6.8.9 Choose New Marker from canvas menu

 6.8.10 Change the marker's Label to Nahwitti Buoy

 6.8.11 Turn off Show Date And Time
 6.8.12 Click Apply

 6.9 Add a marker for the Sutil's starting point...

 6.9.1 Locate Cape Scott on the marine chart (a point of land west of Nissen Bight)
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 6.9.2 Left click on the canvas in the Scott Channel off Cape Scott

 6.9.3 Click New Marker in marker tool to create a new marker at that location

 6.9.4 Change the marker's Label to SRU Starting Point

 6.9.5 Turn off Show Date And Time
 6.9.6 Change the marker's icon to make it easier to tell apart from the others...

 6.9.6.1 Click the Change Symbol button

 6.9.6.2 Click on an appropriate SRU icon

 6.9.6.3 Click OK
 6.9.7 Click Apply

 6.10 Close the marker tool

 6.11 Turn off Marine Charts in the display options side bar

The next step in the process is to add a trackline that indicates the Zebellos' intended course, 
using the Nissen Bight, Nahwitti Buoy and Destination markers created in the previous steps. 
Tracklines are drawn with the left and right mouse buttons as described below.  If you have 
problems while drawing the trackline, you may find it easier to clear it entirely and start fresh 
than to correct the problems.

 7 Add the trackline...

 7.1 Confirm that the scenario clock time matches the vessel's LKP (2007/06/09 15:00 Z)

 7.2 Open the Trackline Manager

 7.3 Click the By Speed radio button in the Mode section if it is not already selected

 7.4 Set the Search Object Speed to 9 knots

 7.5 Draw the track line...

 7.5.1 Left click on Nissen Bight marker to begin trackline

 7.5.2 Left click on Nahwitti Buoy marker to continue trackline

 7.5.3 Right click on Destination marker to end line

 7.5.4 Adjust the Lat and Lon of the trackline's waypoints if necessary...

 7.5.4.1 Left click on a waypoint in the waypoint list to select it

 7.5.4.2 Modify its Lat and/or Lon fields to match markers

 7.5.4.3 Click Apply
 7.5.5 Once track line is correct, select the Lock Track Line radio button.  This will prevent 

you from accidentally changing or moving it with the mouse.

Once the trackline is added, it can be used to deploy search objects.  In this case, search objects 

187



: Tutorial: Fishing Vessel Zebellos (Trackline Overdue)

are deployed at each of the waypoints.  

Hint: The scenario outline describes the Zebellos as being 20 meters long but the search 
object types in CANSARP are listed in feet.  If you have access to a web browser, you can 
quickly convert meters to feet (and perform many other useful conversions) using 
Google's search engine.  To do so, simply enter “20 meters in feet” in Google's search 
field.  The result should be displayed directly below the field even before you hit Return; 
if you do hit Return, it will appear at the top of Google's search results instead.  This 
same technique is used later in step 11.6.5.

The Trackline Manager can add the initial navigational fix error to all the search objects but, 
because the DR error changes at each waypoint, the DR error must be adjusted manually.  You 
will use the linear range ruler to calculate the DR distance and the Search Object Manager to 
apply it to each search object.

 8 Deploy the search objects from the Trackline Manager...

 8.1 If the Trackline Manager is not open, reopen it

 8.2 Switch to the Deploy Search Objects tab (the 2nd tab)

 8.3 Select “power boat 66-90 ft” search object type (20m = 65.6 ft) in the no drogue (left) list by 
clicking on the leftmost box next its name.  The left check box beside each search object's 
name selects or deselects it.  The right check box determines whether it is displayed on the 
canvas.

 8.4 Click on Deploy Search Objects At Waypoints if it is not already selected

 8.5 Enter 0.25 in Fix Error field

 8.6 Click Deploy Search Objects
 8.7 Close Trackline Manager

Now that the search objects have been deployed, environmental data must be added to the 
simulation in order to calculate where they will drift – without winds or currents to push them, 
the search objects will not move.  The next section leads you through the process of adding the 
current and wind data given in the scenario outline.  The current data is entered as subjective 
rather than measured currents because the outline indicates that they are estimates.

The scenario outline provides three pieces of current data and one piece of wind data.  Normally, 
currents and winds are reported for a particular time and have a range of influence of three hours 
before and after that point in time.  In this case, however, there is no mention of the time of the 
readings and there is only the one piece of environmental data for each of the locations and so the 
assumption is that winds and currents remain constant throughout the time frame of the search. 
Therefore, these data will be given a range of influence time that covers the entire search: +/- 12 
hours rather than the default +/- 3 hours.  The normal range of influence radius for each piece of 
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data (10 NM for currents and 100 NM for winds) is sufficient to cover the regions the objects will 
drift through, so they are not changed.

 9 Add environmental data...

 9.1 Add Nissen Bight current...

 9.1.1 Right click on the canvas somewhere near the Nissen Bight marker

 9.1.2 Select Add Subjective Current from the canvas menu

 9.1.3 Enter 330 in Degrees field and 1.0 in Knots field

 9.1.4 Change Range of Influence Time to 12 hours

 9.1.5 Click Apply to add vector to time series

 9.2 Add Nahwitti Buoy current...

 9.2.1 Right click on the canvas somewhere near the Nahwitti Buoy marker

 9.2.2 Select Add Subjective Current from the canvas menu

 9.2.3 Enter 280 in Degrees field and 1.5 in Knots field

 9.2.4 Change range of influence Time to 12 hours

 9.2.5 Click Apply to add vector to time series

 9.3 Add Egg Island current...

 9.3.1 Right click on the canvas somewhere near the Destination marker

 9.3.2 Select Add Subjective Current from the canvas menu

 9.3.3 Enter 240 in Degrees field and 2.0 in Knots field

 9.3.4 Change range of influence Time to 12 hours

 9.3.5 Click Apply to add vector to time series

 9.3.6 Click Close
 9.4 Add Average Winds...

 9.4.1 Right click somewhere in the center of the search region (a little way NW of Nahwitti 
Buoy marker, for instance)

 9.4.2 Select Add Subjective Wind from the canvas menu

 9.4.3 Enter 315 in Degrees field and 15 in Knots field

 9.4.4 Change Range of Influence Time to 12 hours

 9.4.5 Click Apply to add vector to time series

 9.4.6 Click Close

Next, you must select which drift forces (both current and wind) CANSARP will use when 
performing drift calculations.  
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There are no measured currents or SLDMB data in this scenario, so these forces may be left on or 
turned off without changing the results.  Likewise, the dynamic current models do not apply in 
this region, so they may also be left on or turned off without effect.  

The current data provided in the scenario outline represents total water current (TWC) so there is 
no need to make use of CANSARP's static tidal or sea current models.  Similarly, TWC already 
includes the effect of wind on the water itself so there is no need to add additional wind driven 
currents to the simulation.  For these reasons, the subjective currents added to the simulation 
should preempt all three lower precedence current models.  While it is not necessary to make 
subjective currents preemptive if wind driven, tidal and sea currents are turned off in the Current 
Forces sidebar, instructions are given for performing both actions.

Although TWC includes the effect of wind on the water, it does not include the effect of wind on 
the vessel itself.  Therefore, the leeway wind force must be turned on.  Note that CANSARP 
includes leeway divergence angles by default whereas the manual method used in the Zebellos 
exercise does not; see the section Leeway Divergence In CANSARP And Manual Search Planning at 
the end of this tutorial for a discussion of this difference and instructions for making CANSARP 
perform exactly like the manual method.  

 10 Select Drift Forces to use in calculations...

 10.1 Turn on Subjective Currents in the Current Forces sidebar

 10.2 Turn off all other forces in the Currect Forces sidebar

 10.3 Turn on Leeway in the Wind Forces sidebar

 10.4 Make Subjective Currents preemptive, not additive...

 10.4.1 Open Current manager

 10.4.2 Switch to Subjective Currents tab

 10.4.3 Make sure that Preemptive is selected in bottom left corner

 10.4.4 Click Close

Now that the environmental data has been added to the simulation, you can begin drifting the 
search objects to determine the datum for the Sutil's estimated time on scene in each of the three 
locations.

The Sutil will begin its search at 2000 (UTC), so the first step is to advance the scenario clock 
that far and determine the first search object's datum.  Next, you will determine the distance from 
this point to the general area of the second search object's search region to calculate the time 
required for the Sutil to reach that area.  With that information, you will continue to drift the 
second object and, using the same procedure, the third.

At each stage, you will add markers to the canvas at the centre of the arc of probability (the 
“SAR sausage”) for each datum to use later when modifying a custom track search pattern for the 
Sutil to follow.
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 11 Drift Search Objects...

 11.1 Advance scenario clock 5 hours to 20:00Z (SRU time on-scene) and refresh screen to 
calculate drift

 11.2 Mark centre of arc of probability for first search object (Nissen Bight)...

 11.2.1 Zoom in on first arc of probability...

 11.2.1.1 If first search object's arc of probability is not entirely visible, click the Zoom Out 
Tool on the toolbar once or twice until it is

 11.2.1.2 Select the Magnifying Tool from the toolbar

 11.2.1.3 Left click and drag to draw a box around the minimax circle surrounding the first 
search object's drift to zoom to that region

 11.2.1.4 Select the Default Pointer Tool from the toolbar

 11.2.2 Right click on the canvas in the centre of the arc of probability

 11.2.3 Choose New Marker from canvas menu

 11.2.4 Change marker Label to TD1 (total drift #1)

 11.2.5 Change marker Time to 2007/06/09 20:00Z if necessary

 11.2.6 Change marker symbol...

 11.2.6.1 Click Change Symbol
 11.2.6.2 Choose the blue dot icon

 11.2.6.3 Click OK
 11.2.7 Click Apply
 11.2.8 Close marker tool

 11.3 Use Linear Ruler to estimate time required to reach second search object's search area...

 11.3.1 Zoom or pan as required so that the SRU Starting Point marker and the first and 
second search objects' drift regions are visible

 11.3.2 Open Linear Ruler Tool
 11.3.3 Left click on the SRU Starting Point marker

 11.3.4 Left click on the TD1 marker

 11.3.5 Right click in the approximate centre of the second search object's arc of probability 
and note the total Range in the linear range ruler tool (approximately 15 NM)

 11.3.6 Estimate the Sutil's travel time from its origin to the second search object's search 
area: approximately 1 hour at searching speed of 15 kts.

 11.3.7 Close the linear range ruler

 11.4 Advance scenario clock 1 hour to 21:00Z and refresh screen to calculate drift
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 11.5 Mark centre of arc of probability for second search object (Nahwitti Buoy)...

 11.5.1 Zoom in on second arc of probability...

 11.5.1.1 If second search object's arc of probability is not entirely visible, click the Zoom 
Out Tool on the toolbar once or twice until it is

 11.5.1.2 Select the Magnifying Tool from the toolbar

 11.5.1.3 Left click and drag to draw a box around the minimax circle surrounding the 
second search object's drift to zoom to that region

 11.5.1.4 Select the Default Pointer Tool from the toolbar

 11.5.2 Right click on the canvas in the centre of the arc of probability

 11.5.3 Choose New Marker from canvas menu

 11.5.4 Change marker Label to TD2 (total drift #2)

 11.5.5 Change marker Time to 2007/06/09 21:00Z if necessary

 11.5.6 Change marker symbol...

 11.5.6.1 Click Change Symbol
 11.5.6.2 Choose the blue dot icon

 11.5.6.3 Click OK
 11.5.7 Click Apply
 11.5.8 Close marker tool

 11.6 Use Linear Ruler to estimate time required to reach third search object's search area...

 11.6.1 Zoom or pan as required so that the second and third search objects' drifts regions are 
visible

 11.6.2 Open Linear Ruler tool

 11.6.3 Left click on TD2 marker

 11.6.4 Right click in the approximate centre of the third search object's arc of probability and 
note the total Range in the linear range ruler tool (approximately 20 NM)

 11.6.5 Estimate the Sutil's travel time from its origin to the second search object's search 
area: 20 NM at 15 kts = 80 minutes.

Hint: This is another opportunity to use Google's search engine calculator.  Enter “20 
nautical miles / 15 knots in minutes” into Google's search field and it will tell you how 
many minutes are required to travel the given distance at the given speed.

 11.6.6 Close the linear range ruler

 11.7 Advance scenario clock 80 minutes to 22:20Z and refresh screen to calculate drift
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 11.8 Mark centre of arc of probability for third search object (Destination)...

 11.8.1 Zoom in on third arc of probability...

 11.8.1.1 If third search object's arc of probability is not entirely visible, click the Zoom Out 
Tool on the toolbar once or twice until it is

 11.8.1.2 Select the Magnifying Tool from the toolbar

 11.8.1.3 Left click and drag to draw a box around the minimax circle surrounding the third 
search object's drift to zoom to that region

 11.8.1.4 Select the Default Pointer Tool from the toolbar

 11.8.2 Right click on the canvas in the centre of the arc of probability

 11.8.3 Choose New Marker from canvas menu10.2.3

 11.8.4 Change marker Label to TD3 (total drift #3)

 11.8.5 Change marker Time to 2007/06/09 22:20Z if necessary

 11.8.6 Change marker symbol...

 11.8.6.1 Click Change Symbol
 11.8.6.2 Choose the blue dot icon

 11.8.6.3 Click OK
 11.8.7 Click Apply
 11.8.8 Close the marker tool

Now that you've determined where each of the three search objects will drift given the 
environmental conditions, you can plot a course for the Sutil to follow during its search.  

The first step is to allocate the Sutil as a resource available to use in the search.  The Sutil is 
already defined in the SRU database but it needs some adjustments to match its description in the 
scenario outline.  If the Sutil is not defined in the SRU database on your workstation, alternate 
instructions for adding the resource from scratch are provided as well.

Once the resource is allocated, the next step is to define its search pattern.  Given the type of 
search object and type of SRU, the sweep width for this scenario is wide enough for the Sutil to 
cover the entire region in a single pass.  For this reason, a custom track search pattern is used 
rather than a pattern with multiple legs.

Note that SRU endurance is not used in the calculations for a custom track search pattern, except 
to determine the pattern's original length.  The default value of 36 hours for the Cape Sutil will 
produce a search pattern line that is much too long to manipulate easily on the canvas, so you will 
reduce its endurance to two hours to make the line shorter and easier to work with.

Once the search pattern is applied, it must be moved to cover the search regions appropriately. 
You will manipulated the pattern graphically, by clicking and dragging with the mouse on the 
canvas – the markers added in previous steps will facilitate arranging the search pattern in such a 
way that the search areas are well covered by the Sutil's course.  
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Note that, although the search pattern is similar to a trackline in appearance, it is manipulated like 
other search patterns: you must use the middle mouse button to manipulate it instead of the left 
mouse button, which simply selects it.  When clicking on the pattern to manipulate it, be sure to 
click in the interior of the line – if you click at the very end of the line or just outside it, you will 
rotate the line rather than moving its nodes.  

If you have problems manipulating the pattern and add or delete nodes by accident, it may be 
easier to reset the pattern entirely and start from scratch rather than try to fix it.  If you have not 
yet closed the Pattern Editor, you can do this by clicking the Reset button at the bottom of the 
editor window.  Otherwise, you will need to close the editor, change to a different pattern type, 
apply that change and then change back to the custom pattern type and apply to reset it.

 12 Allocate the SUTIL resource and select custom track search pattern...

 12.1 Turn off display of drift tracks in display options sidebar so markers are clearly visible...

 12.2 Click on Center On Search Objects Tool
 12.3 Pan slightly so that all the TD markers and the SRU Starting Point marker are visible on the 

canvas

 12.4 Select Default Pointer Tool
 12.5 Open the SRU Manager

 12.6 Click SRU Database
 12.7 Expand the Primary Marine list and scroll down to find CAPE SUTIL in the list.

If the Sutil is defined in the SRU database, continue to step 12.8 and then skip step 12.9.  If it  
is not defined, skip step 12.8 and go directly to step 12.9.

 12.8 Add the Cape Sutil from the SRU Database

 12.8.1 Click on CAPE SUTIL to select it

 12.8.2 Click Select
 12.8.3 Click Close
 12.8.4 Change Searching Speed (V) to 15 knots

 12.8.5 Change SRU Position Error (Y) to 0.25

 12.9 Add the Cape Sutil from scratch...

 12.9.1 Click New SRU
 12.9.2 Change SRU Name to CAPE SUTIL

 12.9.3 Change SRU Type to “small boat (less than 65 feet)”

 12.9.4 Change Searching Speed (V) to 15 knots

 12.10 Confirm that Search Object Type matches the Zebellos (power boat 66-90 ft)
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 12.11 Switch to Calculation tab

 12.12 Change SRU Endurance to 2 hours

 12.13 Change Search Pattern Type to Custom

 12.14 Click Apply
 13 Manipulate Custom Track Search Pattern...

 13.1 Click Edit to open Custom Track Search Pattern Editor

 13.2 Change CSP time to 2007/06/09 20:00 Z

 13.3 Click Apply (sweep width disappears)

 13.4 Confirm that the Move Node radio button is selected in the Positions section of the Custom 
Track Pattern Editor

 13.5 Using middle mouse button, drag CSP from Nissen Bight to the SRU Starting Point marker

 13.6 Using middle mouse button, drag the end point to the TD3 marker

 13.7 Using middle mouse button, drag the middle waypoint (the bend) to the TD1 marker

 13.8 In Custom Track Pattern Editor, select Insert Node On Existing Segment radio button

 13.9 Using middle mouse button, click-and-hold on the custom track line between TD1 and TD3 
markers, then drag to the TD2 marker before releasing the mouse button

 13.10 Close the Pattern Editor

 13.11 Close the SRU Manager

The final step is to determine whether or not the search pattern effectively covers the search area. 
Two tools will help you do this: the Sweep Width display option and the Body of Water Searched 
display option.  Each has advantages and disadvantages, however.

The Sweep Width display option gives an indication of the region within the SRU's sweep width 
as it travels along its course.  If a search object's minimax circle lies entirely within the sweep 
width, the area has been covered effectively.   As time passes, however, the minimax circles 
continue to expand while the sweep width does not, so evaluating sweep width coverage in this 
way is only valid if the time on the scenario clock is close to the time when the SRU is actually 
within the given search area.

The Body of Water Searched display option fills in the regions of an object's arc of probability 
(its “SAR sausage”) that have been covered by the search.  This body of water continues to 
expand as the scenario time advances, so it doesn't have the same drawback as the Sweep Width 
display option; however, it ignores the area of the minimax circle outside of the arc of 
probability.

 14 Evaluate coverage of search area

 14.1 Zoom out so that entire search plan region is visible

 14.2 Turn on Drift Tracks display option in display options sidebar
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 14.3 Turn on Sweep Width display option in display options sidebar

 14.4 Evaluate coverage of minimax circles within SRU's sweep width

You should see that the Cape Sutil's sweep width covers the entire arc of probability for all three 
search objects at 22:20.  Note that the minimax circle of the first search object extends slightly 
beyond the Sutil's sweep width at this time, but recall that the SRU was in that location at 20:00 
when the first search object's minimax circle was smaller.

 14.5 Verify that the first search object's minimax circle was completely contained within the 
sweep width at its datum...

 14.5.1 Set the scenario clock back to 20:00Z and refresh screen

 14.5.2 Evaluate coverage of first search object's minimax circle at 20:00

 14.6 Evaluate Bodies of Water Searched

 14.6.1 Turn off Sweep Width in display options sidebar

 14.6.2 Turn on Body of Water Searched in display options sidebar

 14.6.3 Advance scenario clock to 22:20Z and refresh screen

You should see that the Cape Sutil's has covered the arc of probability for all three search objects.

Leeway divergence in CANSARP and manual search planning
When CANSARP calculates leeway, it considers four parameters: the leeway coefficient, a 
correcting factor, and left and right angles of divergence.  The angles of divergence determine 
how far apart the drift tracks will spread and are responsible for producing the “SAR sausage” 
characteristic of CANSARP drift calculations.  When leeway is calculated manually, however, 
angles of divergence are not considered and there is only a single drift track as a result.  In order 
to make CANSARP match the results of the manual Zebellos exercise, the angles of divergence 
must be reduced to zero.

Note that this is not the same as turning off leeway entirely – leeway is used in the manual 
exercise so the other two leeway parameters, coefficient and correction, must be used in 
CANSARP to produce the same drift.

The next few steps should make CANSARP produce exactly the same results as the manual 
exercise.  They redrift the search objects at the datum time for each one, this not without using 
leeway divergence.  New markers are added to indicate new the total drift of each target so that 
you can compare the results to those of the manual exercise more easily.

NB: This version of the tutorial exercise is saved as Plan1-NoLD.

 15 Turn off Leeway Divergence...

 15.1 Open the Search Object Manager

 15.2 Select the first search object

 15.3 Locate the angle of divergence fields in the Leeway Parameters region of the manager 

196



: Tutorial: Fishing Vessel Zebellos (Trackline Overdue)

window.  They are labeled º (left) and º (right)
 15.4 Set the value of both fields to 0

 15.5 Click Apply

 15.6 Repeat steps 15.2 through 15.5 for the second and third search objects

 16 Redrift search objects and add markers...

 16.1 Confirm that the scenario clock still reads 2007/06/09 22:20 Z and change it if necessary

 16.2 Click Refresh Screen to redrift at the third object's datum time without leeway divergence

 16.3 Add a marker for third search object's drift without leeway divergence...

 16.3.1 Select the Re-center View tool

 16.3.2 Click on the third search object's datum to center on that point

 16.3.3 Select View Editor from the View Menu or click the View Editor button on the 
managers toolbar

 16.3.4 Right click on the down arrow to the right of the Scale field to choose the smallest ratio 
(the maximum zoom factor)

 16.3.5 Click Apply and then Close
 16.3.6 Right click on the datum and select New Marker from the canvas menu

 16.3.7 Change the marker icon to a red dot (see step11.2.6)

 16.3.8 Change the marker Label to TD3 w/o divergence

 16.3.9 Click Apply
 16.3.10 Close the marker manager

 16.4 Click the Center On Search Objects button on the toolbar

 16.5 Change the scenario clock to 21:00 Z

 16.6 Click Refresh Screen to redrift at the second object's datum time

 16.7 Repeat Steps 16.3 to 16.4 for the second search object

 16.8 Change the scenario clock to 20:00 Z

 16.9 Click Refresh Screen to redrift the first search object without leeway divergence

 16.10 Repeat Step 16.3 to 16.4 for the first search object

Now it should be possible to compare the total drift plotted on chart 3605 Quatsino Sound to 
Queen Charlotte Strait during the manual exercise with the positions of the new, red markers in 
CANSARP.  It may be helpful to display chart #360501 again (see step 6.8.6) when making this 
comparison.

197



Index

cxcviii


	Chapter 1
User Interface
	1.1Start Up & Shut Down
	1.2The Info and Button Bars
	1.3The Scenario Clock
	1.4The Canvas
	1.5The Sidebars
	1.6Pop-up Windows and Dialog Boxes
	1.7Markers

	Chapter 2
Using the CANSARP Wizard
	Chapter 3
Case and Scenario File Management
	3.1Before you begin...
	3.1.1What Is a Scenario?  What Is a Case?
	3.1.2Case Numbers and Scenario Names
	3.1.3Active Case and Scenario
	3.1.4Scenario Components
	3.1.4.1Scenario Parameters


	3.2File Management within CANSARP: The File Menu
	3.2.1Creating a New Scenario In a New or Existing Case
	3.2.2Loading an Existing Scenario (Load Scenario)
	3.2.3Viewing a Scenario In View Mode (View Case)
	3.2.4Printing the Active Scenario (Print Scenario)
	3.2.5Saving the Active Scenario (Save)
	3.2.6The Autosave System (Autosave and Recover Autosave)
	3.2.6.1Recovering from the Autosave File
	3.2.6.2Recovering after a Crash or Forgetting to Save
	3.2.6.3Setting the Autosave Data Interval

	3.2.7Reloading the Active Scenario (Reload)
	3.2.8Reloading from Another Scenario into the Active Scenario (Reload From...)
	3.2.9Discarding the Active Scenario (Discard)
	3.2.10Closing the Active Scenario (Close Case)
	3.2.11Backup Case
	3.2.12Restore Case
	3.2.13Export Drifts

	3.3File Management within CANSARP: The Scenario Manager
	3.3.1Creating a New Scenario in a New or Existing Case (New Case/Scenario)
	3.3.2Switching between Active Scenarios in a Case (Load)
	3.3.3Deleting a Scenario from the Active Case (Delete)
	3.3.4Duplicating a Scenario (Duplicate)

	3.4File Management outside CANSARP: Nautilus File Manager
	3.4.1File Structure within Nautilus
	3.4.2Opening the File Browser in Nautilus File Manager
	3.4.3Deleting Scenarios and Cases
	3.4.4Duplicating Scenarios and Cases
	3.4.5Renaming Scenarios and Cases
	3.4.6Moving or Copying Scenarios to Another (or a New) Case
	3.4.7Archiving and Unarchiving a Case
	3.4.8Locking a Scenario or a Case


	Chapter 4
Overview of Search Planning
	Chapter 5
Starting a New Search Plan and
the Scenario Manager
	5.1The View Editor
	5.2The Scenario Manager
	5.3Scenario Parameters
	5.4Setting the Scenario Clock
	5.5Initial Current Forces

	Chapter 6
Search Objects and the Search Object Manager
	6.1Before you begin...
	6.1.1Search Objects Vs. Tracklines
	6.1.2Search Object Parameters
	6.1.2.1Search Object Type
	6.1.2.2Drift Starting Point: LKP/EIP
	6.1.2.3Initial Position Error
	6.1.2.4Leeway Divergence


	6.2The Search Object Manager
	6.2.1Adding a New Search Object
	6.2.2Modifying Search Objects
	6.2.2.1Selecting an Object to Edit
	6.2.2.2Applying changes
	6.2.2.3Search Object Type
	6.2.2.4Drift Starting Point: LKP/EIP
	6.2.2.5Initial Position Error: Fix Error
	6.2.2.6Initial Position Error: DR Error
	6.2.2.7Leeway Parameters
	6.2.2.8Drogue
	6.2.2.9Colour

	6.2.3Duplicating Search Objects
	6.2.4Deleting a Search Object
	6.2.5Deactivating and Reactivating Search Objects
	6.2.6Allocating SRUs
	6.2.7Reverse Drift

	6.3Search Objects and the Canvas Menu

	Chapter 7
Track Lines and the Trackline Manager
	7.1Before you begin...
	7.1.1.1The Purpose and Composition of a Track Line
	7.1.1.2Behaviour of Search Objects Deployed by Track Lines

	7.2The Trackline Manager
	7.3Adding a Track Line
	7.3.1How to Draw a Track Line
	7.3.2By Speed Vs. By time
	7.3.3Adding a Track Line by Speed
	7.3.3.1Modifying Way Points Added by Speed

	7.3.4Adding a Track Line by Time
	7.3.4.1Modifying Way Points Added by Time


	7.4Editing a Track Line
	7.4.1.1Changing the Speed of a Track Line
	7.4.1.2Changing the Times of Way Points
	7.4.1.3Changing the Positions of Way Points
	7.4.1.4Deleting Way Points
	7.4.1.5Clearing the Track Line
	7.4.2Manipulating a Track Line Via the Mouse
	7.4.2.1Moving Way Points (Move Node)
	7.4.2.2Inserting a New Turning Point (Insert Node on Existing Segment)
	7.4.2.3Extending the Track Line (Add Waypoint)
	7.4.2.4Repositioning the Track Line (Drag Track Line)
	7.4.2.5Deleting Way Points (Delete)
	7.4.2.6Locking the Track Line (Lock Track Line)


	7.5Deploying Search Objects
	7.5.1Distributing Search Objects Along a Track Line
	7.5.2Configuring Search Object Parameters
	7.5.2.1Search Object Type
	7.5.2.2Drift Starting Point
	7.5.2.3Initial Position Error
	7.5.2.4Leeway Parameters

	7.5.3Deploying the Search Objects and the Search Object List

	7.6Modifying Deployed Search Objects
	7.6.1.1Changing Activity Status

	7.7Deleting and Redeploying Search Objects

	Chapter 8
Environmental Time Series Data and 
the Time Series Editor
	8.1Before you begin...
	8.1.1Vectors and Time Series
	8.1.2Range of Influence
	8.1.3Only Some Data May Be Opened

	8.2Displaying Time Series on the Canvas
	8.3Opening a Time Series in the Time Series Editor 
	8.3.1Opening a Time Series from the Canvas
	8.3.2Opening User Entered Data from a Manager

	8.4Interpreting Time Series Data
	8.4.1Time Series Parameters
	8.4.1.1Time Series ID and Position
	8.4.1.2Range of Influence
	8.4.1.3Activation Status

	8.4.2Vector List
	8.4.3Vector Parameters

	8.5Adding a New Time Series
	8.5.1Adding the First Vector to a Time Series
	8.5.1.1Direction of Wind and Current Vectors
	8.5.1.2The Vector Compass

	8.5.2Adding Additional Vectors to a Time Series

	8.6Modifying a Time Series
	8.6.1Changing Time Series Parameters
	8.6.2Deactivating a Time Series
	8.6.3Adding a New Vector
	8.6.4Deleting a Vector
	8.6.5Modifying a Vector

	8.7Deleting a Time Series

	Chapter 9
Environmental Data: Current Data and Models
	9.1Before you begin...
	9.1.1Data Priority and Additive vs. Preemptive Data Types
	9.1.2Time Series Terminology
	9.1.3Entering and Modifying Time Series Data
	9.1.4CANSARP 5.0 Technical Manual

	9.2Types of Current Data
	9.2.1Modeled Current Data
	9.2.1.1Static Data Models
	9.2.1.2Dynamic Data Models
	9.2.1.3Modeled Current Data Grids

	9.2.2Non-modeled Data – User Entered Currents and SLDMBs
	9.2.3Wind Driven Currents

	9.3Acquisition of Dynamic Model Data
	9.3.1.1The Watchdog

	9.4Displaying Currents on the Canvas
	9.4.1.1Changing the Appearance of Current Icons

	9.5The Current Manager
	9.6Measured Currents
	9.6.1The Measured Currents tab of the Current Manager
	9.6.2Editing a Measured Current
	9.6.3Deleting Measured Currents

	9.7SLDMBs
	9.7.1PIW Mode vs. Life Raft Mode
	9.7.2GPS vs. Argos 0-3
	9.7.3The SLDMB Tab of the Current Manager
	9.7.4Displaying available SLDMBs
	9.7.4.1Loading an SLDMB into the Active Scenario

	9.7.5SLDMB Details
	9.7.5.1Calculation of Direction and Speed
	9.7.5.2Extrapolation of Deployment Mode and Temperature Readings
	9.7.5.3Deleting an Individual SLDMB Vector
	9.7.5.4Deactivating an Individual SLDMB Vector
	9.7.5.5Printing SLDMB Details

	9.7.6Discarding SLDMB Data
	9.7.7Reloading SLDMB Data
	9.7.8Range of Influence
	9.7.9Viewing SLDMB Data in the Time Series Editor

	9.8The IML Data Model (Dynamic)
	9.9The Grand Banks Data Model (Dynamic)
	9.9.1.1Grand Banks Data Format
	9.9.2The Current Manager's Grand Banks Model tab
	9.9.2.1Loading Grand Banks current data
	9.9.2.2Reloading Grand Banks Data

	9.9.3Modifying Grand Banks data
	9.9.3.1Deactivating and Deleting Grand Banks data


	9.10Subjective Currents
	9.10.1Subjective Currents Used as Low Confidence Real Time Data
	9.10.2Subjective Currents Used to Represent Charts or Tables
	9.10.3The Subjective Currents Tab of the Current Manager
	9.10.4Making Subjective Currents Preemptive or Additive
	9.10.5Editing a Subjective Current
	9.10.6Deleting Subjective Currents

	9.11Tidal Current Data Models (Static)
	9.11.1Tidal Grid Boundaries and Seasons
	9.11.1.1Tidal Grids for the west coast of British Columbia
	9.11.1.2Tidal Grids for the Straits of Georgia and Juan de Fuca (GF7)
	9.11.1.3Tidal Grids for the Bay of Fundy/Gulf of Maine
	9.11.1.4Tidal Grids for the Gulf of St. Lawrence
	9.11.1.5Displaying Tidal Grids on the Canvas

	9.11.2The Tidal Models tab of the Current Manager – Overriding the Default Grid
	9.11.2.1Viewing Tidal Grids in the Current Manager


	9.12Sea Current Data Models (Static)
	9.12.1.1The West Coast Sea Current Grid
	9.12.1.2The East Coast Sea Current Grid
	9.12.1.3The International Ice Patrol (IIP) Current Grid
	9.12.1.4The Great Lakes Sea Grids
	9.12.2Overriding Default Sea Currents
	9.12.2.1Displaying Sea Grids on the Canvas



	Chapter 10
Environmental Data: Wind Data and Models
	10.1Before you begin...
	10.1.1Data Priority
	10.1.2Time Series Terminology
	10.1.3Entering and Modifying Time Series Data
	10.1.4Leeway and Ekman drift
	10.1.5CANSARP 5.0 Technical Manual

	10.2Displaying Winds on the Canvas
	10.2.1.1Changing the Appearance of Wind Icons

	10.3The Wind Manager
	10.3.1The Wind Models Tab
	10.3.2The Wind Options Tab
	10.3.2.1Time Series Default Range of Influence
	10.3.2.2Deactivating and Reactivating Groups of Wind Vectors
	10.3.2.3Loading CMC Winds

	10.3.3The Subjective Winds Tab

	10.4CMC Winds
	10.4.1Types of Data: Analyzed, Forecast and Observed
	10.4.1.1Analyzed/Forecast Data
	10.4.1.2Observed Data
	10.4.1.3CMC Wind Data Grid

	10.4.2Acquisition of CMC Data
	10.4.2.1The Watchdog
	10.4.2.2Historical Wind Data

	10.4.3Loading CMC Wind Data into a Scenario
	10.4.3.1Reloading CMC Wind Data
	10.4.3.2Modifying CMC Wind Data

	10.4.4Disabling or Re-enabling CMC Wind Data

	10.5Subjective Winds
	10.6The Subjective Winds tab of the Wind Manager
	10.6.1Editing a Subjective Wind
	10.6.2Deleting Subjective Winds
	10.6.3Disabling and Re-enabling Subjective Wind Data

	10.7Case Study: Wind patterns on the west coast of British Columbia

	Chapter 11
Drift and Search Area Determination
	11.1Selecting Drift Forces
	11.1.1Current Forces (preemptive vs. additive)
	11.1.2Leeway
	11.1.3Wind Driven Currents
	11.1.4Ekman Method of WDC Calculation
	11.1.5Interpolation

	11.2Performing a Drift
	11.2.1Datum Time
	11.2.2Project Forward
	11.2.3Reverse Drifts
	11.2.4Changing the Scenario Clock and Redrifting
	11.2.5Deactivated Search Objects Don't Drift

	11.3Displaying Drifts
	11.3.1Drift Tracks
	11.3.2Drift Errors (15 mins)
	11.3.3Don't Clear Drift Tracks
	11.3.4Drift Track Starting Times

	11.4The Search Area Polygon
	11.4.1The Polygon Manager
	11.4.2Probability of Detection


	Chapter 12
Effort Allocation: SRUs and the SRU Manager
	12.1Before you begin...
	12.2The SRU Manager
	12.2.1Details Tab
	12.2.1.1SRU Name
	12.2.1.2Colour
	12.2.1.3CSP (Lat, Lon and Time)
	12.2.1.4Search Object Type
	12.2.1.5SRU Type
	12.2.1.6Searching Speed (V)
	12.2.1.7SRU Position Error (Y)
	12.2.1.8Search Number
	12.2.1.9Additional Buttons

	12.2.2Calculations Tab
	12.2.2.1Weather Factor (Fw)
	12.2.2.2Speed Factor (Fv)
	12.2.2.3Fatigue Factor (Ff)
	12.2.2.4Sweep Width (W)
	12.2.2.5SRU Endurance
	12.2.2.6Aircraft Correction Factor
	12.2.2.7On-Scene Endurance
	12.2.2.8Transit Time
	12.2.2.9Requested Coverage Factor

	12.2.3Pattern Type

	12.3Adding a New SRU
	12.3.1Adding a New SRU from the SRU Database
	12.3.2Adding an SRU from the Canvas Menu
	12.3.3Adding an SRU from the Search Object Manager

	12.4Duplicating an SRU
	12.5Deleting an SRU
	12.6Modifying an existing SRU
	12.7Deleting an SRU
	12.8SRUs and the Canvas Menu
	12.9The Transit Editor
	12.9.1SRU Start Point / Home Base
	12.9.1.1Start Point Time and CSP

	12.9.2Commence Search Point
	12.9.3End Search Point
	12.9.4Recovery Point
	12.9.5Transit Speed
	12.9.6Recalculating Transit Time
	12.9.7Transit Time Recalculation Required
	12.9.8The Transit Time Paradox


	Chapter 13
Effort Allocation: Search Patterns
	13.1Before you begin...
	13.1.1Setting Pattern Type
	13.1.2Minimizing an SRU's pattern

	13.2The Search Pattern Editor
	13.2.1Search Pattern CSP
	13.2.2Search Pattern Details
	13.2.3Search Pattern Coverage
	13.2.3.1Coverage Factor – Requested and Achieved
	13.2.3.2Probability of Detection – This Pattern
	13.2.3.3Probability of Detection – Polygon
	13.2.3.4On-Scene Endurance – SRU and Pattern

	13.2.4Overlap vs. Non-overlap

	13.3Editing Search Patterns Graphically with the Mouse
	13.3.1Moving a Search Pattern with the Mouse
	13.3.2Stretching a Search Pattern with the Mouse
	13.3.3Rotating a Search Pattern
	13.3.4Rotating Patterns via Keyboard and Mouse
	13.3.5Parallel Sweep – Search Pattern Details
	13.3.6Parallel Sweep – Additional Options
	13.3.7Stretching a Parallel Sweep Pattern with the Mouse
	13.3.7.1Adjust S (Track Spacing)
	13.3.7.2Adjust L (Search Leg Length)
	13.3.7.3Adjust n (Track Count)
	13.3.7.4Adjust L & S (Search Leg Length and Track Spacing)
	13.3.7.5Adjust L & n (Search Leg Length and Track Count)


	13.4The Expanding Square Search Pattern (SS)
	13.4.1Expanding Square – Search Pattern Details
	13.4.2Expanding Square – Additional Options
	13.4.3Stretching an Expanding Square Pattern with the Mouse
	13.4.3.1Adjust S (Track Spacing)
	13.4.3.2Adjust TT (Total Track)


	13.5The Sector Search Pattern (VS)
	13.5.1Sector Search – Search Pattern Details
	13.5.2Sector Search – Additional Options
	13.5.3Stretching a Sector Search Pattern with the Mouse

	13.6The Custom Track Search Pattern
	13.6.1Custom Track – Search Pattern Details
	13.6.2Manipulating a Custom Track Search Pattern
	13.6.2.1Adding a New Point via the Keyboard
	13.6.2.2Moving a Point via the Keyboard
	13.6.2.3Deleting a Point via the Keyboard
	13.6.2.4Adding a New Point with the Mouse
	13.6.2.5Moving a Point with the Mouse

	13.6.3Using the Custom Track Pattern for a Coast Crawl
	13.6.3.1Creating a Coast Crawl Pattern
	13.6.3.2Circumnavigating an Island
	13.6.3.3Coast Crawl Pattern Options



	Chapter 14
Printing, Reports and the Logging System
	14.1Print Scenario
	14.2Notes Editor
	14.3Reports Editor
	14.4SRU Tasking Forms
	14.5Log M anager
	14.5.1Scenario Log
	14.5.2Case Log
	14.5.3System Log


	Chapter 15
Additional Tools and Advanced Topics
	15.1Administrator Mode
	15.1.1Modifying SRU Database
	15.1.2Modifying Default Views

	15.2Advanced Display Options
	15.2.1Chart Editor
	15.2.2View Editor

	15.3ASTRO

	Tutorial: Fishing Vessel Zebellos
 (Trackline Overdue)
	Scenario:
	On scene conditions
	Environmental Data
	Effort Allocation
	Assumptions
	Marine Chart

	Step by step instructions for planning this search using CANSARP
	Leeway divergence in CANSARP and manual search planning


